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This Guide

This Guide

This guide explains how to install Deltek for Professional Services (DPS) software on your servers. This
guide is divided into the following parts:

1 Install the DPS Software | This part of the guide walks you through the process of installing
DPS software on your servers, creating new DPS databases or
migrating existing Vision databases, and performing related steps.
It assumes that your server environment is already set up.

2 DPS Server Architecture | If you have not set up your DPS server architecture, read this part
of the guide. It describes several possible architecture models and
helps you choose the one that best fits your company’s needs.

3 Advanced Technical This part of the guide covers advanced configuration options that
Topics you may want to consider, especially if you have a large scale DPS

implementation.

Links to Related DPS Documentation

Here are links to some important DPS documentation:

Online help https://help.deltek.com/Product/DeltekPS
Videos https://help.deltek.com/Product/DeltekPS/ST _Basics Browser
Videos.html

Settings and Configuration Guide https://dsm.deltek.com/DeltekSoftwareManagerWebServices/do
wnloadFile.ashx?documentid=06A24278-7FBD-4ED0-9392-
E73CB4E92528

Platform Compatibility Matrix https://deltek.custhelp.com/ci/fattach/get/2975379/0/filename/De
ItekProductSupportCompatibilityMatrix. pdf
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If You Need Assistance

If You Need Assistance

If you need assistance installing, implementing, or using Deltek for Professional Services (DPS), Deltek
makes a wealth of information and expertise readily available to you.

Customer Services

For over 30 years, Deltek has maintained close relationships with client firms, helping with their problems,
listening to their needs, and getting to know their individual business environments. A full range of
customer services has grown out of this close contact, including the following:

= Extensive self-support options through the Deltek Support Center
= Phone and email support from Customer Care analysts

= Technical services

=  Consulting services

= Custom programming

= Classroom, on-site, and Web-based training

Note: Find out more about these and other services from the Deltek Support Center.

Deltek Support Center

The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support
Plan (OSP).

The following are some of the many options that the Deltek Support Center provides:

= Search for product documentation, such as release notes, install guides, technical information,
online help topics, and white papers

= Ask questions, exchange ideas, and share knowledge with other Deltek customers through the
Deltek Support Center Community

= Access Cloud-specific documents and forums

= Download the latest versions of your Deltek products

= Search Deltek’s knowledge base

=  Submit a support case and check on its progress

= Transfer requested files to a Customer Care analyst

= Subscribe to Deltek communications about your products and services
= Receive alerts of new Deltek releases and hot fixes

= |nitiate a Chat to submit a question to a Customer Care analyst online

Attention: For more information regarding Deltek Support Center, see the online help available from
the Web site.
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Access Deltek Support Center

To access the Deltek Support Center:

1. Go to http://support.deltek.com.

2. Enter your Deltek Support Center Username and Password.
3. Click Login.

Note: If you forget your username or password, click the Login Help? button on the login screen for
help.

Adding Custom Notes to This Guide

If you would like to add custom notes to this guide that are specific to your company, Adobe® Reader® X
provides this ability. If you do not already use Adobe Reader X, you can download it here free from
Adobe.

To add a custom note using Adobe Reader X:

1. On the Reader toolbar, click Comment at the far right.

2. Inthe Annotations pane that displays, click *~ Sticky Note. The cursor changes to match the
button.

3. Position the cursor at the location in the guide where you want the note to appear, and click. A
note icon is inserted at the location and a text box pops up.

Enter your information in the text box.

Continue adding notes as needed.

Note: Deltek recommends that you save the document to a slightly different filename so as to keep
the original from being overwritten.

When reading the document, cursor over a note icon to see the information. Double-click a note icon to
edit the information.
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Overview of the Installation Process

Overview of the Installation Process

Before You Begin

This part of the guide walks you through the process of installing DPS software on your servers, creating
new DPS databases or migrating existing Vision databases, and performing related steps.

The procedures in this guide assume that your server environment is already set up. If you have not set
up your DPS server environment, read Part 2: Overview of Server Architecture. It describes several
possible architecture models and helps you choose the one that best fits your company’s needs.

PowerShell Scripts

The DPS on-premises installation is built using PowerShell scripts. Using PowerShell as the technology
for installing and deploying DPS provides a number of benefits. PowerShell leverages new technologies,
provides enhanced automation, and provides complete visibility and transparency into what is being
deployed, run, and executed, including all changes that the installation makes to your servers.

Attention: For more information on PowerShell and its capabilities, see:

https://docs.microsoft.com/en-us/powershell/scripting/powershell-scripting ?view=powershell-5.1

You will run the PowerShell script, named DeltekPS.ps1, multiple times, using different switches to
achieve the required results. The steps that you follow depend on whether you are installing DPS from
scratch or migrating to DPS from Deltek Vision, GovWin CM, or Ajera CRM.

Basic Steps

Follow these basic steps.

1 Make sure that you have all prerequisites in place. Prerequisites
2 Download the DeltekPS.ps1 PowerShell script. Download the PowerShell Script
3 Run the script, using no switches, to set up the installation Considerations for Running the

environment and to check that the script prerequisites are in  PowerShell Script

place. Run the Script with No Switches
4 Re-run the script, using the CheckPreReq switch, to make Run the Script with the

sure that the product/software prerequisites are in place CheckPreReq Switch
5 Re-run the script, using one of the following switches: Run the Script with the Setup or

SetupAndMigrate Switch

= Setup: If you are installing DPS and creating a
completely new DPS database. =  Run the Script with the

. . . . i
= SetupAndMigrate: If you are installing DPS and Setup Switch
migrating your existing Deltek Vision, GovWin CM, or =  Run the Script with the
Ajera CRM database to DPS. SetupAndMigrate Switch
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6 Re-run the script as many times as needed, using the Optional Switches
optional switches. Use only those switches that are relevant
to your situation; skip those that are not.
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Key Guidelines

This guide walks you through the process of installing Deltek for Professional Services (DPS) on your
own servers. Before you begin, review these key facts and guidelines.

Prerequisites
Read the Prerequisites section carefully before installing DPS. Here are some highlights:

All tiers must have a resolvable, fully qualified domain name (FQDN).

A valid SSL certificate must be installed on the web/application server and report server. If DPS is
only used internally, the certificate can be generated by an internal certificate authority. If DPS is
used externally, the certificate must be generated by a third-party certificate authority, such as
Verisign or DigiCert.

HTTPS and TLS 1.1/1.2 are required. SSL 2.0/3.0 must be disabled. Deltek recommends that
TLS 1.0 be disabled. For more information about disabling SSL 2.0 and 3.0, read this article:

https://support.microsoft.com/en-us/help/187498/how-to-disable-pct-1-0-ssl-2-0-ssl-3-0-or-tls-1-0-in-internet-
informat

You can also use the 1ISCrypto tool by Nartac Software to disable these older protocols.
PowerShell Remoting must be enabled on all tiers.
The DPS setup scripts are signed and should not be changed.

If you are migrating from Deltek Vision, GovWin CM, or Ajera CRM, make sure that you have a
valid backup and tested restore of your Vision/GovWin CM/Ajera CRM database. Perform a test
migration before your final migration.

Note: Before you begin migrating, you must remove all custom database objects (indexes,
triggers, and so on).

If you are migrating from Deltek Vision, GovWin CM, or Ajera CRM, you must be on version 7.6
(CU9) or later.

DPS supports both SQL Server authentication modes: Windows Authentication Only mode or
SQL Server and Windows Authentication mode (also known as "Mixed Mode").

Supported Deployment Scenarios

DPS supports single server, dual server, or multi-server installations.

DPS supports advanced deployments, such as the use of DMZ, multiple web servers, and
dedicated process servers.

DPS supports non-standard HTTPS ports.

DPS supports Microsoft SQL Server default and named instances.

DPS supports installing to a drive other than C:\Program Files\Deltek\DeltekPS.
Each server must be a member of the domain.

DPS cannot be installed on domain controllers, Exchange servers, SharePoint servers, terminal
services, or Citrix servers.
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= DPS cannot be installed on existing Deltek Vision/GovWin CM/Ajera CRM web/application
servers. However, DPS can use the same database and report servers as Deltek Vision/GovWin
CM/Ajera CRM.

= DPS supports SQL Server instances and multiple SQL Server instances on the same server.

=  DPS supports using a different SQL Server instance for the DPS and Report Server databases.

Service Accounts

Deltek recommends that you use domain accounts for IIS Application Pool, DPS Process Server, and
database access. However, you can use local accounts. If an account doesn'’t exist, the DPS setup script
creates a local account with a username and password that you specify.

Passwords

When you specify a password—for example, for the Application Pool Identity or database logon—the
setup script checks the password against a list of known insecure passwords and does not allow you to
use an insecure password.

All passwords must meet any domain policy requirements.

What Do I Need to Do Before Installation?

Before you begin the installation process:
= Review this guide.

=  Set up a dedicated web/application server. You can use an existing report and database server if
they meet operating system and SQL requirements.

=  Set up FQDNSs for the web/application and report servers.
=  Set up SSL certificates for the web/application and report servers.
= |nstall and configure IIS and test FQDN/SSL URL access.

= Enable, configure, and test PowerShell Remoting on the web/application, report, and database
tiers.

What Do I Need to Decide Before Installation?

Before you begin the installation process, you should know:
= The fully qualified domain names for your web/application and report servers.

= The service accounts that you will use for your 1IS Application Pool Identity and DPS process
server.

= How you will connect to your database server (Windows Integration or SQL logon) with sysadmin
rights.

= What SQL logon you will use for DPS access.
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DPS URLs

After installation, your DeltekPS folder will contain a DPSURL.txt file listing your specific URLS. Your
URLSs for DPS will be in these formats:

Launch Page https://[<FQDN>/DeltekPS

Web Client https://[<FODN>/DeltekPS/app

Desktop Client (*Smart https://[<FQDN>/DeltekPSClient
Client”)

To launch the desktop client, you must append
/DeltekVision.application to the URL, like this:
https://<FQDN>/DeltekPSClient/DeltekVision.application.

Alternatively, you can go to the launch page (https://<FQDN>/DeltekPS)
and select the desktop client.

The desktop client link appears on the launch page only if you run DPS
from Internet Explorer or Edge.

Touch CRM* https://<FQDN>/DeltekPS/Touch/CRM

Touch Time* https://<FODN>/DeltekPS/Touch/Time

Outlook (manifest) https://<fqdn>/DeltekPS/outlook/manifest-<clientID>.xml in which
<clientID> is your Deltek customer ID number

Outlook (configuration) https://[<FQDN>/DeltekPS

WebLink https://<FQDN>/DeltekPSClient/weblink.application

You must initially run WebLink on the web/application server using
http://localhost/DeltekPSClient/\Weblink.application to set a password.
Thereafter, you can run it using the FQDN.

Touch Applications and DPS

If you are migrating from Deltek Vision, GovWin CM, or Ajera CRM and use the Touch applications, you
must download the Deltek CRM for Professional Services and/or Deltek Time and Expense for
Professional Services applications from the app store.
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Permissions Required to Install DPS

If you plan to perform a DPS installation, you must have the appropriate rights and privileges.

Attention: For more information, see How to Give Your Account Proper Rights and Privileges in

Reporting Services.

Permissions Required

Web/Application =
Tier

Process Server
Tier

Report Server =
Tier

Database Server
Tier

Your Windows account must be a member of the Local Administrator group
on the server.

Your Windows account must be a member of the System Administrator
group and Content Manager Roles in SQL Server Reporting Services on the
report server.

The setup script requires that you have a user account with sysadmin rights
to connect to the database server. This can be the account that you are
using to run the setup script or can be another SQL login account with
sysadmin rights.

Your Windows account must be a member of the Local Administrator group
on the server.

Your Windows account must be a member of the Local Administrator group
on the server.

Your Windows account must be a member of the System Administrator
group and Content Manager Roles in SQL Server Reporting Services on the
report server.

Your Windows account must be a member of the Local Administrator group
on the server and a member of the SYSADMIN role in SQL Server.

DPS Server Account Requirements

You can choose to have the DPS installation create a local account and use that account to set up DPS
server components, including configuring 11S Web Server settings, creating and launching the DPS

Process Server Windows service, and running DPS reports. However, Deltek recommends that you use a
domain account instead of a local account.

If you have a domain or local account policy that has stringent password requirements, the DPS
installation will be unable to create the local account and you will need to manually configure the DPS
server components before users can launch the application. If this happens, you will not be able to run

reports.

Technical Installation Guide

11




Deltek gwmore

Prerequisites

Prerequisites

Before you install DPS, you must have the following software and configurations in place. Although every
attempt is made to keep these prerequisites up to date, Deltek recommends that you verify them against
the Deltek Platform Compatibility Matrix, which always has the latest compatibility information:

https://deltek.custhelp.com/ci/fattach/get/2975379/0/filename/DeltekProductSupportCompatibilityMatrix. pdf

Operating System =  Windows Server 2016, or
=  Windows Server 2012 R2 (Windows Server 2012 is not supported.)

SQL Server =  SQL Server 2017, or
= SQL Server 2016 SP1
See Deltek’s Platform Support Compatibility Matrix for currently supported SQL Server
Cumulative Updates.

SQL Server = SQL Server FILESTREAM must be installed and configured.

FILESTREAM . . .
See Configure Transaction Document Management for more information.

SQL Server Feature =  SQL Server 2016 SP1 or later CLR Types. Download from:

szzg‘; i?gr‘:]g]t:‘ser https://download.microsoft.com/download/6/4/5/645B2661-ABE3-41A4-BC2D-
34D9A10DD303/ENU/x64/SOLSysClrTypes.msi

=  SQL Server 2016 SP1 or later Shared Management Objects. Download from:

https://download.microsoft.com/download/6/4/5/645B2661-ABE3-41A4-BC2D-
34D9A10DD303/ENU/x64/SharedManagementObjects.msi

=  SQL Server 2016 SP1 or later PowerShell Module. Download from:

https://download.microsoft.com/download/6/4/5/645B2661-ABE3-41A4-BC2D-
34D9A10DD303/ENU/x64/PowerShellTools.msi

PowerShell = PowerShell Version 5.1 (installed by default on Server 2016). Download Version 5.1
for Windows Server 2012 from:

https://www.microsoft.com/en-us/download/details.aspx?id=54616

To check your version, run the PowerShell Console as an administrator and enter
$PSVersionTable.PSVersion

= The Deltek PS PowerShell installation must be run using the Windows PowerShell
Console, not the Windows PowerShell ISE (Integrated Scripting Environment). See
Considerations for Running the PowerShell Script for more information.

= Do not use the Run with PowerShell option on the default right-click context menu
to run the script. This option does not run commands with Administrator rights. If you
want to add a Windows Explorer right-click option, use the
EnableWindowsExplorerPowerShelllntegration switch to enable the Open Windows
PowerShell Here as Administrator menu option. This option displays in the right-
click menu in Windows Explorer.
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https://download.microsoft.com/download/6/4/5/645B2661-ABE3-41A4-BC2D-34D9A10DD303/ENU/x64/PowerShellTools.msi
https://download.microsoft.com/download/6/4/5/645B2661-ABE3-41A4-BC2D-34D9A10DD303/ENU/x64/PowerShellTools.msi
https://www.microsoft.com/en-us/download/details.aspx?id=54616
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Prerequisites

.NET Framework = .NET 4.6.2 or higher (NET Core is not supported.)

Internet Information = IS is required only on the web/application server.

Services (IIS . . . .
(1S) See Microsoft Internet Information Server (1I1S) Installation on Windows Server for more

information

Secure Sockets Layer = Avalid SSL certificate with resolvable fully qualified domain name must be installed
(SSL) and configured on both the web server (1IS) and the report server for the installation
to proceed.

= You can use a self-signed certificate for local single server installation testing only.

See Configure Secure Sockets Layer (SSL) for more information.

Transport Layer = TLS 1.1/1.2 s required.
Security (TLS) = Older TLS/SSL protocols must be disabled on all DPS tiers:

= TLS 1.0 should be disabled on all tiers, but the installation will continue with a
warning if it is not disabled.

= SSL 2.0/3.0 must be disabled.
= Once these protocols are disabled, you must restart your server.

= You can also use the ISCrypto tool by Nartac Software to disable these older
protocols.

See this article for more information about disabling protocols:

https://support.microsoft.com/en-us/help/187498/how-to-disable-pct-1-0-ssl-2-0-ssl-3-0-or-
tls-1-0-in-internet-informat

Visual C++ Runtime = Necessary for Touch applications.
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Prerequisites

Prerequisite Checks Run Automatically

Every time that you run the setup script, regardless of the switches that you use, the script checks that
prerequisites are in place. The following screenshot shows the prerequisite checks that are performed:

eltek Tor Prof 1onal Services (DeltekPS) Installation Script

rogram fileshdelte

ort

/alidating username and pas
Checking Tor DeltekPS Setting

nloading Deltek PowerShell Modules
= completed

Jownloading DeltekPS Configuration File

Checking 5 em Prerequisites

roduct

Services...
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Considerations for Running the PowerShell
Script

You will use Microsoft PowerShell to install DPS on your servers. PowerShell is a command-line shell and
scripting language, designed specifically for system administrators and power-users.

Read this article for background information about PowerShell:

https://docs.microsoft.com/en-us/powershell/scripting/powershell-scripting ?view=powershell-5.1

PowerShell Console

You will run the DeltekPS.ps1 installation script from the PowerShell Console window. Launch the
PowerShell console from the operating system Start menu:

> Windows PowerShell

T Windows PowerShell (x86)
[

E Windows PowerShell ISE

B \indows PowerShell ISE (x86)

Note: DO NOT attempt to run the DeltekPS.ps1 installation script using the Windows PowerShell
ISE.

Digital Signature

The DPS PowerShell installation script is digitally signed by Deltek and will not execute if modified in any
way.

Firewall Rules for PowerShell Remoting

The DPS installation process uses PowerShell remoting several times to:
= Create local accounts on remote servers (if a local account is selected as the service account).
=  Obtain remote server information needed for setup.

Remoting is enabled by default. Remoting uses the Windows Remote Management framework service,
which listens on port 5985.

Read this article to learn how to enable PowerShell remoting:

https://docs.microsoft.com/en-us/powershell/module/microsoft.powershell.core/enable-
psremoting?view=powershell-5.1

Technical Installation Guide 15


https://docs.microsoft.com/en-us/powershell/scripting/powershell-scripting?view=powershell-5.1
https://docs.microsoft.com/en-us/powershell/module/microsoft.powershell.core/enable-psremoting?view=powershell-5.1
https://docs.microsoft.com/en-us/powershell/module/microsoft.powershell.core/enable-psremoting?view=powershell-5.1

Deltek &ovmere

Considerations for Running the PowerShell Script

If you are using dynamic ports for your SQL Server, read this article to learn about correct firewall
configuration:

https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/configure-a-windows-
firewall-for-database-engine-access

PowerShell Execution Policy

The default execution policy (get-executionpolicy) for the DPS-supported operating systems is
RemoteSigned. Your organization may require a tighter policy (for example, Restricted), in which case
you may see an error message such as this when you try to run the script:

C:\P [ tek\Deltel cripts

Run the following command from the PowerShell console to temporarily change the execution policy to
RemoteSigned:

Set-ExecutionPolicy —Scope Process —ExecutionPolicy RemoteSigned

This command changes the policy for this console session only, meaning that if you close the console
and re-open it, you will need to run the Set-ExecutionPolicy command again.

Prompts for Deltek Support Username and Password

Whenever you run the DeltekPS.ps1 script, the script prompts you for your Deltek Support username and
password. When you enter these credentials, the script:

= Checks to see if you have rights to access Deltek Software Manager, where installation files are
stored.

= Downloads any newer versions of the DPS PowerShell modules and configuration files.

You will receive the following error message if you do not run Internet Explorer before you enter your
username and password. This step is required before PowerShell can make any Invoke-WebRequest
calls. To resolve the error, start Internet Explorer, complete the initialization process, and re-run the script.
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Deltek Tor Protessional Services (DeltekPS) Installation 5cript

Checking installation directory (c:“program files‘deltek'deltek

e: richmccloud@deltek. com
d for richmccloud@deltek. com: ==

Log Files

The installation creates a logs subfolder, located in the \Program Files\Deltek\DeltekPS folder, that
contains the installation log as well as conversion log files created for each database that may have been
upgraded during the installation.

Installation Log
To find errors in the log file, select one of the following actions:
= Server installations: Search for the word error in the log file.

= Database Upgrades: Search for “msg” in the log file.

Log Files Generated During the Report-Loading Process

If there are any errors during the installation process when reloading reports, they are logged in the
installation log. Resolve any errors and reload your reports manually through the application.

If there are errors, you can reload your reports by accessing the SmartClient application Utilities »
Report Administration and clicking Load Report Files or by using the LoadReports switch which will
load reports for all languages for the entered database.

Conversion Log

If you upgraded any databases during the installation process, the installation creates database
conversion log files, which are saved in the same timestamp folder as the setup logs.

Troubleshoot Installation Problems

If you encounter problems during the DPS installation on the server and are unable to continue, contact
Deltek Customer Care for assistance and include the following information:

= The timestamped setup log stored in the installation directory\logs folder on the DPS server.

= Screenshots and details about the errors received.
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Note: A Deltek Customer Care analyst might ask you to use the SendLogsToDeltek switch, which will
zip and e-mail the logs directly. This information will help Deltek resolve your issue as quickly as
possible.

Invoke-SQLCMD Error

If you receive an “Invoke-Sqglcmd” error while running the setup script, the likely cause is that you installed
the SQL Server Feature Pack prerequisites while the PowerShell Console application was open and have
not closed the console.

To resolve this error, close the PowerShell console and restart it.
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Tips and Tricks for Using the PowerShell
Console

Use these tips as you work in the PowerShell Console.

Navigation

Maximize the size of the PowerShell Console for easier reading and formatting.

Create a batch file (or use the CreateDeltekPSCMDFile switch to create a batch file) that
automatically launches the PowerShell Console.

Use the EnableWindowsExplorerPowerShelllntegration switch to add a PowerShell Console right-
click context menu to Windows Explorer. Do not use the Run with PowerShell option on the
default right-click context menu to run the setup script. This option does not run commands with
Administrator rights. If you use the Run with PowerShell option, an error message will flash
quickly and the PowerShell console window will close.

To copy/paste in the PowerShell console:
1. Use your mouse to highlight the text that you want to copy.
2. With the text highlighted, right-click and select Copy.

3. Place the cursor where you want to paste the text, right-click and select Paste.

Entering Commands

As you respond to prompts, you may see default values in brackets. If the default value is correct,
press ENTER to accept the default.

PowerShell remembers a list of the most recent commands entered. Even if you close the
console and re-open it, you can use the up and down arrows to navigate through previously
entered commands. This functionality is enabled by default in Windows Server 2016, but may
require you to install the PSReadLine module to function properly in Windows Server 2012 R2.

Attention: For more information about PSReadLine, see this article:
https://github.com/lzybkr/PSReadLine.

PowerShell also remembers your previous responses to prompts, so you can use the up and
down arrows to reuse these, too.

You must run all scripts with the period and back-slash characters before the script name (for
example, \DeltekPS.ps1).

You can begin entering the name of a file and then press TAB to auto-complete the entry. For
example, to enter the filename DeltekPS.ps1, type Del and press TAB. If multiple options exist,
tab through them until you find the correct one. The auto-completion places the characters .\ in
front of the filename (for example, .\DeltekPS.ps1).
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Performance

= If scripts or executables are running very slowly on Windows Server 2016, try running the
following command to temporarily disable Windows Defender real-time monitoring:

Set-MpPreference —DisableReal TimeMonitoring $true
To re-enable real-time monitoring, run the same command but use $false instead of $true.

= |f the console appears to be hung, check to see if the word Select is shown in the console
window:

EN Gelect Administraton Windows PowerShell

If itis, click the top bar of the console and press ENTER.
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Known Issues

These known issues will be resolved in future releases:

= |f the script is not able to connect to the report server URL, you will not be re-prompted for the
report server information and the script will exit. To work around this problem, ensure that the
report server URL is valid and re-run the script.
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Download the PowerShell Script

When you are sure that your prerequisites are in place, download the PowerShell script, DeltekPS.ps1, to
a temporary location on your DPS web/application server.

Download it from Deltek Software Manager (DSM), the tool that Deltek uses to distribute new software
and updates. You can access DSM through the Deltek Support Center or use Deltek Software Manager
Lite to download Deltek products.

Note: The installation directory for DPS is determined by the drive from which you run the installation
script. For example, if you want to install DPS on the D:\ drive, download the DeltekPS.ps1 file to a
temporary folder on the D:\ drive.

Download the Script via the Deltek Support Center

To download the script via the Deltek Support Center:

N o o b~ w DD Pe

In your Web browser, go to http://support.deltek.com.

Enter your Deltek Support Center Username and Password, and click Login.
When the Deltek Support Center page displays, click Product Downloads.

On the Deltek Software Manager screen, click Launch Deltek Software Manager.
On the Application Run dialog box, click Run to download the software manager.
Open Deltek Software Manager from the new icon at the bottom of your screen.

Click Settings at the top right of the dialog box to use the Settings dialog box to specify the folder
where you want to download Deltek products, and click OK.

Note: When you log on for the first time, DSM asks you to select a default folder where
Deltek products are to be downloaded. You can change this folder at any time on the Settings
dialog box.

In the left pane, scroll to DeltekPS (1) and expand the folder structure.

= DeltekPS (1)
= DeltekPS 1.1 (GA) (1)

=] Complete (2)

[m] Release Available On *
[22] | Deltek for Professional Services 1.1.8

Select the most recent version of DPS.

The right pane displays a message stating that the setup files have been added to the download
queue.

Note: To view the items in the download queue, click View Download Queue at the bottom
of the left pane.

10. Click Download at the bottom of the left pane to download the files to the folder that you

selected.
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Download the Script via DSM Lite

To download the script via Deltek Software Manager Lite:

In your Web browser, go to https://dsm.deltek.com/DeltekSoftwareManagerLite.

2. Enter your Deltek Support Center Username and Password, and click Logon.

3. When the Deltek Software Manager Lite page displays, select DeltekPS 1.1 GA from the drop-
down list.

4. Under Complete Releases, click the most recent version of DPS.
Deltek Software manager prompts you to run or save the setup script (DeltekPS11.exe).

5. Save the file to a folder.

Note: The download behavior and download folder may differ depending on the browser and
browser settings that you are using.

DSM Documentation and Troubleshooting

Refer to the following links for additional information:

= Deltek Software Manager online help

=  Troubleshooting Deltek Software Manager

Note: When you click a link, you will be asked to log into DSM if you are not already logged in.
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Optional Switches

Optional Switches

This table lists all of the switches that you can run with the DeltekPS.ps1 PowerShell script. You use
some switches when you first install DPS and others after DPS is up and running.

Use this switch to... Read this section...

SetupDatabaseNew

MigrateDatabase

CreateDatabaseEntry

SetupWebApp

InstallDedicatedProcessServer

Download;

Download AndExtract;
DownloadPreReq;
DownloadDatabases

Upgrade; UpgradeWebApp;
UpgradeProcessServer;
UpgradeDatabases

InstallProcessServer;
RemoveProcessServer

SetServiceAccount

LoadReports

Uninstall

Create a new blank database
after you have already installed
DPS.

Migrate an existing Deltek
Vision, GovWin CM, or Ajera
CRM database after you have
already installed DPS.

Add a migrated database to the
databases.enc file.

Install a secondary
web/application server for load
balanced configurations.

Install a stand-alone dedicated
process server.

Download and extract
installation files.

Apply upgrades to your DPS
implementation.

Uninstall or reinstall the
process server service.

Change the default service
account used for the IIS
Application Pool Identity, the
Process Server service
account and for Reporting
Services authentication.

Reload DPS reports to the
report server.

Remove DPS from the
web/application server.

SetupDatabaseNew Switch

MigrateDatabase Switch

CreateDatabaseEntry Switch

SetupWebApp Switch

InstallDedicatedProcessServer
Switch

Download, DownloadAndEXxtract,
DownloadPreReq, and
DownloadDatabases Switches

Upgrade, UpgradeWebApp,
UpgradeProcessServer, and
UpgradeDatabases Switches

InstallProcessServer and
RemoveProcessServer Switches

SetServiceAccount Switch

LoadReports Switch

Uninstall Switch
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Use this switch to... Read this section...

EnablellISRequiredFeatures

GetLicenseFile

UpdateLicense

EnableWindows-
ExplorerPowerShellintegration

CreateDeltekPSCMDFile

SendLogsToDeltek

Cleanup

Enable required IIS features
that are currently disabled.

Generates the DPS license file
as a .SQL script that can be
applied to your databases.

Generates the DPS license file
as a .SQL script and applies it
to all of the databases defined
in your databases.enc file.

Enable Windows Explorer to
open a PowerShell prompt
from the folder selected.

Create a batch file to run
DeltekPS.psl1 and set the
PowerShell Execution Policy
for the process.

Compress all of the logs in the
\Logs folder and e-mail them to
Deltek.

Remove older files no longer
needed in SmartClient and the
Database Scripts folder.

EnablelISRequiredFeatures
Switch

GetLicenseFile Switch

UpdateLicense Switch

EnableWindows-
ExplorerPowerShelllntegration
Switch

CreateDeltekPSCMDFile Switch

SendLogsToDeltek Switch

Cleanup Switch
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Run the Script with No Switches

After you download the PowerShell script, DeltekPS.ps1, to a temporary location on your DPS
web/application server, you can begin installing DPS.

First, run the script using no switches to:

Set up the installation environment, including creating the installation directory and copying the
script to the installation directory \Scripts folder.

Verify that the prerequisites are in place to run the script with switches. (These “script” pre-
requisites are different from the product/software pre-requisites, which are validated when you
run the —CheckPreReq switch.)

Procedure

To run the script with no switches:

1. On the operating system Start menu, launch the Windows PowerShell Console:

> Windows PowerShell

."! Windows PowerShell (x86)

B Windows Powershell ISE

B windows PowerShell ISE (x86)

Run the console using the Run as Administrator option on the right-click context menu.

The DeltekPS.ps1 script includes a #Requires statement that checks that you are running the
PowerShell Console using the Run as Administrator option. If you are not, this message
displays:

PS C:\temp> .\DeltekPs.psl

From the PowerShell Console, which is similar to the command prompt, change the default
directory (c:\windows\system32) to the temporary location where you stored the DeltekPS.ps1
script (for example, c:\temp).

Note: The installation directory for DPS is determined by the drive from which you run the
installation script. For example, if you want to install DPS on the D:\ drive, download the
DeltekPS.ps1 file to a temporary folder on the D:\ drive.

To run the script, enter DeltekPS.ps1 and then press TAB to autocomplete the entry.

The auto-completion places the characters .\ in front of the filename (.\DeltekPS.ps1).
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The script runs and performs these steps:
a. The script identifies the directory from which the script was executed.

b. If this is not the supported installation directory (for example, <drive>:\Program
Files\Deltek\DeltekPS), the script creates the supported installation directory.

c. The script copies the DeltekPS.ps1 file to the installation directory \Scripts folder.
d. The script prompts you to re-run the script.
To re-run the script, enter DeltekPS.ps1 and then press TAB.

Now, and whenever you run the script in the future, the script prompts you for your Deltek
Support username and password. When you enter these credentials, the script:

= Checks to see if you have rights to access Deltek Software Manager, where installation files
are stored.

= Downloads any newer versions of the DPS PowerShell modules and configuration files.

Enter ur Delt il _richm
Enter your De support ~d for richmccloud@deltek. com
/alidating username and pa:

Enter your Deltek Support username and password.

The script checks that the correct versions of the following prerequisites are installed:

= QOperating system
= .NET Framework
= PowerShell
=  SQL Server features
The script checks that SSL 2.0/3.0 and TLS 1.0 have been disabled.

If any third-party software prerequisite are missing, they display in red in the script messages.
The script automatically downloads the required installers to the following location and opens the
folder:

<drive>:\Program Files\Deltek\DeltekPS\Support\PreReq

Resolve the problem before continuing with the setup process.

Setup Steps Performed by the Script

1.
2.

The script verifies that the installation directory is valid.

The script prompts you for your support username and password and validates them before
continuing.

The script downloads the DeltekPSSettings.xml file, if it is missing.

This file stores information about the setup, is server-specific, and is persistent from release to
release. You should not change this file unless Deltek support asks you to change it.

The script downloads the latest DPS PowerShell Modules.
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5.

The script checks to ensure that the latest DeltekPS.ps1 script is being used. If not, it downloads
the latest script and prompts you to restart setup.

The scripts checks script prerequisites, including:
=  Operating system

= .NET Framework

=  PowerShell

=  SQL Server features

= Microsoft Visual C++ Runtime

If any third-party software prerequisite are missing, they display in red in the script messages.
The script automatically downloads the required installers to the following location and opens the
folder:

<drive>:\Program Files\Deltek\DeltekPS\Support\PreReq
The script checks that SSL 2.0/3.0 and TLS 1.0 have been disabled.

Every time the script is run, it downloads the DeltekPSConfiguration.xml file and overwrites any
existing version of this file. The file stores meta-information about releases that the script uses to
derive release, version, configuration, and dependency information. You should not change this
file unless Deltek support asks you to change it.

10. The script gathers information about the user running the script, the server, and the domain.

11. The script checks for an existing installation of DPS.

12. The script validates your access to DPS before continuing with the setup.
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Screenshots of Setup Steps

Successful Installation

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 with no
switches.
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Unsuccessful Prerequisite Check

If you run the script without having the script prerequisites installed, you will see output similar to this
example:

sername: richmccloud
for richmeccloud@deltek

File
ttings File (DeltekPSSettinc

nloading Deltek Po ell Module
nload and Extracti Deltek ershell Modules completed

ent script
=1

WNEXT] TL5 1.0 1is enabled. Deltek recommends TLS 1.0 be disabled

nation on t
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Run the Script with the CheckPreReq Switch

The next time that you run the PowerShell script, DeltekPS.ps1, run it with the CheckPreReq switch.

Procedure

To run the script with the CheckPreReq switch:

1.

Run the script from the DPS installation \Scripts directory with the CheckPreReq switch
appended:

DeltekPS.ps1 —CheckPreReq

The script runs and checks that all required 1IS features are enabled.

If any of these features are not enabled, install them using Windows Server Manager or
Deployment Image Servicing and Management (DISM), or use the EnablelISRequiredFeatures
switch discussed in Microsoft Internet Information Server (IIS) Installation on Windows Servers.

If the IIS features are enabled, the script prompts you for the web, database, and report servers
to which you are installing DPS.

Enter the URL to your web server.

The script tries to connect to the server and checks that a valid SSL certificate is installed on it. If
the script cannot make a valid HTTPS connection, this message displays:

Setup will now prompt yvou for information on your Web Server.

wWeb Server [https://DPSOPSCLEAN1ZR2.dev.ads.deltek. com]:

Web Server [https://DPSOPSCLEAN12R2. dev.ads.deltek. com]:

If you receive this message, check that the URL is correct and that an SSL certificate has been
installed. Then re-try the connection. In most instances, your SSL certificate is assigned to a
custom DNS value, not the DNS name of the server, even though the DNS name of the server
displays in brackets at the prompt.

If the connection is successful, the script prompts you for your database server.
Identify your database server.

= Enter the name of your database server. If you are using a named SQL instance, identify the
server in the form Server\instance.

= The script attempts, via Windows Management Instrumentation (WMI), to obtain the port on
which your SQL Server instance is listening and validate that a connection can be made. If
the script cannot determine the port, the connection attempt is made on TCP port 1433. If a
connection cannot be made there, the script prompts you to check that the server name is
correct and that the necessary ports are open in the firewall.

= If you are using dynamic ports, see the firewall information in this document.

If the connection is successful, the script prompts you for your SYSADMIN user account.
Identify your SYSADMIN user account to connect to the database server.

= |f your domain account is a member of the sysadmin role, press ENTER at the [WI] prompt
(for Windows Integrated). If not, enter a SQL login with sysadmin rights.

= Once a connection is made to the database server, the script checks that SSL 2.0/3.0 and
TLS 1.0 have been disabled on the remote server.
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= If necessary, disable the SSL and TLS protocols, reboot the server, and re-run the script. The
script checks that the correct versions of the following prerequisites are installed:

=  SQL Server
= FILESTREAM

If the connection is successful, the script prompts you for your report server.

6. Enter the hostname of your report server and press ENTER. This must be the machine name, not
the FQDN or the IP address.

The script checks that a valid SSL certificate is installed on the report server.

The script creates the default report server URL.
7. If the URL is correct, press ENTER; otherwise, enter the correct URL.

For example, you may use a custom DNS record for the server that does not match the
hostname, or you may use a SQL instance, which will typically create the default report server
virtual directory in the form ReportServer_<InstanceName>.

8. Enter the report server URL.

= Once a connection is made to the report server, the script checks that SSL 2.0/3.0 and TLS
1.0 have been disabled on the server and that an SSL (https) connection can be made.

= If necessary, disable the SSL and TLS protocols, reboot the server, and re-run the script.

Screenshot of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 —
CheckPreReq.
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Run the Script with the Setup or
SetupAndMigrate Switch

The next time that you run the PowerShell script, DeltekPS.ps1, run it with one of the two Setup switches:

Use this switch... Read this section...

Setup If you are installing DPS and creating Run the Script with the Setup Switch
a completely new DPS database.

SetupAndMigrate If you are migrating to DPS from Run the Script with the
Deltek Vision, GovWin CM, or Ajera SetupAndMigrate Switch
CRM.

Whether you are installing DPS on one server or multiple servers, all installation functions are performed
from the web/application server where the DPS PowerShell Installation script is run. The only exceptions
are when you use one of these switches:

= DownloadDatabases

= InstallDedicatedProcessServer

=  Download

= DownloadAndExtract, followed by MigrateDatabase

= The MigrateDatabase switch is used primarily with the DownloadAndExtract switch to test
migrations from Ajera CRM, GovWin CM, or Vision 7.6 (CU 9 or later). Run the
DownloadAndExtract switch, and then run the MigrateDatabase switch. After you validate
your database migration, use the SetupAndMigrate switch on the same server to make your
installation production-ready and perform your go-live migration at the same time.

= Alternatively, you can use the Setup switch (which will, by default, install a blank DPS
database) to make the installation production-ready, and then use the MigrateDatabase
switch to perform your go-live migration. When you use the MigrateDatabase switch, the
script does not create a WebLink entry. Use the CreateDatabaseEntry switch to add the
migrated database to WebLink.

After you run the installation script with any of the available switches, a log is created. Deltek
recommends that you review the log files if you encounter any errors during the installation. If you find
any errors, contact Deltek Customer Care with the contents of the log file.

Setup logs are written to the installation directory Logs folder, stamped with the date and time that the
setup script was executed.
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Use the PowerShell script, DeltekPS.ps1, with the Setup switch to install DPS and create a completely
new DPS database. If you are migrating from to DPS from Deltek Vision, GovWin CM, or Ajera CRM, use
the_SetupAndMigrate switch instead.

You can perform a one, two, or three tier installation with the Setup switch.

Procedure

To run the script with the Setup switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -Setup.
The script prompts you for your Deltek Support username and password.
2. Enter your Deltek Support username and password.
The script displays this message:

Deltek for Professional Services requires resolvable FQDN using a valid SSL certificate
being installed on both the Web Server (lIS) and the Report Server. TLS 1.1/1.2 are
required. SSL 2.0/3.0 must be disabled. PowerShell Remoting is used so ensure it is
enabled on all your tiers.

The installation scripts are signed and should not be changed.

Please read the installation documentation (that explains all above in more detail) before
continuing.

3. Select Yes if you have read the installation documentation.
A new browser window opens, containing Deltek’s licensing terms.

4. Read the licensing terms and, if you agree with them, return to the PowerShell console and select
Yes.

The script prompts you for the URL for your web server. As the default, it displays the fully
qualified domain name of the server, with the prefix HTTPS.

5. Either press ENTER to accept the displayed value or, if your web server SSL certificate is
registered to a custom DNS value, enter the fully qualified URL for the web server.

The script prompts you for the account to be used as the 1S Application Pool identity. The default
value is a local account called [DeltekPS].

This account is used for the following service roles:
= Application Pool Identity

= Process Server service account

= Report Server Content Manager account

(Use the SetServiceAccount switch if you need to change these settings at a later time.)

6. Either accept the default value of [DeltekPS] or use an existing domain account.

The script prompts you for a password for this account.

Technical Installation Guide 34



Deltek gwumor

Run the Script with the Setup Switch

7. Enter and confirm the password.

If you entered a local account, the script uses the account value to create a local user account.
Regardless of whether you entered a local or domain account, the script adds the account to the
local administrator group. The script checks that the password entered is a secure password so
that it will pass standard Domain Group Policy password tests.

The script prompts you for the name of your report server.

8. Enter the hostname of your report server and press ENTER. This must be the machine name,
not the FQDN or the IP address.

When you enter the hostname, the script uses it to build a URL to the report server, which is the
default value you will see in brackets. Your actual FQDN will likely be different and must be tied to
the SSL certificate. The server URL must be SSL secured.

If the script cannot connect to the server, it prompts you to confirm this information:
= Report server name (the default is [HostName])
= Report server URL, in the format [https://FQDN/ReportServer]

If you are using a named instance for your Reporting Services installation (for example, if you are
performing a SQLExpress installation), your virtual directory is probably in the format:
ReportServer_<InstanceName>. Your report server databases is probably in the form
ReportServer$<instanceName>. The script checks for your report server database names and
prompts you if a connection cannot be made. Because you may have your Report Server
databases on a different SQL Server instance, you will be prompted for the name of the Report
database server as well as the Report Server database name.

9. If the Report Server URL presented in brackets is correct, press ENTER to use it. If not, change
the value to the correct URL for your Report Server and then press ENTER.

The script connects to the report server and validates the server’'s TLS configuration.
Then it prompts you for the information needed to connect to your database server.
10. Identify your database server.

=  Enter the name of your database server. If you are using a named SQL instance, identify the
server in the form Server\instance.

= The script attempts, via Windows Management Instrumentation, to obtain the port that your
SQL Server instance is listening on and validate that a connection can be made. If a port
cannot be determined, the connection attempt is made on TCP port 1433. If a connection
cannot be made there, the script prompts you to check that the server name is correct and
that the necessary ports are open in the firewall.

= If you are using dynamic ports, see the firewall information in this document.

If the connection is successful, the script prompts you for your database username.

11. Enter your database username. This should be either a SQL login or a Windows account. The
default is [WI] for Windows Integrated.

The account must be a member of the SQL server sysadmin fixed server role. The script checks
for this.

The script connects to the database server and validates the server's TLS configuration. Then it
prompts you for the name of the database that will be created.

12. Enter the name for your new blank DPS database. The default is [DeltekPS]. The script prompts
you for a SQL login and password.
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13. Enter a SQL login and password.

These credentials will be associated with the DPS database and the report server databases and
granted the db_owner role.

This account can be a SQL Server or Windows login. If you use a Windows account, it must be
the 11S Application Pool Identity. If it is not, you will receive a message and prompt to use the
Application Pool Identity.

If you use a Windows account, the script automatically selects the Windows Authentication
checkbox in WebLink for both DPS and report server database access.

The script does the following:

a. Checks that the password entered is a secure password so that it will pass standard
Domain Group Policy password tests.

b. Checks for the existence of the report server databases. If the script does not find the
default Report Server database name, ReportServer, it prompts you for the name of the
report database server and the Report Server database name.

The script has all of the information that it needs to complete the setup and begins performing
setup steps.

14. When the setup steps are completed, your DPS administrator can log into DPS and begin the
activation and setup process.

Setup Steps Performed by the Script

After you enter all of the information needed to run DeltekPS.ps1 -Setup, the script completes the
following steps:

1. The script verifies that the SQL Server version is supported and FILESTREAM is enabled.

2. The script downloads and extracts the PHP.exe file, needed to set up the Deltek Touch
applications, and DeltekPS<Build#>.exe, the core DPS installation files. This process takes
several minutes.

3. The script sets up required IS components:
= Application Pool (DeltekPSAppPoaol)
=  Applications:
= DeltekPS: Server side components
= DeltekPS/App: Web client
= DeltekPSClient: Smart client

4. The script creates the blank DeltekPS database and creates and configures a blank
FILESTREAM database (DeltekPSFILES). Then it runs the database script to create the default
DPS database schema.

5. The script creates new SQL logins or associates existing logins with their respective databases.
This includes creating a local account on the database server if you are using a local account for
the Application Pool Identity.

6. The script creates a backup device named DeltekPS for use with the backup utility in the desktop
client.

The script updates databases.enc with values that were provided during the setup.

8. The script configures IIS for PHP (the Deltek Touch applications).
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9. The script installs the Process Server service and sets the service account to the account
identified for the Application Pool Identity.

10. The script sets permissions for Reporting Services. This includes creating a local account if you
are using a local account for the Application Pool Identity.

11. The script loads reports to the report server, updates Outlook manifest files, and updates Deltek
Touch configuration files.

12. The script writes information about the DPS configuration to the DeltekPSSettings.xml file at the
root of the installation directory.

Warning: Do not delete this file. You will need it for future upgrades.

13. The script obtains your current DPS license information and applies the licenses to your newly
created database.

14. The script clears the PowerShell console memory of all values used in the setup process.

15. The script launches the DPSURL.htm file from the root of the installation directory. This file lists
URLSs for all of your DPS applications.

Screenshots of Setup Steps

These screenshots show the complete output from a successful installation run using DeltekPS.ps1 -
Setup.
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Setup will now prompt you for information on your Report Server.
Mote: You must have Administrative rights to yvour Report Server.

Enter the Hostname of your Report Server [DPSOPSCLEAN2016]: visopssqllGexp.dev.ads.deltek.com
Invalid Hostname entered. Enter the Hostname (not an FQDN or IP address).
Enter the Hostname of your Report Server [DPSOPSCLEAN2016]: wisopssqllGexp

Delte

Report Server URL [https: ,./fv1sopssq'|16exp dev. ads.deltek. com/ReportServer]: https://visopssqll6exp.dev.ads.deltek. com/reportserver_sqlexpress

Report Server URL: https://visopssqliéexp.dev. ads.deltek. com/reportserver_sqlexpress

Setup will now prompt you for information on your Database Server.
Mote: You (or SOL logon) must have SysAdmin rights to your Database Server.

Database Server\Instance [DPSOPSCLEANZO16]: visopssqllGexp\sglexpress
est'l'ng Server connection to visopssqlléexp (Port: 57234)

r Conr on S sful
Database Username to connect or specify WI to use Windows Integrated [WI]:
esting 5QL logon to visopssqlléexp\sglexpress
visiondevsvcacct (Windows Integr‘ated Togon) is a member of the SQL SysAdmin role

Database Name [DeltekPS]:

DeltekPs already exists. Please enter a new name.

Database Name [DeltekPs]: deltekpstest

deltekpstest a'Ir‘eady exists. Please enter a new name.

Database Name [DeltekPs5]: deltekpsdemo

Database Username (this account will be created if it does not exist) [DeltekPs]:
Database Password for DeltekPS:

hecking supplied password against insecure list

Database Password Confirmation for DeltekPs:

i unab'le to connect to your Report Ser‘ver‘ database Please enter the name of your Report Server database:
I 0L

Server Ve n/Build:
M1croso'Ft SQL Ser‘ver‘ Version/Build (SQL Ser‘ver‘ 2016 5P1): 13.0.4001

ed in
1 in

Backing up web.config settings to DeltekPssettings.xml
Downloading Deltek for Professional Services.
Downloading DeltekP51182580.exe (this can take up to 5 minutes)
Download Completed (Elapsed Time (min:sec): 23)
Extracting c:‘\program 'F'lles\deltek\de1tekps\DeltekP51182580 exe
Downloading web. config
Downloading initial databases enc
Downloading DeltekPSDatabasesEnc. exe
reating IIS Application Pool (DeltekPSAppPool)
eated application poo
reating IIS Applications/Virtual Directories

Application pool Protocols Physical Path

DeltekPSAppPool http c:\program files\deltek\.deltekps\Web
DeltekPSAppPool http c:\program files\deltek\deltekpsiwWeb\App
DeltekPSClient DeltekPSAppPool http c:yprogram fileshdeltek\deltekps' SmartClient

reating databaze (DeltekPs)

r‘eatmg database (DeltekPs on visopssqlléexphsglexpress)
3 v created DeltekP5 on wi 1 xphsqlexpress

reating FILESFREN-I GEELECE (DE'ItekPSFILES om \nsopssq'llﬁexp\sq'lexpr‘ess)
ful ated DeltekPSFIL| [ 11 5
sfully configured FILESTRE

reating the new database schema

Processing Jobs. Please wait.

Job name [Job54]; State: Comp'leted Processing Done in 2.64 minutes

hecking if Local Account exists

Local user account DeltekPS does not exist and will be created.

reating local account

DeltekPS was not a login on DeltekP5 on wvisopssglléexp)\sqlexpress

DeltekP5S added to DeltekP5 on visopssqlléexpl\sqlexpress and db_owner Role

DeltekPs added to db_owner Role in reportserver$sglexpress on visopssgll6exp\sqlexpress
DeltekPS added to db_owner Role in reportserver$sglexpressTempDB on visopssqll6exp\sqlexpress
visopssglleexpyDeltekPS was not a login on DeltekPSFILES on visopssglleexphsglexpress
visopssqll6exphDeltekPS added to DeltekPSFILES on wisopssqllGexp\sqlexpress and db_owner Role
Updating database entries

Encrypting database entries

Databaze entries updated

onfiguring PHP on IIS
Process Server

Insta'l'lmg Process Server
The Pr er has installed.

Setting Process Server Identity to DeltekPs

De]tekPSchessSer‘ver‘ll stopped
for service 'Deltek PS Prucess Server 1.1 (DeltekP5ProcessServerll)’ to start.
DeltekPS has been set su sfu

Report Serwver

hecking if Local Account exists..

Local user account DeltekPS already exists.

Policy successfully set

he command completed successfu'l'ly

Policy successfully set.
he command completed successfully

alling https: ,.ff\nsopssq'llﬁexp ev. ads. deltek. com,.freportser‘ver‘ 5q1express wwth username: DeltekPS
tion to https:// p.dev. ads. de / tce e Was =ful.
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Run the Script with the SetupAndMigrate Switch

If you are migrating to DPS from Deltek Vision, GovWin CM, or Ajera CRM, use the PowerShell script,
DeltekPS.ps1, with the SetupAndMigrate switch to install DPS. If you are not migrating from Deltek
Vision, GovWin CM, or Ajera CRM to DPS, use the Setup switch instead.

Note: You must migrate from Deltek Vision, GovWin CM, or Ajera CRM 7.6 (CU 9) or a later version.

You can perform a one, two, or three tier installation using the SetupAndMigrate switch.

Procedure

To run the script with the SetupAndMigrate switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -SetupAndMigrate.
2. Enter your Deltek Support username and password.
The script displays this message:

Deltek for Professional Services requires resolvable FQDN using a valid SSL certificate
being installed on both the Web Server (lIS) and the Report Server. TLS 1.1/1.2 are
required. SSL 2.0/3.0 must be disabled. PowerShell Remoting is used so ensure it is
enabled on all your tiers.

The installation scripts are signed and should not be changed.

Please read the installation documentation (that explains all above in more detail) before
continuing.

3. Select Yes if you have read the installation documentation.
A new browser window opens, containing Deltek’s licensing terms.

4. Read the licensing terms and, if you agree with them, return to the PowerShell console and select
Yes.

The script prompts you for the URL for your web server. It will display the fully qualified domain
name of the server, in brackets, with the prefix HTTPS.

5. Either press ENTER to accept the displayed value or, if your web server SSL certificate is
registered to a custom DNS value, enter the fully qualified URL for the web server.

The script prompts you for the account to be used as the 1S Application Pool identity. The default
value is a local account called [DeltekPS].

This account is used for the following service roles:

=  Application Pool Identity

= Process Server service account

= Report Server Content Manager account

(Use the SetServiceAccounts switch if you need to change these settings at a later time.)
6. Either accept the default value of [DeltekPS] or use an existing domain account.

The script prompts you for a password for this account.
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7. Enter and confirm the password.

The script uses the account value to create a local user account and add that user to the local
administrator account.

If you entered a local account, the script uses the account value to create a local user account.
Regardless of whether you entered a local or domain account, the script adds the account to the
local administrator group. The script checks that the password entered is a secure password so
that it will pass standard Domain Group Policy password tests.

The script prompts you for the name of your report server.

8. Enter the hostname of your report server and press ENTER. This must be the machine name,
not the FQDN or the IP address.

When you enter the hostname, the script uses it to build a URL to the report server, which is the
default value you will see in brackets. Your actual FQDN will likely be different and must be tied to
the SSL certificate. The server URL must be SSL secured.

If the script cannot connect to the server, it prompts you to confirm this information:
= Report server name (the default is [HostName])
= Report server URL, in the format [https://FQDN/ReportServer]

If you are using a named instance for your Reporting Services installation (for example, if you are
performing a SQLExpress installation), your virtual directory is probably in the format:
ReportServer_<InstanceName>. Your report server databases is probably in the form
ReportServer$<instanceName>. The script checks for your report server database names and
prompts you if a connection cannot be made. Because you may have your Report Server
databases on a different SQL Server instance, you will be prompted for the name of the report
database server as well as the Report Server database name.

9. If the Report Server URL presented in brackets is correct, press ENTER. If not, change the value
to the correct URL for your Report Server and press ENTER.

The script connects to the report server and validates the server’'s TLS configuration. Then it
prompts you for the information needed to connect to your database server.

10. Identify your database server.

= Enter the name of your database server. If you are using a named SQL instance, identify the
server in the form Server\instance.

=  The script attempts, via Windows Management Instrumentation, to obtain the port that your
SQL Server instance is listening on and validate that a connection can be made. If a port
cannot be determined, the connection attempt is made on TCP port 1433. If a connection
cannot be made there, the script prompts you to check that the server name is correct and
that the necessary ports are open in the firewall.

= If you are using dynamic ports, see the firewall information in this document.

If the connection is successful, the script prompts you for your database username.

11. Enter your database username. This should be either a SQL login or a Windows account. The
default is [WI] for Windows Integrated.

The account must be a member of the SQL server sysadmin fixed server role. The script checks
for this.

The script connects to the database server, verifies that the SQL Server version is supported and
that FILESTREAM is enabled, and validates the server’'s TLS configuration.
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The script prompts you for the name of the Deltek Vision, GovWin CM, or Ajera CRM database
that you will migrate to DPS.

12. Enter the name of the Deltek Vision, GovWin CM, or Ajera CRM database that you will migrate to
DPS.

The script then warns you to remove any custom database objects (indexes, triggers, and so on)
before you proceed with the migration.

13. Enter Yes to acknowledge the warning and proceed or enter No to exit the script.

The script checks that the database has been converted to Unicode. If not, it will convert it as part
of the migration process,

The script asks you if you have a backup of the database.

14. Enter YES in capital letters if you have a backup.

Warning: Do not proceed unless you have a backup of your Deltek Vision, GovWin CM, or
Ajera CRM database.

The script checks if you have a FILESTREAM database (<database>FILES) and creates one if
you do not.

The script prompts you for a SQL login and password.
15. Enter a SQL login and password.

These credentials will be associated with the migrated DPS database and the report server
databases and granted the db_owner role.

This account can be a SQL Server or Windows login. If you use a Windows account, it must be
the 1IS Application Pool Identity. If it is not, you will receive a message and prompt to use the
Application Pool Identity.

If you use a Windows account, the script automatically selects the Windows Authentication
checkbox in WebLink for both DPS and report server database access.

The script:

a. Checks that the password entered is a secure password so that it will pass standard
Domain Group Policy password tests.

b. Checks for the existence of the report server databases. If the script does not find the
default Report Server database name, ReportServer, it prompts you for the name of the
report database server and the Report Server database name.

The script has all of the information that it needs to complete the setup and begins performing
setup steps.

16. When the setup steps are completed, your DPS administrator can log in to DPS.
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Setup Steps Performed by the Script

After you enter all of the information needed to run DeltekPS.ps1 -SetupAndMigrate, the script
completes the following steps:

1. The script downloads and extracts the PHP.exe file, needed to set up the Deltek Touch
applications, and DeltekPS<Build#>.exe, the core DPS installation files. This process takes
several minutes.

2. The script sets up required IS components:
= Application Pool (DeltekPSAppPool)
= Applications:
= DeltekPS: Server side components
= DeltekPS/App: Web client
= DeltekPSClient: Smart client

3. The script converts your Deltek Vision, GovWin CM, or Ajera CRM database to Unicode (if
necessary) and migrates the database to DPS.

4. The script creates new SQL logins or associates existing logins with their respective databases.
This includes creating a local account on the database server if you are using a local account for
the Application Pool Identity.

5. The script creates a backup device named DeltekPS for use with the backup utility in the desktop
client.

6. The script updates databases.enc with values that were provided during the setup.
7. The script configures IIS for PHP (the Deltek Touch applications).

8. The scriptinstalls the Process Server service and sets the service account to the account
identified for the Application Pool Identity.

9. The script sets permissions for Reporting Services. This includes creating a local account if you
are using a local account for the Application Pool Identity.

10. The script loads reports to the report server, updates Outlook manifest files, and updates Deltek
Touch configuration files.

11. The script writes information about the DPS configuration to the DeltekPSSettings.xml file at the
root of the installation directory.

Warning: Do not delete this file. You will need it for future upgrades.

12. The script obtains your current DPS license information and applies the licenses to your newly
migrated database.

13. The script clears the PowerShell console memory of all values used in the setup process.

14. The script launches the DPSURL.htm file from the root of the installation directory. This file lists
URLSs for all of your DPS applications.
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Screenshots of Setup Steps

These screenshots show the complete output from a successful installation run using DeltekPS.ps1 -
SetupAndMigrate.
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onverting database to Unicode

onverting the database to unicode (Note: Depending on the size of the database, this could take awhile)
Processing Jobs. Please wait.
Job name [Job90]; State: Cnmpleted Processing Done in 5.35 minutes

igrating databasze

igrating the database schema (Note: Depending on the size of the database, this could take awhile)
Processing Jobs. Please wait...%
[Job92]; State: Cnmp]eted Processing Done in 3.63 minutes

Database migration completed (VisionDemo76 on VISC ILZ016EE) Ve

hecking if Local Account exists..

Local user account DeltekPS does not exist and will be created.

reating local account

(IS0PS5QLZ01L6EENDeltekPS was not a Togin on VisionDemo7é on VISOPSSQLZ016EE
IS0PSS0QL2016EENDeltekPS added to VisionDemo76e on VISOPSSQLZ016EE and db_owner Role
I50PS50L2016EE DeltekPS was not a Togin on ReportServer on VISOPSSOLZO016EE
'I50PS5QL2016EENDeltekPS added to ReportServer on VISOPSSQLZO016EE and db_owner Role
IS0PS5QLZ01L6EENDeltekPS was not a Togin on ReportServerTempDE on VISOPSSOLZO16EE
(IS0PS50QL2016EE,DeltekPS added to ReportServerTempDBE on VISOPSSQLZ016EE and db_owner Role
I50PS50L2016EE \DeltekPS was not a Togin on VisionDemo7&FILES on VISOPSSQLZO1G6EE
'I50PS5QL2016EENDeltekPS added to WisionDemo76FILES on VISOPSSOL2016EE and db_owner Role
Report Execution Timeout updated to 7200 in ReportSerwver

Updating databasze entries

Encrypting database entries

Database entries updated

onfiguring PHP on IIS
Process Serwver

Installing Process Server ; N
The Process Server service has been insta

Setting Process Server Identity to DeltekPs

TtekP5ProcessServerll stopped
vice account .%DeltekPS has been set

Report Serwver

hecking if Local Account exists.. )

Local user account DeltekPS already exists.

alling https://VIS0P550QL2016EE. dev. ads. deltek. com/ReportServer with username: DeltekPs
Connection to https://VISOPSSQL201GEE. dev. ads. deltek. com/ReportServer was successtul

Luad1ng Reports (this could take up to 10 minutes)
Reports Loaded Successfully

Restoring web. config settings from DeltekPSSettings.xml
Updating Outlook manifest file
reating Touch configuration files

Updating Deltek PS Settings file
Requesting Ticense information

Licenses have been updated in wour database

Setup Complete
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Post Installation Steps (DPS Setup or
SetupAndMigrate)

After you complete the installation process, verify the installation to confirm that all prerequisite software
is installed and all installation steps were completed.
To verify that your installation was successful:
1. Open Internet Explorer and enter the URL to the DPS application.

For example, http:\\sWeb Server>\DeltekPS.

Launch both the Web Client and SmartClient applications.

On the Logon form, enter your User ID. If you are unsure of your user ID, enter admin.

Enter your Password. If you are unsure of your password, leave this field blank.

If you do not have a user ID and password, and a user ID of admin and a blank password do not
work, contact Deltek Customer Care.

5. Use the drop-down list to select the Database (if you have only one database you will not see
database drop-down in the Web Client).

6. Click Login. If the DPS application opens, displaying the Welcome page, your installation is
successful.

Note: If there are any errors during the installation process when reloading reports, they will be listed
in the installation log. Resolve any errors and reload your reports manually through the application or
by using the LoadReport switch.

Back Up Your DPS Database

During installation of the database tier, the DPS backup device is created on the Database Server to
allow you to perform ad hoc database backups before major data changes or processes take place.

To back up the database, click Utilities » Backup Database on the DPS desktop application Navigation
menu.
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Configure DPS

Once the DPS software is installed, you can begin configuring DPS to meet your company’s needs.
Review the following documentation.

Online help https://help.deltek.com/Product/DeltekPS

Videos https://help.deltek.com/Product/DeltekPS/ST_Basics_Browser_Videos.ht
ml

Settings and https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFil

Configuration Guide e.ashx?documentid=06A24278-7FBD-4ED0-9392-E73CB4E92528

Release notes https://help.deltek.com/Product/DeltekPS/ReleaseNotes/
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Optional Switches

In addition to the switches that you must use to install DPS, you may want to use some optional switches
with the DeltekPS.ps1 PowerShell script.

You may use some switches when you first install DPS and others after DPS is up and running.
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SetupDatabaseNew Switch

Use the SetupDatabaseNew switch to create a new blank DPS database and an associated
FILESTREAM database after DPS is installed. The script adds the new database to the databases.enc
file.

Procedure

To run the script with the SetupDatabaseNew switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -SetupDatabaseNew.
2. Enter your Deltek Support username and password.
The script prompts you for the information needed to connect to your database server.
3. Identify your database server.

= Enter the name of your database server. If you are using a named SQL instance, identify the
server in the form Server\Instance.

= The script attempts, via Windows Management Instrumentation (WMI), to obtain the port on
which your SQL Server instance is listening and validate that a connection can be made. If
the script cannot determine the port, the connection attempt is made on TCP port 1433. If a
connection cannot be made there, the script prompts you to check that the server name is
correct and that the necessary ports are open in the firewall.

= If you are using dynamic ports, see the firewall information in this document.

If the connection is successful, the script prompts you for your database username.

4. Enter your database username. This should be either a SQL login or a Windows account. The
default is [WI] for Windows Integrated.

The account must be a member of the SQL server sysadmin fixed server role. The script checks
for this.

5. Enter the name for your new blank DPS database. The default is [DeltekPS].
If a database with that name already exists, the script prompts you to enter a new name.
The script prompts you for a SQL login and password.

6. Enter a SQL login and password.

These credentials will be associated with the DPS database and the report server databases and
granted the db_owner role.

This account can be a SQL Server or Windows login. If you use a Windows account, it must be
the 1IS Application Pool Identity. If it is not, you will receive a message and prompt to use the
Application Pool Identity.

If you use a Windows account, the script automatically selects the Windows Authentication
checkbox in WebLink for both DPS and report server database access.

The script performs the following steps:

= |f you are using a SQL login, the script checks that the password entered is a secure
password so that it will pass standard Domain Group Policy password tests.

= The script verifies that FILESTREAM is enabled and creates the new database schema.

Technical Installation Guide 50



Deltek gwumor

SetupDatabaseNew Switch

=  The script prompts you for the password for the Application Pool Identity account so that the
account can be granted rights to the new FILESTREAM database.

= The script checks for the existence of the report server databases. If the script does not find
the default Report Server database name, ReportServer, it prompts you for the name of the
report database server and the Report Server database name.

7. Enter the password for the Application Pool Identity account.

The script creates the necessary database associations and updates the databases.enc file with
the new database.

Setup Steps Performed by the Script

When you run DeltekPS.ps1 -SetupDatabaseNew, the script completes the following steps:
1. The script validates that a connection can be made to the database server.

2. The script validates that the database username is a member of the SQL server sysadmin fixed
server role.

The script prompts for the SQL Login and password to be associated with the DPS database.

The script checks that the SQL password entered is a secure password so that it will pass
standard Domain Group Policy password tests.

The script checks for the existence of the report server databases.
The script verifies that FILESTREAM is enabled and creates the new database schema.

7. The script prompts for the password of the Application Pool Identity so that it can be associated
with the FILESTREAM database.

8. The script creates the necessary database associations and updates the databases.enc file with
the new database.

9. The script obtains your current DPS license information and applies the licenses to your newly
created database.

10. The script clears the PowerShell console memory of all values used in the setup process.
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Screenshot of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 -
SetupDatabaseNew.
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MigrateDatabase Switch

Use the MigrateDatabase switch to migrate a Deltek Vision, GovWin CM, or Ajera CRM database for use
by DPS. Use this switch with a fully installed DPS system or use it with the DownloadAndExtract switch to
perform test migrations prior to installing the DPS software.

Note: The database must be from Deltek Vision, GovWin CM, or Ajera CRM 7.6 (CU 9) or a later
version.

Procedure

To run the script with the MigrateDatabase switch:

1.
2.

From the installation directory Scripts folder, enter .\DeltekPS.ps1 -MigrateDatabase.
Enter your Deltek Support username and password.
The script displays this message:

This switch will migrate an Ajera CRM/GovWin CM/Vision 7.6 database to Deltek PS 1.x
(including converting it to Unicode, if necessary). This switch will ONLY migrate the
database to DPS. You can add this database to Weblink by running the —
CreateDatabaseEntry switch.

The script prompts you for the information needed to connect to your database server.
Identify your database server.

= Enter the name of your database server. If you are using a named SQL instance, identify the
server in the form Server\instance.

= The script attempts, via Windows Management Instrumentation (WMI), to obtain the port on
which your SQL Server instance is listening and validate that a connection can be made. If
the script cannot determine the port, the connection attempt is made on TCP port 1433. If a
connection cannot be made there, the script prompts you to check that the server name is
correct and that the necessary ports are open in the firewall.

= If you are using dynamic ports, see the firewall information in this document.

If the connection is successful, the script prompts you for your database username.

Enter your database username. This should be either a SQL login or a Windows account. The
default is [WI] for Windows Integrated.

The account must be a member of the SQL server sysadmin fixed server role. The script checks
for this.

The script verifies that the SQL Server version is supported and that FILESTREAM is enabled,
and validates the server’s TLS configuration.

Then it prompts you for the name of the Deltek Vision, GovWin CM, or Ajera CRM database that
you will migrate to DPS.

Enter the name of the Deltek Vision, GovWin CM, or Ajera CRM database that you will migrate to
DPS.

The script then warns you about custom database objects (indexes, triggers, etc.) that may need
to be removed before proceeding with the migration.

Technical Installation Guide 53



Deltek gwumor

MigrateDatabase Switch

7. Enter YES to acknowledge the warning and proceed or No to exit the script.

The script prompts you to confirm that you have a backup of your database before continuing with
the migration.

Warning: Do not proceed unless you have a backup of your Deltek Vision, GovWin CM, or
Ajera CRM database. The database must be from version 7.6 (CU 9) or later.

8. Enter YES in capital letters if you have a backup.

The script checks if you have a FILESTREAM database (<database>FILES) and creates one if
you do not.

The script checks that the database has been converted to Unicode. If not, it will convert it as part
of the migration process.

Setup Steps Performed by the Script

When you run DeltekPS.ps1 -MigrateDatabase, the script completes the following steps:
1. The script validates that a connection can be made to the database server.

2. The script validates that the database username is a member of the SQL server sysadmin fixed
server role.

3. The script verifies that the SQL Server version is supported and that FILESTREAM is enabled,
and validates the server’s TLS configuration.

4. The script checks if you have a FILESTREAM database (<database>FILES) and creates one if
you do not.

5. The script prompts for the Deltek Vision, GovWin CM, or Ajera CRM database to be migrated and
checks to see if it has been converted to Unicode. If not, it will be converted.

6. If the Unicode conversion is successful, the database will be migrated to DPS.

7. The script obtains your current DPS license information and applies the licenses to your newly
migrated database.

8. The script clears the PowerShell console memory of all values used in the setup process.
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Screenshot of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 -
MigrateDatabase.
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CreateDatabaseEntry Switch

Use the CreateDatabaseEntry switch to add a migrated database to the databases.enc file.

The MigrateDatabase switch performs the database operations needed to convert the database to
Unicode (if necessary) and then migrate the database to DPS. It does not add the database entry to
databases.enc. The reason that the MigrateDatabase switch does not add the database to databases.enc
is that you can use the MigrateDatabase switch to perform a test migration before DPS is installed. (You
can use the DownloadAndExtract switch followed by the MigrateDatabase switch to perform a test
migration).

Procedure

To run the script with the CreateDatabaseEntry switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -CreateDatabaseEntry.
2. Enter your Deltek Support username and password.
The script displays this message:
This will add a database entry to Weblink.
The script prompts you for the information needed to connect to your database server.
3. Identify your database server.

= Enter the name of your database server. If you are using a named SQL instance, identify the
server in the form Server\Instance.

= The script attempts, via Windows Management Instrumentation (WMI), to obtain the port on
which your SQL Server instance is listening and validate that a connection can be made. If
the script cannot determine the port, the connection attempt is made on TCP port 1433. If a
connection cannot be made there, the script prompts you to check that the server name is
correct and that the necessary ports are open in the firewall.

= |f you are using dynamic ports, see the firewall information in this document.

If the connection is successful, the script prompts you for your database username.

4. Enter your database username. This should be either a SQL login or a Windows account. The
default is [WI] for Windows Integrated.

The account must be a member of the SQL server sysadmin fixed server role. The script checks
for this.

The script verifies that the SQL Server version is supported and that FILESTREAM is enabled,
and validates the server’s TLS configuration.

Then it prompts you for the name of the database to add to WebLink.
5. Enter the name of the database.

The script prompts you for a SQL login and password.
6. Enter a SQL login and password.

These credentials will be associated with the DPS database and the report server databases and
granted the db_owner role.
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This account can be a SQL Server or Windows login. If you use a Windows account, it must be
the 1IS Application Pool Identity. If it is not, you will receive a message and prompt to use the
Application Pool ldentity.

If you use a Windows account, the script automatically selects the Windows Authentication
checkbox in WebLink for both DPS and report server database access.

The script performs the following steps:

= If you are using a SQL login, the script checks that the password entered is a secure
password so that it will pass standard Domain Group Policy password tests.

= The script verifies that FILESTREAM is enabled and creates the new database schema.

=  The script prompts you for the password for the Application Pool Identity account so that the
account can be granted rights to the new FILESTREAM database.

=  The script checks for the existence of the report server databases. If the script does not find
the default Report Server database name, ReportServer, it prompts you for information
about the Report Server database server and database.

Setup Steps Performed by the Script

When you run DeltekPS.ps1 -CreateDatabaseEntry, the script completes the following steps:
1. The script validates that a connection can be made to the database server.

2. The script validates that the database username is a member of the SQL server sysadmin fixed
server role.

The script prompts for the SQL Login and password to be associated with the DPS database.

4. The script checks that the SQL password entered is a secure password so that it will pass
standard Domain Group Policy password tests.

5. The script checks for the existence of the report server databases.
The script verifies that FILESTREAM is enabled and creates the new database schema.

7. The script retrieves the Application Pool credentials and prompts for the password of the
Application Pool Identity so that it can be associated with the FILESTREAM database.

8. The script creates the necessary database associations and updates the databases.enc file with
the new database.

9. The script obtains your current DPS license information and applies the licenses to your newly
created database.

10. The script clears the PowerShell console memory of all values used in the setup process.
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Screenshot of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 -
CreateDatabaseEntry.
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SetupWebApp Switch

Use the SetupWebApp switch to install a secondary web/application server if you have a load balanced
configuration. You must have an existing installation of DPS to use this switch. Deltek recommends that
you use a shared path to databases.enc for this setup.

Attention: See Configure a Shared Location for Databases.enc for more information.

This process does not create or migrate databases or load reports.

Procedure

To run the script with the SetupWebApp switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -SetupWebApp.
A new browser window opens, containing Deltek’s licensing terms.

2. Read the licensing terms and, if you agree with them, return to the PowerShell console and select
Yes.

The script prompts you for the URL for your web server. It will display the fully qualified domain
name of the server, with the prefix HTTPS.

3. Either press ENTER to accept the displayed value or, if your web server SSL certificate is
registered to a custom DNS value, enter the fully qualified URL for the web server.

The script prompts you for the account to be used as the 1S Application Pool identity. The default
value is [DeltekPS]. This account will need read access to the shared databases.enc path, if you
are using one.

This account is used for the following service roles:
= Application Pool Identity
= Process Server service account

(Use the SetServiceAccount switch if you need to change these settings at a later time.)

4. Either accept the default value of [DeltekPS] or use an existing domain account.
The script prompts you for a password for this account.
5. Enter and confirm the password.

The script downloads and extracts the PHP.exe file, needed to set up the Deltek Touch
applications, and DeltekPS<Build#>.exe, the core DPS installation files. This process takes
several minutes.

The script asks you if you are using a shared path to databases.enc. See Configure a Shared
Location for Databases.enc for more information.

6. Enter Y or N.

= Y: The script prompts you for the shared path on your primary web/application server and
tests that the path is valid.

= N: The script tells you that you need to copy the databases.enc file from the primary
web/application server to the new web/application server after the setup process is
completed.
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Setup Steps Performed by the Script

After you enter all of the information needed to run DeltekPS.ps1 -SetupWebApp, the script completes
the following steps:

1. The script verifies that the SQL Server version is supported and FILESTREAM is enabled.
2. The script sets up required IS components:
= Application Pool (DeltekPSAppPool)
= Applications:
= DeltekPS: Server side components
= DeltekPS/App: Web client
= DeltekPSClient: Smart client
The script configures 1IS for PHP (the Deltek Touch applications).
4. If you are using a shared databases.enc path, the script enters the path in the web.config file.

The script installs the Process Server service and sets the service account to the account
identified for the Application Pool Identity.

6. The script writes information about the DPS configuration to the DeltekPSSettings.xml file at the
root of the installation directory.

Warning: Do not delete this file. You will need it for future upgrades.

7. The script clears the PowerShell console memory of all values used in the setup process.

8. The script launches the DPSURL.htm file from the root of the installation directory. This file lists
URLSs for all of your DPS applications.
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Screenshots of Setup Steps

These screenshots show the complete output from a successful installation run using DeltekPS.ps1 -
SetupWebApp.
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InstallDedicatedProcessServer Switch

Use the InstallDedicatedProcessServer switch to install a stand-alone dedicated process server. This
server has application server components but does not require 11S.

You must have an existing installation of DPS to use this switch. Deltek recommends that you use a
shared path to databases.enc for this setup. See Configure a Shared Location for Databases.enc for
more information.

This process will not create or migrate databases or load reports.

Procedure

To run the script with the InstallDedicatedProcessServer switch:

1.

4,

From the installation directory Scripts folder, enter .\DeltekPS.ps1 -
InstallDedicatedProcessServer.

The script checks for prerequisites.

The script prompts you for the account to be used as the Process Server service account. The
default value is a local account called [DeltekPS]. This account will need read access to the
shared databases.enc path, if you are using one.

(Use the SetServiceAccounts switch if you need to change these settings at a later time.)

Either accept the default value of [DeltekPS] or use an existing domain account.
The script prompts you for a password for this account.
Enter and confirm the password.

The script asks you if you are using a shared path to databases.enc. See Configure a Shared
Location for Databases.enc for more information.

Enter Y or N.

= Y: The script prompts you for the shared path on your primary web/application server and
tests that the path is valid.

= N: The script tells you that you need to copy the databases.enc file from the primary
web/application server to the new web/application server after the setup process is
completed.

Setup Steps Performed by the Script

After you enter all of the information needed to run DeltekPS.ps1 -InstallDedicatedProcessServer, the
script completes the following steps:

1.

o g A~ w D

The script prompts for the service account and password to be used, validates this account, and if
necessary adds the account to the local administrators group.

The script installs the Deltek PS build and configures the Process Server Windows service.

If you are using a shared databases.enc path, the script enters the path in the web.config file.
The script sets the Process Server service account to the account that you entered.

The script grants the necessary service rights to the service account.

The script starts the service.
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When the process server installation is completed, perform these steps:

1. (Optional) The process server is installed by default on all web/application servers. Consider
disabling or removing the process server from these servers. Use the RemoveProcessServer
switch if you want to remove the service.

However, you may want to keep the additional process servers so that you can have multiple
process servers sharing the processing load during times of heavy use.

2. Go to the Process Server settings in DPS and add the new process server. If appropriate, set up
process queues to use dedicated process servers. See the DPS online help for more information.

Screenshot of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 -
InstallDedicatedProcessServer.
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DownloadAndExtract, DownloadPreReq, and
DownloadDatabases Switches

Use the Download, DownloadAndExtract, DownloadPreReq, and DownloadDatabases switches to
perform downloads of the installation files, databases and prerequisite software.

You can use the Download and DownloadAndExtract switches to download files, and then use the
MigrateDatabase switch to run and test your database migration from DPS to Deltek Vision, GovWin CM,
or Ajera CRM. This will not prevent you from setting up DPS in the future. However, if you do this, you will
still need to run the script with the Setup or SetupAndMigrate switch at a later time.

Download Download installation files.

DownloadAndExtract Download installation files and extract them to the correct DPS
installation path. You must run the Setup or SetupAndMigrate switch
to use the extracted files for DPS. See the notes below.

DownloadPreReq Download all third party installation files that are prerequisites for
installing DPS. The files are downloaded to the DeltekPS\Support
folder.

Use this switch if the script alerts you that prerequisites are not
installed.

DownloadDatabases Download specialized databases (for example, language and demo)
for use with DPS. The switch will prompt you to restore these
databases.

Notes on DownloadAndExtract

= The MigrateDatabase switch is used primarily with the DownloadAndExtract switch to test
migrations from Ajera CRM, GovWin CM, or Vision 7.6 (CU 9 or later). Run the
DownloadAndExtract switch, and then run the MigrateDatabase switch. After you validate your
database migration, use the SetupAndMigrate switch on the same server to make your
installation production-ready and perform your go-live migration at the same time.

= Alternatively, you can use the Setup switch (which will, by default, install a blank DPS database)
to make the installation production-ready, and then use the MigrateDatabase switch to perform
your go-live migration.

Procedure
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -<Download Option>.
2. Enter your Deltek Support username and password.
A new browser window opens, containing Deltek’s licensing terms.

3. Read the licensing terms and, if you agree with them, return to the PowerShell console and select
Yes.

The download starts.
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Setup Steps Performed by the Script

After you enter the information needed to run DeltekPS.ps1 using one of the download switches, the
script downloads the files to the server where the script was run. Then it completes the following steps.

If You Use the Download Switch

The script downloads the self-extracting file DeltekPS<Build>.exe to the root of the DPS installation
directory.

If You Use the DownloadAndExtract Switch

The script downloads the self-extracting file DeltekPS<Build>.exe to the root of the DPS installation
directory and extracts the build files. You must run the Setup or SetupAndMigrate switch to use the
extracted files for DPS.

If You Use the DownloadPreReq Switch

The script downloads prerequisite files to the \Support\Prereq folder. The folder automatically opens. The
downloaded files include the DeltekPSPrerequisitelnstallation.txt file, which provides information about
the files.

If You Use the DownloadDatabases Switch

1. The script downloads the self-extracting file DeltekPS<Build>.exe to the \Databases folder and
extracts the contents. The downloaded files include the DeltekPSDatabasesVersion.txt file, which
shows the DPS version number of the databases.

2. The script asks you if you want to restore the AE or Consulting demo database
(DeltekPSDemoAE or DeltekPSDemoConsulting).

A message displays, indicating that the script will need to share the DeltekPS directory (Windows
share) and that the SQL Service account must be granted read access to the share. These steps
are necessary for the restore to happen over the network. The SQL Service account must be a
domain account.

3. If you enter No, the script ends. If you enter Yes to restore the AE or Consulting demo database,
these steps occur:

a. The script prompts you for the database serveninstance to which the database will be
restored.

b. The script prompts you for the SQL sysadmin account used to make the connection (the
default is WI).

c. The script prompts you for the demo database to restore (AE or Consulting). Enter AE or
Consulting at the prompt.

d. The script prompts you for a SQL login and password. Enter a SQL login and password.

These credentials will be associated with the DPS database and the report server
databases and will be granted the db_owner role.

The account can be a SQL Server or Windows login.

If you use a Windows account, it must be the 1IS Application Pool Identity. If it is not, you
will receive a message and prompt to use the Application Pool Identity.
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If you use a Windows account, the script automatically selects the Windows
Authentication checkbox in WebLink for both DPS and report server database access.

e. The script prompts you for the password for the Application Pool Identity (for Filestream
database access).

f.  The script prompts you for the password for the SQL Service account.

g. The script restores the DeltekPSDemoAE or DeltekPSDemoConsulting database and
creates the corresponding Filestream database.

h. The script assigns the necessary rights to the SQL login account entered and adds a
database entry to databases.enc.

Screenshots of Setup Steps
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Upgrade Switch

Use the Upgrade switch to apply software updates to your DPS installation.
Deltek recommends that you upgrade to the latest version of DPS because:
= New features are added only to the latest version.
= Except in critical situations, Deltek fixes software issues only in the latest version.
= Deltek support is typically available only for the latest and the next previous versions.
= The latest version incorporates the newest technologies and tools.

Before upgrading, you should review the DPS Release Notes and perform a test conversion and test
installation of the new version to ensure that your firm’s business processes are working properly in the
new version.

Deltek’s Global Services team is available to support you as you plan for this upgrade. We offer both
technical and custom services to ensure the best possible Deltek experience. Contact
DeltekforPSConsulting@deltek.com.

Important: When you initially run the Setup or SetupAndMigrate switch to set up your DPS
environment, the setup prompts you for a variety of information about your servers and validates that
information. Once validated, the information is written to the DeltekPSSettings.xml file at the root of
the DPS installation directory. The Upgrade switch attempts to retrieve the server information so that
you are not prompted for the same information again. If the information in the settings file is not
accurate, you must edit that file prior to running the Upgrade switch.

Procedure

To run the script with the Upgrade switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -upgrade.
The script prompts you for your Deltek Support username and password.
2. Enter your Deltek Support username and password.
A new browser window opens, containing Deltek’s licensing terms.

3. Read the licensing terms and, if you agree with them, return to the PowerShell console and select
Yes.

The script attempts to retrieve the report server hostname provided on the initial setup by reading
the values in the DeltekPSSettings.xml file.

4. Enter the hostname of your report server (if the value was not automatically retrieved) and press
ENTER. This must be the machine name, not the FQDN or the IP address.

When you enter the hostname, the script uses it to build a URL to the report server, which is the
default value you will see in brackets. (Note that your actual FQDN will likely be different and
must be tied to the SSL certificate). The server URL must be SSL secured.

If the script cannot connect to the server, it prompts you to confirm this information:
= Report server name (the default is [HostName])
= Report server URL, in the format [https://FQDN/ReportServer]
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Upgrade Switch

If you are using a named instance for your Reporting Services installation (for example, if you are
performing a SQLExpress installation), your virtual directory is probably in the format:
ReportServer_<InstanceName>. Your report server databases is probably in the form
ReportServer$<instanceName>. The script checks for your report server database names and
prompts you if a connection cannot be made.

The script attempts to retrieve the report server URL provided on the initial setup by reading the
values in the DeltekPSSettings.xml file.

If the Report Server URL was not automatically retrieved, you will be prompted for it.

If the Report Server URL presented in brackets is correct, press ENTER. If not, change the value
to the correct URL for your Report Server and press ENTER.

The script connects to the report server and validates the server’'s TLS configuration.

The script attempts to retrieve the database server provided on the initial setup by reading the
values in the DeltekPSSettings.xml file. If it cannot retrieve the value, it prompts you for the
information needed to connect to your database server.

5. ldentify your database server.

= Enter the name of your database server (if the value was not automatically retrieved). If you
are using a named SQL instance, identify the server in the form Server\instance.

=  The script attempts, via Windows Management Instrumentation, to obtain the port that your
SQL Server instance is listening on and validate that a connection can be made. If a port
cannot be determined, the connection attempt is made on TCP port 1433. If a connection
cannot be made there, the script prompts you to check that the server name is correct and
that the necessary ports are open in the firewall.

= If you are using dynamic ports, see the firewall information in this document.

If the connection is successful, the script attempts to retrieve the database username provided on
the initial setup by reading the values in the DeltekPSSettings.xml file. If the value cannot be
retrieved, the script prompts you for your database username.

6. Enter your database username (if the value was not automatically retrieved). This should be
either a SQL login or a Windows account. The default is [WI] for Windows Integrated.

The account must be a member of the SQL server sysadmin fixed server role. The script checks
for this.

The script connects to the database server and validates the server’'s TLS configuration. It then
prompts you start the upgrade and asks whether you have database backups.

7. Enter Y if you have backups or N if you do not (if you enter N, the script exits). The default is [N].

The script will now perform the upgrade process.
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Setup Steps Performed by the Script

After you enter all of the information needed to run DeltekPS.ps1 using the Upgrade switch, the script
completes the following steps:

1.
2.
3.

© N o 0 &

The script stops the W3SVC (1IS) and Process Server services.

The script removes any older database upgrade scripts from the Databases\Scripts folder.
The script downloads and extracts the new DPS build.

The script updates the Touch configuration files.

The script updates all databases in databases.enc to the current build.

The script restarts the services stopped in Step 1 above.

The script reloads reports.

The script updates the Outlook Manifest file and reports on the outcome of the upgrade.
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Screenshots of Setup Steps
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UpgradeWebApp Switch

Use the UpgradeWebApp switch to upgrade a secondary web/application server to the current DPS build.
Deltek recommends that you upgrade to the latest version of DPS because:

= New features are added only to the latest version.

= Except in critical situations, Deltek fixes software issues only in the latest version.

= Deltek support is typically available only for the latest and the next previous versions.

= The latest version incorporates the newest technologies and tools.

Before upgrading, you should review the DPS Release Notes and perform a test conversion and test
installation of the new version to ensure that your firm’s business processes are working properly in the
new version.

Procedure

To run the script with the UpgradeWebApp switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -upgradewebapp.
The script prompts you for your Deltek Support username and password.
2. Enter your Deltek Support username and password.
A new browser window opens, containing Deltek’s licensing terms.

3. Read the licensing terms and, if you agree with them, return to the PowerShell console and select
Yes.

The script prompts you to start the upgrade and asks whether you have database backups.
4. Enter Y if you have backups or N if you do not (if you enter N, the script exits). The default is [N].

The script will now perform the upgrade process.

Setup Steps Performed by the Script

After you enter all of the information needed to run DeltekPS.ps1 using the UpgradeWebApp switch, the
script completes the following steps:

1. The script stops the W3SVC (IIS) and Process Server services
2. The script downloads and extracts the new DPS build.

3. The script updates the Touch configuration files.

4. The script restarts the services stopped in Step 1 above.

5

The script updates the Outlook Manifest file and reports on the outcome of the upgrade.
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Screenshots of Setup Steps
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UpgradeProcessServer Switch

Use the UpgradeProcessServer switch to upgrade a dedicated process server installation to the current
DPS version.

You do not need to run this switch if you have a process server installed as part of a web/application tier
installation. In this scenario, the Upgrade and UpgradeWebApp switches will also upgrade the process
server installation.

Before upgrading, review the DPS Release Notes and perform a test conversion and test installation of
the new version to ensure that your firm’s business processes are working properly using the new
version.

Procedure

To run the script with the UpgradeProcessServer switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -upgradeprocesserver.
The script prompts you for your Deltek Support username and password.
2. Enter your Deltek Support username and password.
A new browser window opens, containing Deltek’s licensing terms.

3. Read the licensing terms and, if you agree with them, return to the PowerShell console and select
Yes.

The script prompts you to start the upgrade and asks whether you have database backups.
4. Enter Y if you have backups or N if you do not (if you enter N, the script exits). The default is [N].

The script will now perform the upgrade process.

Setup Steps Performed by the Script

After you enter all of the information needed to run DeltekPS.ps1 using the UpgradeProcessServer
switch, the script completes the following steps:

1. The script stops the W3SVC (IIS) and Process Server services.
2. The script downloads and extracts the new DPS version.

3. The script restarts the services stopped in Step 1 above.
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UpgradeDatabases Switch

Use the UpgradeDatabases switch to upgrade all databases in Databases.enc to the current DPS build.
Deltek recommends that you upgrade to the latest version of DPS because:

= New features are added only to the latest version.

= Except in critical situations, Deltek fixes software issues only in the latest version.

= Deltek support is typically available only for the latest and the next previous versions.

= The latest version incorporates the newest technologies and tools.

Before upgrading, you should review the DPS Release Notes and perform a test conversion and test
installation of the new version to ensure that your firm’s business processes are working properly in the
new version.

Procedure

1. The script attempts to retrieve the database server provided on the initial setup by reading the
values in the DeltekPSSettings.xml file. If it cannot retrieve the value, it prompts you for the
information needed to connect to your database server.

2. ldentify your database server.

= Enter the name of your database server (if the value was not automatically retrieved). If you
are using a named SQL instance, identify the server in the form Server\instance.

=  The script attempts, via Windows Management Instrumentation, to obtain the port that your
SQL Server instance is listening on and validate that a connection can be made. If a port
cannot be determined, the connection attempt is made on TCP port 1433. If a connection
cannot be made there, the script prompts you to check that the server name is correct and
that the necessary ports are open in the firewall.

= If you are using dynamic ports, see the firewall information in this document.

If the connection is successful, the script attempts to retrieve the database username provided on
the initial setup by reading the values in the DeltekPSSettings.xml file. If the value cannot be
retrieved, the script prompts you for your database username.

3. Enter your database username (if the value was not automatically retrieved). This should be
either a SQL login or a Windows account. The default is [WI] for Windows Integrated.

The account must be a member of the SQL server sysadmin fixed server role. The script checks
for this.

The script connects to the database server and validates the server’s TLS configuration. Then it
prompts you start the upgrade.

4. Enter Y to start the upgrade of all databases in Databases.enc or N if you do not (if you enter N,
the script exits). The default is [N].

The script will now perform the database upgrade process.

Setup Steps Performed by the Script

The UpgradeDatabases switch loops through all databases in Databases.enc and runs the current build
upgrade script against each database in turn. The result of each database upgrade is displayed. The
database upgrade logs can be found in the Logs\<date_timestamp\JobsSQL\ folder.
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InstallProcessServer and RemoveProcessServer
Switches

Use these switches to install and uninstall the DPS Process Server service:

InstallProcessServer If you experience an error installing the service using the Setup or
SetupAndMigrate switch, use the InstallProcessServer switch to
install the service.

RemoveProcessServer If you experience an error uninstalling the service using the Uninstall
switch, use the RemoveProcessServer switch to uninstall the
service.

Procedure

To run the script with the InstallProcessServer or RemoveProcessServer switch:

1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -InstallProcessServer or
\DeltekPS.ps1 -RemoveProcessServer.

2. Respond to the prompt:

= If you are using the InstallProcessServer switch, enter the service account name and
password. The script validates the information that you enter and adds the user to the local
administrator group (if applicable). The script installs the service, sets the identity, and grants
the necessary service rights.

= If you are using the RemoveProcessServer switch, enter Yes to uninstall the service.

Screenshots of Setup Steps

These screenshots show the complete output from running DeltekPS.ps1 -InstallProcessServer and
DeltekPS.ps1 -RemoveProcessServer.

InstallProcessServer

ocal or domain (domain‘\username) account or a local account will be
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RemoveProcessServer
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SetServiceAccount Switch

By default, all DPS service accounts are configured using the account that you identify as the Application
Pool Identity account when you run the DeltekPS.ps1 script using the Setup or SetupAndMigrate
switches. These accounts include:

= |IS Application Pool Identity (DeltekPSAppPool)
=  Service account for the DPS Process Server service

= Account used for authentication to Reporting Services (the value entered in the Report Server
Windows Username field on the Report Server tab in WebLink)

Use the SetServiceAccount switch to change one or all of these service accounts to use a different
account. The new account should be a domain account.

Procedure

To run the script with the SetServiceAccount switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -SetServiceAccount.
The script checks for prerequisites.

The script prompts you for the information needed to use this switch, including the name of the
IIS Application Pool ([DeltekPSAppPool]) and the name of the database entry from
Databases.enc.

2. Enter this information.

The script displays the service accounts currently in use and asks you which account you want to
change:

1. Change Service Account for the IIS Application Pool Identity.
2. Change Service Account for the Deltek PS Process Server service.
3. Change Service Account for the Report Server user account.
4. Exit.
3. Select an option.

The script prompts you for the name and password for the account that you want to change and
performs these additional steps:

If you chose... This happens...

Change Service Account for the The script prompts you for database server connection

IIS Application Pool Identity information so that it can update the FILESTREAM
database rights for the new account and the identity of
the 1IS Application Pool.

Change Service Account for the The script updates the logon account for the DPS
Deltek PS Process Server service = Process Server service and grants Service Local
Security Policy rights to the logon account.
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If you chose... This happens...

Change Service Account for the The script grants System Administrator and Content

Report Server user account Manager rights to Reporting Services and updates the
database entry in databases.enc for the database that
you identified in Step 1.

The script updates the service account that you chose and prompts you to change another
service account.

4. Enter 4 (Exit) when you are finished updating the service accounts.

Screenshot of Setup Steps

This screenshot shows the complete output from running DeltekPS.ps1 —SetServiceAccount.
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LoadReports Switch

Use the LoadReports switch to load reports if you experienced an error loading reports using the Setup or
SetupAndMigrate switch.

Procedure

To run the script with the LoadReports switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -LoadReports.
The script checks for prerequisites.
The script prompts you for the service account name and password.

2. Enter the service account name and password. Use the account already configured as the Report
Server Windows Username in WebLink.

The script prompts you for the information needed to connect to the report server.
3. Enter the information needed to connect to the report server.

The script validates that the connection can be made, loads the reports, and displays the results
of the loading process.

Setup Steps Performed by the Script

=  The scripts prompts for the Application Pool/Process Server account which will typically have
rights to reporting services.

Note: If you have changed accounts, using the SetServiceAccounts switch or manually, enter
the account that has the System Administrator and Content Manager rights to your reporting
services instance.

=  The script validates the account information.

=  The script prompts you for information about your reporting services instance and validates that a
successful connection can be made using the account information provided in Step 1.

= The script loads reports on the report server. This process can take up to 10 minutes.
=  When the reports finish loading, the script displays the message: LoadReports Completed.
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Screenshot of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 -
LoadReports.
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Uninstall Switch

Use the Uninstall switch to remove DPS from your web/application server. This process removes the
following components:

= |IS Application Pool (DeltekPSAppPool)

= IS Applications (DeltekPS, DeltekPS\App, DeltekPSClient)

= Deltek PS Process Server service

= All files and directories in the installation directory except those in \Scripts and \Logs

It will also prompt you to delete the local account (DeltekPS) if one exists.

Note: The Uninstall switch will not remove local accounts created by the Setup or SetupAndMigrate
switches on the report or database servers. Nor will it remove databases, SQL Logins, or loaded
reports on the report server.

Procedure

To run the script with the Uninstall switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -Uninstall.
The script checks for prerequisites.
The script asks you if you want to continue with the uninstall process.

2. Enter Yes to start the uninstall process.

Setup Steps Performed by the Script

The script completes the following steps:
=  The script removes the DeltekPS, DeltekPS\App and DeltekPSClient IIS applications.
= The script removes the DeltekPSApplicationPool IIS application pool.
= The script removes the Deltek PS Process Server service.

= The script checks to see if the local DeltekPS account exists and, if it does, asks you if you want
to delete the account.

=  The script removes the installation files, except for the \Scripts and \Logs folders.
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Screenshot of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 -
Uninstall.
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EnablelISRequiredFeatures Switch

Use the EnableliISRequiredFeatures switch if the IIS prerequisite check indicates that you have not
enabled all required IS modules. This switch will use the Enable-WindowsOptionalFeature PowerShell
cmdlet to enable required IS modules that are currently disabled.

Procedure

To run the script with the EnablellSRequiredFeatures switch:
1. From the installation directory Scripts folder, enter .\DeltekPS.ps1 -EnableliISRequiredFeatures.

The script checks for prerequisites and checks to see if any required IIS modules are not
installed. It displays the names of any missing modules and prompts you to enable them.

2. Enter Yes to enable all required modules.

This process takes several minutes

Setup Steps Performed by the Script

The script completes the following steps:
=  The script checks each required IIS feature to see if it is enabled.

= The script provides a list of required features that are currently disabled and prompt you to enable
them.

= |f you enter Yes, the script enables the required features.

Screenshot of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 -
EnablellISRequiredFeatures.

hecking for required IIS features that are not enabled

he following IIS required features are not enabled:
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GetLicenseFile Switch

The GetLicenseFile switch generates the Deltek PS Module passwords for your database if they need to
be generated as a separate step. The script generates the license file as a .SQL script and places it in the
\Databases\Scripts folder with the name DeltekPSModulePasswords<ClientID>.sq|, in which <clientID> is
your Deltek customer ID number. You can run this .SQL script against your database using SQL Server
Management Studio.

The Setup, SetupAndMigrate, SetupDatabaseNew and MigrateDatabase switches also call this function
and automatically apply the created .SQL script against the database.

Procedure

From the installation directory Scripts folder, enter .\DeltekPS.ps1 -GetLicenseFile.

The script generates the license file.

Setup Steps Performed by the Script

The script generates the license file as a .SQL script and places it in the \Databases\Scripts folder with
the name DeltekPSModulePasswords<ClientID>.sql.

Screenshots of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 -
GetLicenseFile.

Starting GetLicenseFile

Please run this script (c:\program files‘\deltek‘deltekps'Databaszes"Scripts'DeltekPSModulePas

s C: wprogram filesh\deltek'deltekps'Scripts>
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UpdateLicense Switch

The UpdateLicense switch generates the DPS module passwords for your database when they need to
be generated as a separate step. This happens when licensing information changes, such as when you
add a module or add new licenses.

The script generates the license file as a .SQL script and places it in the \Databases\Scripts folder with
the name DeltekPSModulePasswords<ClientID>.sql, in which <clientID> is your Deltek customer ID
number. The script automatically runs the generated SQL script against all databases in the
databases.enc file. If needed, you can run this .SQL script against additional databases using SQL Server
Management Studio.

Procedure

From the installation directory Scripts folder, enter .\DeltekPS.ps1 -UpdateLicense.

The script generates the license file.

Setup Steps Performed by the Script

The script generates the license file as a .SQL script and places it in the \Databases\Scripts folder with
the name DeltekPSModulePasswords<ClientID>.sql.

The script automatically runs the generated SQL script against all databases in the databases.enc file.

Screenshots of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 -
UpdateLicense.
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EnableWindowsExplorerPowerShelllntegration
Switch

Use the EnableWindowsExplorerPowerShellintegration switch to enable the Open Windows PowerShell
Here as Administrator menu option in Windows Explorer. This option displays in the right-click menu.
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Procedure

From the installation directory Scripts folder, enter .\DeltekPS.ps1 -
EnableWindowsExplorerPowerShellintegration.

Setup Steps Performed by the Script

The script makes the necessary registry changes to allow the right-click Open Windows PowerShell
Here as Administrator menu option.

Screenshot of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 -
EnableWindowsExplorerPowerShellintegration.

alling DeltekPS5etup-EnableWindowsExplorerPowerShellIntegration

S C:yprogram files\deltek\deltekps'Scripts=
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CreateDeltekPSCMDFile Switch

Use this switch to create a Windows batch file (.cmd) that launches PowerShell using the RemoteSigned
PowerShell execution policy. Use this switch if your organization has a more restrictive execution policy,
such as Restricted, and you cannot change the policy.

The batch file will set the execution policy only for the batch file process, whereas using Set-
ExecutionPolicy from the PowerShell console prompt will, by default, set the policy for the machine. See
PowerShell Execution Policy for more information.

Procedure
From the installation directory Scripts folder, enter .\DeltekPS.ps1 —CreateDeltekPSCMDFile.

Setup Steps Performed by the Script

The script creates a batch file (DeltekPS.cmd) in the root of the Deltek PS installation directory
(<drive>:\Program Files\Deltek\DeltekPS) that you can use to launch the PowerShell console with the
execution policy set to RemoteSigned.
To pass the switch parameter to the batch file, follow the steps below:
1. Open the PowerShell console (or a Windows command prompt) using Run as Administrator.
2. Enter the following:
DeltekPSCmd -<switch parameter> (e.g. DeltekPSCMD —Setup)

Screenshot of Setup Steps

This screenshot shows the complete output from a successful installation run using DeltekPS.ps1 —
CreateDeltekPSCMDFile.
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SendLogsToDeltek Switch

Use this switch to compress and e-mail installation logs to Deltek. Run this switch anytime Deltek
requests log files for review.

Procedure

From the installation directory Scripts folder, enter .\DeltekPS.ps1 —SendLogsToDeltek.

Setup Steps Performed by the Script

This switch compresses and e-mails all logs in the \Logs folder.

Screenshots of Setup Steps

This screenshot shows the complete output from running DeltekPS.ps1 —SendLogsToDeltek.
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Cleanup Switch

Cleanup Switch

Use this switch to remove older database upgrade scripts from the Databases\Scripts folder. Run this
switch after upgrades to remove obsolete files.

Procedure

From the installation directory Scripts folder, enter .\DeltekPS.ps1 —Cleanup.

Setup Steps Performed by the Script

This switch removes the database upgrade scripts that are no longer applicable to the current installation.

Screenshots of Setup Steps

This screenshot shows the complete output from running DeltekPS.ps1 —Cleanup.

Cleaning up previous files not needed for upgrade

Removing older database scripts

Cleanup Completed
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Overview of Server Architecture

Overview of Server Architecture

Before you install DPS software, you should carefully consider the server architecture that best fits your
company’s needs. You can choose from several architecture models.

Logical Tiers

DPS uses a multi-tier architecture. Various components of the DPS application are distributed to logical
tiers for performance and scalability. The logical tiers are as follows:

Client This is the user interface layer for DPS. It presents input data to the
application/web server tier and displays the returned result in a format that you can
understand. The client tier is installed on a workstation.

DPS uses two technologies in the client tier:
The primary technology is a web-based interface (web client).

The secondary technology is a smart client that uses the ClickOnce deployment
technology for delivering Windows-based applications to the user. The smart client
application checks for new updates on the web/application server each time the
application is launched and automatically installs them into the local user’s profile
(%USERPROFILE%\Local Settings\Apps\2.0\... ).

The smart client technology will be phased out prior to the release of DPS 3.0.
Web/Application | This tier performs functional process logic for DPS. When a request is sent by the
Server client tier, this the web/application server tier processes that request (such as

retrieving stored data or performing a specific function) and then returns the result
to the client tier. This tier also uses IIS to host DPS applications.

Process Server | This tier lets the user schedule processes and profiles to run automatically in the
background. Examples of processes that can run on the process server are:
= All reports
= All scheduled alerts

= Large batch jobs (for example, billing, revenue generation)

Report Server This tier handles all reporting requests. It uses Microsoft SQL Server Reporting
Services.

Database This tier consists of SQL Server Database Server(s) where DPS data is stored and
retrieved.
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Installation/Deployment Models

You can choose one of three different models to deploy DPS. The model that you choose depends on
your organization’s size needs, cost considerations, security requirements, and fault tolerance.

Note: Regardless of the deployment model you choose, you install all components from the
web/application tier, except a dedicated process server.

Deployment

Model

One-Server
(Single Server)

Dual-Server
(Two-Tier)

Configuration 1

Description

Install DPS tiers (web, application,
process server, report components,
and database) on the same
machine.

Infrastructure security is not a
concern with this model because all
application use is internal to the
organization.

Install the database and report
components on a server machine
and the web/application and process
server components on a separate
server machine.

In this configuration, the DPS client
application needs a direct connection
to the report server to run and view
reports.

Infrastructure security is not a
concern with this model because all
application use is internal to the
organization.

Use this model if...

Your organization is small (fewer than
50 employees).

Deployment needs are simple. For
example, you are installing DPS on a
test machine.

All users are at a single location and
will access DPS in the office or over a
Virtual Private Network (VPN)
connection to the corporate network.

Users will not access the application
over the internet.

You have a small to medium sized
organization that may not have a
technical staff.

Your organization has one SQL
Server license.

All users are at a single location and
will access DPS in the office or over a
Virtual Private Network (VPN)
connection to the corporate network.

Users will not access the application
over the internet.

Because the database server and the
report server are on the same server
machine, this model is not suitable for
an environment in which users access
the application over the internet. To
address the security issue of having
the report/database server exposed to
the internet, consider using the IS
ARR Reverse Proxy for the web
server to act as a proxy for handling
requests to the report server. See
Create a Reverse Proxy for SQL
Reporting Using Application Request
Routing for details.
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Deployment

Model

Dual-Server
(Two-Tier)

Configuration 2

Three or More
Servers

Description

Install the database component on a
server machine and the
web/application, process server, and
report components on a separate
server machine.

Split the report server (web service)
from the database server hosting the
report server database.

Install reporting services on a server
separate from the database engine.
Install any of the following:

= A single database server

= One or more report servers

= One or more web/application
servers

= One or More process Servers,
each on its own machine

Use this model if...

You have a small to medium sized
organization that may not have a
technical staff.

Your organization has more than one
Microsoft SQL Server license.

Users will access DPS over the
internet.

You have a large organization that
has multiple locations, can afford
multiple SQL Server licenses, and will
use DPS on an internal Wide Area
Network (WAN).

You need additional report,
web/application, or process servers
for load balancing, performance,
security, or fault tolerance reasons.

You have complex deployment and
firewall requirements.

Technical Installation Guide

96

Know more.
Do more.*



Overview of Server Architecture

Delte

Know more.
Do more.*

Logical Tier Model

This diagram shows the logical tiers and technologies used at each tier of a DPS deployment. You do not
necessarily need a separate physical server for each logical tier. If you use a single-server deployment

model, you install and configure each tier on a single server.

Logical Tier Model (Core Application Tiers only)

This diagram contains the logical tiers and port mo
technologies utilized at each tier of a DPS Re Tier [1 ar m]

deployment. Logical tiers do not necessarily require
a separate physical server for each tier.

requirement that the
WinForms Report Viewer
control has for direct

communication to the report

o
b
Q
=
-:. uIv
Client Tier \ l )
- / T,
——
DPS WinForms client L
:\El)lzrosoft R(—T.‘pOI’t.Ing services Windom Viewer '\%
ployed via ClickOnce)
Web / Application Tier Process Server Tier
{1 or more) (1 or more)

This connection shows the Ea Database Tier
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Logical Tier Model with Reverse Proxy

This diagram shows how the 1IS ARR Reverse Proxy has been implemented on a web server to serve as
a proxy for handling requests to the report server. This configuration addresses the security issue of
having the report/database server exposed to the internet.

This diagram shows the logical tiers and technologies used at each tier of a DPS deployment. You do not
necessarily need a separate physical server for each logical tier.

Report Tier (1 or more)

N

Database Tier

. .

- Y

.
>

Client Tier Web / Application Tier

(1 or more)

Process Server Tier
. (1 or more)

)

=1 \
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Logical Tier Model with Three or More Servers

This diagram shows a DPS deployment that uses three or more servers.

Note: To load balance web servers, you must use the sticky session feature (also known as session
affinity).

Internet Clients

External Firewall

ST 44 *
Load Balancing . ~ ~
Switch ‘:."" :’;: T ? i
HTTP: 80 ADO NET
M = S0AP = 1433
HETE: 80 Wehb Server 1 Web Server 2 Web Server 3 Web Server N
Internal Intemal | Internal
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= Report Server N
SQL Reporting Services /j l/\l

Load Balancing ~
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° o °
M V =
Report Server 1 Repeort Server 2 Repor{Server 3 ADO .NET
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Internal Clients ﬂ Report Server Database Server
= = ADO NET, B
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Server Setup Checklists

Follow the appropriate checklist to configure your DPS servers, depending on your installation model:
= Single Server
= Dual-Server (Two Tier) Configuration 1
= Dual-Server (Two Tier) Configuration 2

=  Three or More Servers

Single-Server

1. Verify that the server operating system is =  System Requirements
supported.

2. Verify that you have at least 2 GB of disk space
available for this installation.

3. Verify that the user account performing the
installation is a member of the local Windows
System Administrators group.

4. Verify that your SQL Server Database Engine and = « Database Requirements
Reporting Services installations meet the system
requirements.

5. Verify that the user account performing the
installation is a member of the sysadmin role in
SQL Server security settings, or make sure that
you have valid SQL Server credentials available
for use during the installation.

6. Use SQL Server Configuration manager to ensure = Epable or Disable a Server Network
that the TCP/IP and Shared Memory protocols are Protocol (SOL Server Configuration
enabled. Manager)

7. Install Microsoft .NET Framework. = _NET Architecture

8. Install Microsoft Internet Information Services (I1S) =  Microsoft Internet Information Server
with ASP .NET enabled. (11S) Installation on Windows Server

9. Configure Reporting Services with native mode. =  Microsoft SOL Server Reporting

Services
If Reporting Services is already configured, you = How to Connect to the Report Service
will need to know the Web Service URL and the Web Service

name of the Report Server databases.

10. Verify that the user account has the proper rights = How to Give Your Account Proper
and privileges in Reporting Services. Rights and Privileges in Reporting
Services Web Services
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Server Setup Checklists

11. If you experience connection errors to SQL =  Configure a Firewall for Report Server
Reporting Services and have verified the previous Access

steps, check that access is not being blocked by
Windows or your firewall.

=  Configure a Windows Firewall for
Database Engine Access

12. Review the Web Server Post-Installation checkilist.

Dual-Server (Two-Tier) Configuration 1

Database and Report Tier

1. Verify that the server operating system is =  System Requirements
supported.
2. Verify that you have at least 2 GB of disk space

available for this installation.

3. Verify that the user account performing the
installation is a member of the local Windows
System Administrators group.

4, Verify that your SQL Server Database Engine and System Reguirements
Reporting Services installations meet the system
requirements.

5. Verify that the user account performing the
installation is a member of the sysadmin role in
SQL Server security settings, or make sure that
you have valid SQL Server credentials available
for use during the installation.

6. Use SQL Server Configuration manager to Enable or Disable a Server Network
ensure that the TCP/IP and Shared Memory Protocol (SOL Server Configuration
protocols are enabled on your report server and Manager)
database server.

7. Configure Reporting Services with native mode. Microsoft SOL Server Reporting

Services
If Reporting Services is already configured, you How to Connect to the Report Service
will need to know the Web Service URL and the Web Service
name of the Report Server databases.
8. Verify that the user account performing the How to Give Your Account Proper

installation has the proper rights and privileges in
Reporting Services.

Rights and Privileges in Reporting
Services Web Services
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9. If you experience connection errors to your =  Configure a Windows Firewall for
database or report server and have verified the Database Engine Access
previous steps, check that access is not being
blocked by Windows or your firewall.

Web Application and Process Server Tier

1. Verify that the server operating system is =  System Requirements
supported.

2. Verify that you have at least 2 GB of disk space
available for this installation.

3. Install Microsoft .NET Framework. = _NET Architecture
4, Install Microsoft Internet Information Services (IIS) =  Microsoft Internet Information Server
with ASP .NET enabled. (11S) Installation on Windows Server
5. Verify that the user account performing the
installation has the proper account credentials as
stated in the database and report tier steps.
6. Ensure that you have the following information = Database Requirements

prior to starting your installation:
= Database Serven\SQL instance name
= Report Server database names
= Report Server Web Service URL

7. Review the Web Server Post-Installation checklist.

Dual-Server (Two-Tier) Configuration 2

Database Tier

1. Verify that the server operating system is =  System Requirements
supported.

2. Verify that you have at least 2 GB of disk space
available for this installation.

3. Verify that the user account performing the
installation is a member of the local Windows
System Administrators group.
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4,

Verify that your SQL Server Database Engine and
Reporting Services installations meet the system
requirements.

Verify that the user account performing the
installation is a member of the sysadmin role in
SQL Server security settings, or make sure that
you have valid SQL Server credentials available
for use during the installation.

Use SQL Server Configuration manager to ensure
that the TCP/IP and Shared Memory protocols are
enabled on your report server and database
server.

If you experience connection errors to your
database and have verified the previous steps,
check that access is not being blocked by
Windows or your firewall.

Web Application and Report Tier

1.

Verify that the server operating system is
supported.

Verify that you have at least 2 GB of disk space
available for this installation.

Install Microsoft .NET Framework.

Install Microsoft Internet Information Services (I1S)
with ASP .NET enabled.

Ensure that you have the SQL Server username
and password that you created for Reporting
Services.

Configure Reporting Services with native mode.

If Reporting Services is already configured, you
will need to know the Web Service URL and the
name of the Report Server databases.

Verify that the user account has the proper rights
and privileges in Reporting Services.

System Requirements

Enable or Disable a Server Network
Protocol (SOL Server Configuration

Manager)

Configure a Windows Firewall for
Database Engine Access

System Requirements

.NET Architecture

Microsoft Internet Information Server
(11S) Installation on Windows Server

Prerequisite Report Server and SOL
Server Database Credentials

Microsoft SOL Server Reporting
Services

How to Connect to the Report Service
Web Service

How to Give Your Account Proper
Rights and Privileges in Reporting
Services Web Services
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8.

10.

11.

12.

Verify that the user account performing the
installation is a member of the sysadmin role in
SQL Server security settings.

Verify that your SQL Server Reporting Services
installation meets the system requirements.

Use SQL Server Configuration manager to ensure
that the TCP/IP and Shared Memory protocols are
enabled on your report server and database
server.

If you experience connection errors to your
database or report server and have verified the
previous steps, check that access is not being
blocked by Windows or your firewall.

Review the Web Server Post-Installation checkilist.

Three or More Servers

Database Tier

1.

Verify that the server operating system is
supported.

Verify that you have at least 2 GB of disk space
available for this installation.

Verify that the user account performing the
installation is a member of the local Windows
System Administrators group.

Verify that your SQL Server Database Engine and
Reporting Services installations meet the system
requirements.

Verify that the user account performing the
installation is a member of the sysadmin role in
SQL Server security settings, or make sure that
you have valid SQL Server credentials available
for use during the installation.

Use SQL Server Configuration manager to
ensure that the TCP/IP and "Shared Memory"
protocols are enabled on your report server and
database server.

System Requirements

Enable or Disable a Server Network
Protocol (SOL Server Configuration

Manager)

Configure a Firewall for Report Server
Access

Configure a Windows Firewall for
Database Engine Access

System Requirements

System Requirements

Enable or Disable a Server Network
Protocol (SOL Server Configuration

Manager)
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7.

If you experience connection errors to your
database and have verified the previous steps,
check that access is not being blocked by
Windows or your firewall.

Report Tier

1.

Verify that the server operating system is
supported.

Verify that you have at least 2 GB of disk space
available for this installation.

Verify that the user account performing the
installation is a member of the local Windows
System Administrators group.

Verify that the user account has the proper rights
and privileges in Reporting Services.

Verify that the user account performing the
installation is a member of the sysadmin role in
SQL Server security settings.

Verify that your SQL Server Database Engine and
Reporting Services installations meet
requirements.

Use SQL Server Configuration manager to ensure
that the TCP/IP and Shared Memory protocols are
enabled on your report server and database
server.

Configure Reporting Services with native mode.

If Reporting Services is already configured, you
will need to know the Web Service URL and the
name of the Report Server databases.

If you experience connection errors to your report
server and have verified the previous steps, check
that access is not being blocked by Windows or
your firewall.

Configure a Windows Firewall for
Database Engine Access

System Requirements

How to Give Your Account Proper
Rights and Privileges in Reporting
Services Web Services

System Requirements

Enable or Disable a Server Network
Protocol (SOL Server Configuration

Manager)

Microsoft SOL Server Reporting
Services

How to Connect to the Report Service
Web Service

Configure a Firewall for Report Server
Access
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Server Setup Checklists

Web / Application Tier
1. Verify that the server operating system is = System Requirements
supported.
2. Verify that you have at least 2 GB of disk space
available for this installation.
3. Install Microsoft .NET Framework. = _NET Architecture
4. Install Microsoft Internet Information Services (IIS) ' =  Microsoft Internet Information Server
with ASP .NET enabled. (11S) Installation on Windows Server
5. Verify that the user account performing the
installation has the proper account credentials as
stated in the database and report tier steps.
6. Ensure that you have the following information = Database Regquirements
prior to starting your installation:
= Database Serven\SQL instance name
= Report Server database names
= Report Server Web Service URL
7. Note the DPS installation location on your web
server. You will need this information for the
Process Server tier.
8. Review the Web Server Post-Installation checklist.

Process Server Tier

1.

Verify that the server operating system is =  System Requirements
supported.

Verify that you have at least 2 GB of disk space
available for this installation.

Install Microsoft .NET Framework. = _NET Architecture

Verify the location (path) of the existing
databases.enc file on your web server. During
the installation, you will need to provide this
information.

The default location of this file is: C:\Program
Files\Deltek\DeltekPS\.

Review the Dedicated Process Server Post-
Installation checklist.
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Post-Installation Checklist (New Installations)

After you finish installing DPS for the first time, follow these steps.

If you have just finished installing an update, follow the steps in Post-Installation Checklist (Upgrades)
instead.

Web Server

1. Set the WebLink password on the web server. To launch WebLink, on the web server, use
http://localhost/deltekpsclient/weblink.application.

2. In WebLink, click the System Settings tab and review the Polling Interval and Max
Concurrent Jobs field settings to confirm that they meet your needs.

3. If you have a dedicated process server machine:

a. Onthe web server, navigate to Control Panel » Administrative Tools and disable
the Deltek PS Process Server service.

b. Launch DPS, add the name of the process server, and then assign queues to the
server that you inserted.

a. Click Configuration » System Settings.
On the Servers tab, add the name of your process server.
Assign the process queues to that process server.

4. = For new installations, perform the post-installation steps for new installations.

= For upgrade installations, perform the post-installation steps for upgrades.

Warning: Deltek recommends that the total of all of the process queues (per server) does not exceed
the number in the Max Concurrent Jobs field.

Set the process queue maximum in DPS (Configuration » General » System Settings » Servers tab »
Process Queues grid » Max field).

If the total of all of your process queues (per server) exceeds the number in the Max Concurrent Jobs
field, only the number of jobs as specified in the Max Concurrent Jobs field will run concurrently. If
you run too many concurrent jobs, you will add load to your database server and/or report server.

Dedicated Process Server

See Step 2 of the Web Server Post-installation Checklist above to add and configure dedicated
process servers in DPS.

Additional/Optional Modules

DPS is a prerequisite for certain additional or optional modules. Install these modules before deploying
DPS to end users.
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Client Tier (Workstation)

1. Supply DPS users with the DPS URL.: http://servername/DeltekPSclient).

Replace servername in the URL with your server name.

2. When you launch DPS, the credentials for new and sample databases are:
= Username: ADMIN

= Password: <no password>
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Post-Installation Checklist (Upgrades)

After you finish installing an update to DPS, follow these steps.

If you have just finished installing DPS for the first time, follow the steps in Post-Installation Checklist

(New Installations) instead.

Web Server

1.

2
3.
4

© © N

10.

11.

Verify that the databases.enc file was copied over from the previous installation.
Verify that the web.config file was copied over from the previous installation.
Verify that unused values are commented out in the web.config file.

Verify that the DeltekPSAppPool (or custom application pool) has the following settings:
= _.NET CLR Version: v4.0.
= Enable 32-bit Applications: False

Verify the physical paths for the DeltekPS and DeltekPS\App and DeltekPSClient virtual
directories.

Verify that you can view VisionServices (http:/localhost/DeltekPS/VisionServices.asmx).
Verify that you can launch and run WebLink.
Verify that you can launch and run DeltekPS.

If you have a dedicated Process Server machine:

Perform these steps only if you previously applied any custom web.config settings to customize

Process Server behavior.
a. Launch DeltekPS.
b. Verify that the custom web.config settings were applied during the installation.

For example, perform these steps if you have custom settings for the number of emails

being sent at a time (EmailChunkSize) or the maximum size of an email (MaxEmailSize):

a. Click Configuration » System Settings » Email Tab.
b. Verify or update the Email Size Limit (Megabytes) setting.
c. Verify or update the Number of Emails to Send at Once setting.

Verify that the Process Server Windows Service is running.

If you performed an in-place upgrade and entered bypass when prompted for the process

server service identity password, you must update the identity with the correct password or the

service will not start.
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Post-Installation Checklist (Upgrades)

Dedicated Process Server

See Steps 9, 10, and 11 of the Web Server Post-installation Checklist (Upgrades) to add and configure
dedicated process servers in DPS.
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System Requirements

Some parts of the DPS application are distributed to logical tiers for performance, scalability, and security
purposes. These logical tiers are distinct technologies required to run DPS, such as report server
software or web server software. They may or may not be hosted on the same machine. The method that
you use to distribute the DPS logical tiers across physical tiers or actual machines depends on your
organization’s needs.

Note: The software requirements for each logical tier are listed in the Deltek Support Compatibility
Matrix.

Supported Versions and Compatible Versions

Supported versions are the most current, actively tested technologies used to deploy DPS.

Compatible versions are recent technologies that have been tested and used for deploying DPS in the
past, but are not currently being tested. Deltek believes that they are still compatible with DPS.

NET Architecture

The DPS server-side architecture uses the Microsoft .NET Framework, a set of software technologies
developed to connect information, people, systems, and devices.

.NET allows Deltek developers and your in-house IT staff to extend the DPS workflow capabilities by
calling outside web services from within DPS. For example, you may send real-time, updated project
information from DPS to an external collaboration web site so that your clients can view current project
information.

.NET makes it possible for you to develop applications that integrate with DPS, call web services from
within DPS, and communicate with DPS through mobile devices.

DPS requires Microsoft .NET Framework 4.6.2.

Platform Virtualization

Virtual environment software, such as VMware®, resides in the hardware layer underneath the operating
system and is used to partition a single server into a multiple server/multiple operating system
environment. Deltek’s product development makes limited use of virtual environments.

Note: See the Virtual Environments Statement document on the Deltek Customer Care Connect site
(http://support.deltek.com) for more information.
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Database Requirements

Database Requirements

You must have a Microsoft SQL Server database engine to run DPS. The Microsoft SQL Server edition
that you choose to deploy with DPS depends on a number of factors, such as the size of your database
and the number of employees actively using the application, which can impact database server
performance.

=  For firms with fewer than 50 employees, DPS supports Microsoft SQL Server Express Edition
with Advanced Services, which has a database size limitation of 10 GB, 1 GB maximum utilized
RAM, and is limited to the lesser of 1 CPU socket or four cores.

See this Microsoft article to learn about other limitations of this edition:
https://msdn.microsoft.com/en-us/library/cc645993(v=sqgl.120).aspx

= For firms with more than 50 employees, DPS supports Microsoft SQL Server Standard and
Enterprise Edition.

The machine on which you install Microsoft SQL Server depends on your firm’s deployment model.

SQL Server

SQL Server Standard, Business Intelligence (BI), or Enterprise Edition

= If you decide to split the report server (web service) from the database server hosting the report
server database, you need an additional Microsoft SQL Server license.

= Report server scale-out deployment is only available in Microsoft SQL Server Business
Intelligence or Enterprise Edition. A scale-out deployment is an installation configuration that has
multiple report server instances sharing a single report server database.

= The following Microsoft link lists the features supported by the different editions of Microsoft SQL
Server. Click Other Versions and select the version that you are using:

https://msdn.microsoft.com/en-us/library/cc645993(v=sqgl.120).aspx

SQL Server Express Edition with Advanced Services

Owners of SQL Server Express Edition with Advanced Services (SQL Server Express) should note the
following:

= The report server database must be hosted on the local machine running the SQL Server
database engine instance. You cannot use a remote SQL Server instance to host the report
server database.

=  Any data sources that you use for reporting must be SQL Server databases that run on the same
local machine that runs the SQL Server database engine instance. You cannot use remote data
sources or other data source types. To use additional data source types, you must use a different
edition of Reporting Services. This means that your DPS database must reside on the same
machine as your report server databases.

= Use the Single Server Deployment Model or Configuration 1 of the Two Server Deployment
Model.
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SQL Server Express Edition Requirement

If you are implementing SQL Server Express Edition, Deltek requires that you use SQL Server Express
Edition with Advanced Services as the database and report server for your DPS implementation. It
contains the database engine and reporting services required to manage the database and run reports.

The other SQL Express Edition installers do not have all the components needed to support DPS.

Communication between DPS and the SQL Server Database

See the notes below about how to set up DPS to communicate with the SQL Server database.

= The DPS installer creates a Microsoft SQL Server logon account for the DPS database. The
account requires the db_owner database role membership in the Login Properties and User
Mapping dialog box for the following databases:

= DPS database

= ReportServer and ReportServerTempDB databases

Attention: For more information and guidance on configuring rights, see How to Give Your
Account Proper Rights and Privileges in Reporting Services Web Services.

= Use SQL Server Configuration Manager to enable the TCP/IP and Shared Memory network
protocols on the Microsoft SQL Server to allow DPS to connect to the database. All network
protocols are installed by SQL Server Setup, but may or may not be enabled.

Attention: For details, see the article Enable or Disable a Server Network Protocol (SOL
Server Configuration Manager).

= Verify the name of your SQL Server Instance. The default DPS installation uses the server name
for the connection and installs as an instance named SSQLSERVER. Sometimes SQL Server is
installed using an instance name other than the default (MSSQLSERVER). The SQL Server
Express Edition installer from Microsoft installs as the named instance SQLEXPRESS.

Note:

= When you connect to the default SQL Server database engine instance, you use the
name of your database server. When accepting connections, SQL Server
automatically maps the default instance of the database engine to the server name.

= When connecting to a named instance of the SQL Server database engine, you must
specify the name of the SQL Server plus the instance in the connection in the format
SERVERNAME\INSTANCENAME.

For example, if your SQL Server is named SQLSERVER1 and you installed to an
instance named SQLExpress, you specify the server connection in the format
SQLSERVERI\SQLExpress.

= If you do not know the name of your SQL Server instance or you are unable to connect to your
database server after installation, see the article Determine Whether the Database Engine Is
Installed and Started.
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DPS supports both SQL Server authentication modes: Windows Authentication Only or SQL
Server and Windows Authentication (also known as Mixed Mode).

Mixed Mode is required for new installations. If you are unable to connect to your SQL database
server and you have already performed the steps in the first two bullets of this list, you should
verify that the SQL Server security settings are properly configured.

Attention: For details, see the article Change Server Authentication Mode.

If you experience connection errors to your database or report server and have verified the
previous steps, verify that Windows (or your) firewall is not blocking access to the SQL Server
database engine and reporting services.

Attention: See the following Microsoft article for detailed steps:

= Configure a Firewall for Report Server Access

= Configure a Windows Firewall for Database Engine Access

Multiple Languages

You can install a blank DPS database in a selected language on your database server. The database that
you select determines the language that displays in the DPS application user interface. If you are
installing DPS for the first time, the installation routine includes a step in which you select the language
database version that you want to use for the installation.

You can select from these languages:

DPS 1.x:

= English (United States or International)
DPS 2.0, scheduled for release in late 2018:
= France (Canada or France)

=  Spanish

=  Dutch (Netherlands)

= Portuguese (Brazil)

= (German

Database Maintenance Activities

Deltek recommends completing the following activities on your database daily:

1.

2
3.
4

Check database integrity.
Rebuild indexes (doing this daily is not required, but it should be done at regular intervals).
Update statistics.

Make a complete backup.

The Microsoft-hosted Open Source Project site www.codeplex.com provides a project/tool for SQL
Express users that you can use to create maintenance plans. It is called ExpressMaint
(http://expressmaint.codeplex.com/).
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This project maintains two utilities for automating the backup and maintenance of databases for prior and
current SQL Server Express Edition releases. They are based on the sgimaint application that shipped
with SQL Server 2000, but were updated to support current released versions.

Microsoft provides basic documentation for manually creating a Windows scheduled task to work with
SQL stored procedures for automating daily backups. See the following article:

How to Schedule and Automate Backups of SOL Server Databases in SOL Server Express.

Several SQL Server resource websites and the SQLPass community. See this resource, which provides
details on automating database maintenance steps using SQL Express. See the following article:

SOL Server Backup, Integrity Check, and Index and Statistics Maintenance.
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Microsoft SQL Server Edition and Version
Information

Use these links to learn about recommended SQL Server service packs and cumulative updates.

Microsoft SQL Server 2016 Service Pack 1 (SP1)

=  Microsoft SQL Server 2016 SP1 Update. This package contains the Microsoft SQL Server 2016
Service Pack 1 update to be applied to existing SQL Server 2016 installations:

https://www.microsoft.com/en-us/download/details.aspx?id=54276

Microsoft SQL Server 2017 Cumulative Update

= Cumulative update package 6 for SQL Server 2017 RTM:

http://catalog.update.microsoft.com/v7/site/Search.aspx?g=S0QL%20Server%202017%20RTM%2
O0Cumulative%20Update%20(CU)%206%20KB4101464%20

Microsoft SQL Server 2016 Cumulative Update

= Cumulative update package 6 for SQL Server 2016 SP1:

http://catalog.update.microsoft.com/v7/site/Search.aspx?g=S0QL%20Server%202016%20Service
%20Pack%201%20Cumulative%20Update%20(CU)%206%20KB4037354%20

Microsoft SQL Server 2016 Express Edition with Advanced
Services

= If you are using the free edition of SQL Server as your database and reporting services engine,
download and install Microsoft SQL Server 2016 with Advanced Services:

https://download.microsoft.com/download/9/0/7/907AD35F-9F9C-43A5-9789-
52470555DB90/ENU/SOLEXPRADV _x64 ENU.exe

= You must also download and install SQL Server Management Studio, which does not come as
part of SQL Express:

http://go.microsoft.com/fwlink/?Link|ID=840946

Microsoft SQL Server Reporting Tools

= Microsoft SQL Server Report Builder for Microsoft SQL Server 2014. You can use the Report
Builder standalone version or the ClickOnce version of Report Builder installed with Reporting
Services:

https://www.microsoft.com/en-us/download/details.aspx?id=42301

= Microsoft SQL Server Data Tools - Business Intelligence for Visual Studio 2013. Installs Microsoft
SQL Server Data Tools Business Intelligence project templates for Analysis Services, Integration
Services, and Reporting Services that support Visual Studio 2013 and SQL Server 2014:

https://www.microsoft.com/en-us/download/details.aspx?id=42313

Technical Installation Guide 117


https://www.microsoft.com/en-us/download/details.aspx?id=54276
http://catalog.update.microsoft.com/v7/site/Search.aspx?q=SQL%20Server%202017%20RTM%20Cumulative%20Update%20(CU)%206%20KB4101464%20
http://catalog.update.microsoft.com/v7/site/Search.aspx?q=SQL%20Server%202017%20RTM%20Cumulative%20Update%20(CU)%206%20KB4101464%20
http://catalog.update.microsoft.com/v7/site/Search.aspx?q=SQL%20Server%202016%20Service%20Pack%201%20Cumulative%20Update%20(CU)%206%20KB4037354%20
http://catalog.update.microsoft.com/v7/site/Search.aspx?q=SQL%20Server%202016%20Service%20Pack%201%20Cumulative%20Update%20(CU)%206%20KB4037354%20
https://download.microsoft.com/download/9/0/7/907AD35F-9F9C-43A5-9789-52470555DB90/ENU/SQLEXPRADV_x64_ENU.exe
https://download.microsoft.com/download/9/0/7/907AD35F-9F9C-43A5-9789-52470555DB90/ENU/SQLEXPRADV_x64_ENU.exe
http://go.microsoft.com/fwlink/?LinkID=840946
https://www.microsoft.com/en-us/download/details.aspx?id=42301
https://www.microsoft.com/en-us/download/details.aspx?id=42313

Deltek gwmore

Microsoft Internet Information Server (11S) Installation on Windows Server

Microsoft Internet Information Server (IIS)
Installation on Windows Server

A prerequisite for installing DPS is that Microsoft Information Server (IIS) must be installed on the
web/application server. The setup script checks that all required IIS features are installed on the server. If
not, the script prompts you to install them.

Run the setup script with the EnablellISRequiredFeatures switch if the 1S prerequisite check indicates
that you have not enabled all required IS modules. This switch uses the Enable-
WindowsOptionalFeature PowerShell cmdlet to enable required 11S modules that are currently disabled.

Required IIS Features

The following features are prerequisites for DPS installation. Enable them on the Select Role Services
screen.

Common HTTP Features = Default Document
= Directory Browsing
= HTTP Errors
= Static Content
= HTTP Redirection

Health and Diagnostics = HTTP Logging
= Request Monitor (recommended)

= Tracing (recommended)
Performance =  Static Content Compression

Security =  Windows Authentication (only necessary if you will be using it)

= Request Filtering

Application Development = .NET Extensibility 4.5

= ASP.NET 4.5 (Add Roles and Features Wizard dialog box
displays when you select this option. Click Add Features
button.)

= CGI (Required if you will be using Deltek Touch products)
= |SAPI Extensions
= |SAPI Filters

Management Tools = |IS Management Console
= 1IS Management Scripts and Tools
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Microsoft SQL Server Reporting Services

DPS uses Microsoft SQL Server Reporting Services as its report management and delivery platform.
There are several things to consider when you migrate to DPS:

=  SQL Server Reporting Services is not installed as part of the DPS installation. SQL Server
Reporting Services must be installed and configured before DPS installation so that DPS can
connect to the report server.

= The DPS reporting RDL (report definition language) schema supports the latest versions of SQL
RS 2012 and 2014. DPS does not support SQL Server RS 2008 and 2005 Business Intelligence
Development Studio (BIDS).

Overview of SQL Server Reporting Services

Microsoft SQL Server Reporting Services is a server-based reporting platform that you can use to create
and manage reports that contain data from relational and multidimensional data sources. The reports that
you create can be viewed and managed over an Internet connection. Reporting Services includes the
following core components:

= A complete set of tools that you can use to create, manage, and view reports.

= A Report Server component that hosts and processes reports in a variety of formats. Output
formats include HTML, PDF, TIFF, Excel, CSV, and more.

= An API that allows developers to integrate or extend data and report processing in custom
applications, or create custom tools to build and manage reports.

The reports that you build can be based on relational or multidimensional data from SQL Server, Analysis
Services, Oracle, or any Microsoft .NET data provider such as ODBC or OLE DB. You can create tabular,
matrix, and free-form reports. You can also create ad hoc reports that use predefined models and data
sources.

Reporting Services uses URLSs to access the Report Server web service and Report Manager. Before you
can use either application, you must configure at least one URL each for the web service and Report
Manager. Reporting Services provides default values for both application URLs that work well in most
deployment scenarios, including side-by-side deployments with other web services and applications.

Reporting Services uses a SQL Server database for internal storage. The database is a required
component used to store reports, session data, resources, and server metadata.

The benefits of Reporting Services include:

= Ease of Deployment and Management: SSRS is embedded in the SQL Server that database
clients already use. This streamlines deployment and updates, and provides a platform for
delivery of new functionality for years to come.

= Industry Leading Platform: SSRS is fast becoming one of the leading Business Intelligence (BI)
platforms on the market.

= Better Technology Alignment with DPS: SSRS aligns with the Microsoft-centric technology
strategy for DPS.

Note: Scale-out configuration of SSRS is supported and provides a load balanced configuration for
scalability. This configuration requires the Enterprise Edition of SQL Server.
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More Information about Reporting Services

The best way to learn about Reporting Services is through the documentation included with your SQL
Server (Books Online, Microsoft Labs, and so on).

These articles describe how to configure the latest versions of Reporting Services:
= Getting Started (SQL Server 2012)

=  Configuring Reporting Services

These articles provide additional information about Reporting Services:
= Whatis SQL Server Reporting Services (SSRS)?

=  SQL Server Documentation

Report Server Licensing Requirements

The method that you use to deploy your Report Server depends on the edition and licenses you own for
your Microsoft SQL Server database. If you plan to host your Reporting Services web service on a
machine separate from the Reporting Services report server database, you must determine whether your
SQL Server edition and licenses can support this deployment.

The following Microsoft page describes the licensing options available with SQL Server and Reporting
Services:

https://www.microsoft.com/en-US/sal-server/sgl-server-2017?&0CID=AID631226 SEM 9gSDPzSr

Features Supported by Different SQL Server Editions

This table shows the features that come with the commonly used editions of Microsoft SQL Server
available on the market today and supported by DPS.

Express with

Feature Advanced Standard Enterprise
Services

Custom Reporting

Report Builder v v v
Report Models for Report Builder - v v
Report Designer (SSDT-BI) v v v

Standard Reporting

Access to All Standard Reports v v
Report History (Previously Run) - v v
Email Reports - v v
Email Report Links - 4 v
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Express with

Feature Advanced Standard Enterprise
Services

Schedule Reports - v v

Schedule and Report History - v v

Search and Download in Preview - 4 v

You can also refer to the Features Supported by the Editions of SOL Server 2014 article. Click Other
Versions at the top and select the version that you use.

Custom Reports and Custom Invoices

Supported Report Writing Tools

DPS supports the following Microsoft SQL Server Reporting Services report-writing tools for creating
custom reports and custom invoices:

= Report Builder 3.0

=  SQL Server Data Tools - Business Intelligence Report Writer for Visual Studio 2013 (referred to
as SSDT-BI 2013 Report Designer)

These report-writing tools produce a report file with the RDL 2010 schema that DPS requires.

Note: See the Deltek for Professional Services Custom Reports and Microsoft SQL Server Reporting
Services Guide for help downloading and installing the supported report-writing tools and creating custom
reports.

Upgrade Custom Reports and Custom Invoices

If you are upgrading from an earlier DPS version, see the Deltek for Professional Services Custom
Reports and Microsoft SOL Server Reporting Services Guide for upgrade instructions.

Summary of Upgrading Custom Reports and Invoices

DPS Custom Reports and

DPS Version Upgrading Microsoft SQL Server Reporting
From... Upgrade Action Required Services Guide

An earlier 7.x version Upgrade your reports to the RDL See Appendix A: Custom Reports
(your custom reports and/or 2010 schema. and Migrating from Vision to DPS
Y P On-Premise.

custom invoices have an
RDL 2005 or RDL 2008
schema)
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DPS Custom Reports and

DPS Version Upgrading Microsoft SQL Server Reporting
From... Upgrade Action Required Services Guide
A 6.x version Complete both of the following: See the following sections:
(Your custom reports and/or | = Upgrade your reports to the =  Appendix A: Custom Reports
custom invoices have an RDL 2010 schema. and Migrating from Vision to
RDL 2005 schema.) - DPS On-Premise
= Perform additional steps for
changes to some DPS =  “Vision 7.0 Database Table
database table names. Name Changes that Affect

Custom Reports” section in
Appendix A: Custom Reports
and Migrating from Vision to
DPS On-Premise.

Extra Space in Invoice Header

If you are using DPS with SQL Server Reporting Services, your invoices will print with extra space in the
header when the top margins are expanded. This is a known issue with SQL Server Reporting Services.

Deltek recommends that you carefully review your invoice templates, and wherever possible, reduce the
top margins in the DPS Invoice Template Editor to prevent the extra space issue from occurring.

Configure Microsoft SQL Server Reporting Services

Important Information about Configuring Reporting Services

= For more information about configuring Report Services, see Important Information about
Configuring Report Services and Reporting Services Configuration Manager (Native Mode).

= If you have configured the Report Server service account to be a domain account, Reporting
Services will use Kerberos Authentication by default. You must ensure that you have created an
SPN for the account. To configure an SPN, see the article Reqister a Service Principal Name
(SPN) for a Report Server.

=  For more information about Kerberos authentication, see the article Configure Windows
Authentication on the Report Server.

= Alternatively, you can configure the RSReportServer.config file with the following XML structure,
which specifies NTLM only. This configuration is for deployments that do not support Kerberos or
to work around Kerberos authentication errors (HTTP 401 errors) :

<AuthenticationTypes>
<RSWindowsNTLM/>
</AuthenticationTypes>
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Initial Setup Steps

Use these steps to configure your initial SQL Server Reporting Services setup. These steps are required
for DPS to verify that SQL Server Reporting Services exists. DPS will use the accounts specified on the
Report Server tab of WebLink to make connections to Reporting Services.

Note: Do not configure an Execution Account as part of Report Server configuration. If you do, the
Execution Account will be used instead of the credentials listed in WebLink. This may result in
reporting errors in DPS.

To configure your initial setup:

1. Click Start » All Programs » Microsoft SQL Server <Select Your Version> » Configuration
Tools » Reporting Services Configuration Manager to launch the Reporting Services
Configuration Wizard.

2. On the Reporting Services Configuration Connection dialog box, select your SQL Reporting
Services Instance Name, and then click Connect.

If you have multiple installations of Reporting Services, you may see more than one instance.
MSSQLServer is the default instance.

3. Onthe Report Server Status pane of the Reporting Services Configuration Manager dialog box,
click Start to start the Reporting Services instance. If it is already running, click Service Account
in the left pane.

4. On the Service Account pane of the Reporting Services Configuration Manager dialog box,
choose the appropriate account and click Apply. Microsoft recommends using the Network
Service account.

For additional information on choosing a service account, see Service Account - Reporting
Services Native Mode (Configuration Manager).

If you have configured the Report Server Service Account to be a domain account, Reporting
Services will use Kerberos Authentication by default.

5. The Service Account pane of the Reporting Services Configuration Manager dialog box displays
again, showing the results in the bottom pane. Click Web Service URL in the left pane.

6. Onthe Web Service URL pane, accept the default values.

The default value for Virtual Directory is ReportServer. If you installed Report Server as an
instance, the virtual directory is usually ReportServer and the instance name, separated by a
character, such as an underscore or dollar sign.

7. Take note of the Report Server web service URL shown in the Web Service URL dialog box, in
case DPS is unable to connect to the Report Server during the installation and prompts you for
the correct path.

8. Click Apply to accept your settings. If the settings are correct, the Results pane displays the
status.

9. Click Database in the left pane.

DPS uses the Report Server web service URL at the bottom of the dialog box as part of its test
connection URL when it tries to connect to the Report Server.

SQL Server Reporting Services does not require 1IS to be enabled.

10. In the Report Server Database pane, click Change Database.
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11. Onthe Change Database screen, choose whether to create a new Report Server database or
use an existing one. For a new installation, select Create a new report server database. Click
Next.

12. Enter the database Server Name and a user account that has privileges to create or select the
database and assign the required rights.

a. Click Test Connection to test your credentials. Make any needed corrections.

b. Click OK when you have connected successfully to the database. The Change Database
screen displays.

c. Click Next.
13. Accept the default values. Click Next.

Note: Only Native Mode is supported. Select Native Mode if it is not selected by default.

14. In the Credentials pane of the Change Database screen, specify the type of credentials and
accounts that Reporting Services will use to connect the database. Click Next.

15. Review the summary of the changes that you made. Click Next.
You can watch as the Report Server databases are created.
16. Click Finish when all steps are marked as successfully completed.

17. In the left pane of the Report Services Configuration Manager dialog box, click Report Manager
URL.

18. In the Report Manager URL pane, accept the default values. Click Apply.

19. Click Encryption Keys in the left pane and back up the encryption keys to a safe location. Click
Apply.
20. Click Exit. You are now ready to begin the DPS installation.

Connect to the Report Server Web Service

SQL Server Reporting Services provides access to the full functionality of the Report Server through the
Report Server web service, ReportingService2005.asmx, an XML web service with a SOAP API.

The web service uses SOAP over HTTP and acts as a communication interface between client programs
and the Report Server. It provides the interface for enumerating the reports and report folders and a host
of other capabilities for report execution, rendering, and management

The web service provides two endpoints: one for report execution and one for report management. The
DPS setup script connects to the report execution endpoint.

Specify the Report Server Host Name and URL

When you run the setup script, the setup attempts to connect to the Reporting Service web service
screen. If it cannot, it returns an error message and displays the Specify Report Server and Report Server
URL Information screen.

Complete one of the following actions:
= Verify that the information on the screen is correct. Click Enter.

= |f the information is incorrect, update the fields with the correct values:
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= Report Server: The Report Server name is the host name (machine name) of your Report
Server machine.

= Report Server URL: This is the URL used to connect to the Reporting Services web service
on the Report Server. It should be in the format:

https://<Report Server Fully Qualified Domain Name>/Virtual Directory/

For example: https://dpsreportserver.company.com/reportserver

The setup script automatically appends reportservice2005.asmx to the URL.
Elements in the Report Server URL
URL Element | Description

Fully Qualified Domain Name | The full DNS name of the server, which must match the assigned
SSL certificate.

Virtual Directory This is the name of the folder that contains the XML web service for
report execution. This folder is configured during setup or when you
run the Microsoft SQL Server Reporting Services Configuration tool.
The default name is reportserver.

If you are unsure of the name, follow the steps in Identify Virtual
Directory Name.
If you installed Reporting Services as an instance, the name of the

virtual directory may also include the instance name. For example,
reportserver_INSTANCENAME.

<endpointname>.asmx The setup script automatically appends reportservice2005.asmx to
the URL.

This is the name of the web service endpoint. The 2005 in the name
does not refer to any version of SQL Server.

Identify Virtual Directory Name

To identify the virtual directory name:

1. Click Start » All Programs » Microsoft SQL Server <Select Your Version> » Configuration
Tools » Reporting Services Configuration Manager.

Connect to the Report Server Web Service URL in the left pane.
3. Check the Virtual Directory field in the right pane.

Note: Make sure that the entry in the Virtual Directory field matches the virtual directory
listed on the Specify Report Server and Report Server URL screen.

If you have not configured SQL Reporting Services, click the Help icon in the lower left corner of the
Reporting Services Configuration Manager dialog box to access Microsoft documentation for configuring
Reporting Services.
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SQL Report Server Database Prompt During Setup

If the DPS setup script is unable to connect to the ReportServer database server or to identify the
Reporting Services databases, it will prompt you for the database server\instance hosting the report
server databases as well as the name of the Report Server database. You will be prompted to provide
sysadmin credentials to authenticate to the database server and prompted for the SQL login credentials
(SQL Server or Windows account) that will be granted db_owner rights to the ReportServer and
ReportServerTempDB databases.

Enter the following information:

= Report Database Server: Enter the name of the database server that contains the Report Server
databases. If the database server is using a specific instance name, enter the name in the format
Serveninstance.

= Accept the WI (Windows Integrated) option if you use Windows integrated security. If you do
not, enter the SQL login and password. If you do not use Windows integrated security, make sure
that your server is configured to support Mixed Mode Security.

= SQL Login: The default SYSADMIN account for SQL Server is sa.
= SQL Password: Enter the password associated with this SQL Login.

= ReportServer Database: Enter the name of your ReportServer database. Typically, the default
name for this database is ReportServer. If you have an instance, then the name is
ReportServer$instanceName. If you are unsure of the name, follow the steps in Identify
ReportServer Database Names.

= ReportServerTempDB Database: Enter the name of your ReportServerTempDB database.
Typically, the default name for this database is ReportServerTempDB. If you have an instance,
then it is ReportServer$instanceNameTempDB. If you are unsure of the name, follow the steps
in Identify ReportServer Database Names.

Note: If the SQL Login does not have db_owner membership of the Report Server and
ReportServerTempDB databases, setup grants these rights.

Identify ReportServer Database Names
To identify the ReportServer and ReportServer TempDB databases names, complete the following
steps on your Report Server:

1. Click Start » All Programs » Microsoft SQL Server <Select your Version> » Configuration
Tools » Reporting Services Configuration Manager.

2. On the Reporting Services Configuration Manager dialog box, click Database in the left pane,
and then click Change Database in the right pane.

3. Onthe Change Database screen, select the Choose an existing report server database
option. Click Next. The Change Database/Database Server screen displays.

4. If you are:

= Logged in as an Administrator, accept the default values to make a connection using
Integrated Authentication.

= Not logged in as an Administrator, select SQL Server Account from the Authentication
Type drop-down list. Enter the System Administrator (SA) credentials in the Username and
Password fields.
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5. Click Next.

6.

Use the Report Server Database drop-down list to see the names of the ReportServer and
ReportServerTempDB databases. Click Cancel.

Give Your Account Proper Rights and Privileges in Reporting
Services Web Services

Two types of credentials are required for the Report Server installation to complete successfully:

You must have a Windows account (local or domain) with proper rights and privileges to the
Report Server web services component. This account must have Content Manager and System
Administrator privileges in the Reporting Services Report Manager Tool. These privileges prevent
401 (unauthorized access) errors from occurring when the installation tests the connection to the
Reporting Services web service and when you test and run reports.

The Local Windows Administrator Group on the report server will appear to already have the
Content Manager and System Administrator roles in Reporting Services. However, the Windows
account must still be granted these rights explicitly so that the installation can connect to
Reporting Services and assign the proper privileges to the local DPS Windows account that the
installer creates.

You must have a Report Server SQL Server database login that is a member of the db_owner
role for the ReportServer and ReportSeverTempDB databases.

To configure/verify rights and privileges to the Report Server web services component:

1.

Log on locally to the report server desktop console with a Windows account that is a member of
the local administrator group.

Launch the Report Manager URL (http://localhost/reports):

You must be on the server and browse to the Report Manager URL using localhost as the server
name (http://localhost/reports) to see the Report Manager configuration options.

If you do not see the configuration options, launch Internet Explorer using the Run as
administrator option to run Internet Explorer with elevated privileges.

Click Folder Settings at the top of the SQL Server Reporting Services screen.
Click New Role Assignment.

In the Content Manager role, add the account that you will be logged into when you perform the
DPS setup.

The account appears in the listing with the Content Manager rights.

During setup, this account is used to connect to the report server and install DPS reports into
Reporting Services. (This is also the account listed in WebLink to run DPS reports).

If you do not enter a different account, the setup process creates an account named DeltekPS
that is assigned Content Manager and System Administrator rights to load and run DPS reports
on behalf of DPS users.

Click Site Settings » Security » New Role Assignment.

Enter your Windows account and select the System Administrator role.
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Prerequisite Report Server and SQL Server Database Credentials

During DPS setup, when the script is testing for proper rights to the report server, a SQL Server account
is required for connecting to the SQL Server database that hosts the report server databases used for
managing the report server and DPS reports. This account must be configured on the SQL Server that
hosts the report server. (Most installations have the SQL Server report server database on the same
machine as the report server web server component.)

To avoid errors during the report server installation, or when testing WebLink entries or running reports,
you must configure a report server SQL Server database login and give it membership to the db_owner
role on the SQL Server that hosts the ReportServer and ReportSeverTempDB databases and your DPS
database.

Note: The steps below should also be performed on your database.

To configure/verify rights and privileges to the Report Server database server component:
1. Launch Microsoft SQL Server Management Studio.

2. Click the plus sign before the server name to expand the server, and then expand the Security
folder.

Right-click the Logins folder and select New Login.

4. Select the Windows account, enter an existing SQL Server login, or create a new SQL Server
login and assign it a password. The example below creates an account named DeltekPS.

5. Click User Mapping to display the User Mapping screen.
Select the ReportServer database option in the Users mapped to this login section.
The Database role membership for the server becomes enabled in the bottom section.
7. Select the db_owner option to add the login to the db_owner role for the database.
Repeat the same steps for the ReportServerTempDB database.

9. Repeat the same steps to map the login to the DPS database and give it db_owner role
membership to the database.
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Configure Transaction Document Management

DPS Transaction Document Management (TDM) uses Microsoft SQL Server FILESTREAM technology to
store and retrieve documents in a SQL Server database. Deltek has chosen to configure FILESTREAM
functionality and to store these documents in a separate database rather than in your DPS transactional
database. These documents include transaction-related supporting documents as well as Adobe
InDesign templates.

FILESTREAM is a prerequisite to installing DPS and the various setup scripts will check to ensure that it
is correctly installed and configured. If it is not, then you will need to install and configure it before you can
install DPS. The setup scripts will also create the FILESTREAM database (<databaseName>FILES) for
you automatically with the Setup and SetupDatabaseNew switches and will check to ensure the
FILESTREAM database exists with SetupAndMigrate and MigrateDatabase and if it does not the setup
will automatically create it.

This section will help you configure FILESTREAM and DPS TDM.

Warning: Your separate DPS and FILESTREAM (TDM) databases must be backed up on the same
schedule so that they will be in sync if a restore is needed.

Prerequisites

Install or upgrade to the current version of DPS.

FILESTREAM Best Practices

Read the FILESTREAM Best Practices article before you start.

Some examples of FILESTREAM best practices are:

= Disable short file names on FILESTREAM computer systems because they take significantly
longer to create. To disable short file names, use the Windows fsutil utility.

= Regularly defragment FILESTREAM computer systems.
= Use 64-KB NTFS clusters. Compressed volumes must be set to 4-KB NTFS clusters.

= Disable indexing on FILESTREAM volumes and use the Windows fsutil utility to set
disablelastaccess.

= Disable antivirus scanning of FILESTREAM volumes, if possible. If antivirus scanning is
necessary, avoid setting policies that automatically delete offending files.

= Ensure that your nightly backup routine (and any other backup processes) back up the
FILESTREAM database at the same time as your DPS transaction database. Metadata for
uploaded files is stored in the DPS database, while the actual uploaded file data is stored in the
FILESTREAM database. If you restore one or both databases and the database backups are out
of sync, data issues may occur. See “Databases Out of Sync” Issue for more information.

Note: The DPS Backup Utility application, on the Utilities menu, automatically backs up both the DPS
transaction database and the FILESTREAM database.
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Identify the SQL Server to Host the FILESTREAM Database

In many DPS configurations, the SQL Server that hosts the DPS transaction database also hosts the
FILESTREAM database. However, DPS TDM has been developed to allow the FILESTREAM database
to exist on a separate SQL Server instance.

Enable FILESTREAM on SQL Server

You must enable FILESTREAM on the SQL Server instance intended to host the FILESTREAM database
before you can create the database. Because FILESTREAM is not enabled by default, you must enable
FILESTREAM during the SQL Server installation or after SQL Server is installed. See the appropriate
section for your installation.

Enable FILESTREAM during SQL Server Installation

To enable FILESTREAM during SQL Server installation:
1. Open the Database Engine Configuration.
2. Click the FILESTREAM tab and ensure that the following options are selected:
= Enable FILESTREAM for Transact-SQL access
= Enable FILESTREAM for file I/O streaming access

= Allow remote clients to have streaming access to FILESTREAM data

Note: By default, the Windows share name created for FILESTREAM access will be the SQL
Server instance name (default SQL instances are named MSSQLSERVER). Deltek
recommends that you use the default selections.

3. Click Next to continue.

Enable FILESTREAM after SQL Server is installed

To enable FILESTREAM after installing SQL Server:
1. On the database server, open the SQL Server Configuration Manager.
2. Right-click your SQL Server service, and click Properties on the shortcut menu.
3. Click the FILESTREAM tab, ensure that all three options are selected, and click OK.

Note: By default, the Windows share name created for FILESTREAM access will be the SQL
Server instance name (default SQL instances are named MSSQLSERVER). Deltek
recommends that you use the default selections.

In addition, complete the following configuration settings in SQL Server properties:
1. Open SQL Server Management Studio.
2. Right-click the server, and click Properties.

3. Select the Advanced page.
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4. Check to ensure that the Running Values are displaying that the Filestream Access level is set
to Full access enabled.

5. Click OK, and restart the SQL Server service.

Configure and Validate the FILESTREAM Database with WebLink

After the FILESTREAM database has been created and the 1IS Application Pool identity has been
granted db_owner rights to the FILESTREAM database, use the WebLink Utility to create the
FILESTREAM database schema.
To configure the database schema and verify the configuration:

1. Launch and log in to the WebLink utility on the DPS web/application server.

2. From the Current Database drop-down list, select the DPS database that will be used with DPS
TDM.

3. Select the Enable FILESTREAM check box.

You will receive a message asking if you would like to verify that the FILESTREAM database is
configured correctly.

By default, WebLink prefills:
= The name of the SQL Server being used for the DPS database
= The name of the FILESTREAM database (required and grayed out)

If you are hosting the FILESTREAM database on a different instance of SQL Server, click No and
modify the name of the FILESTREAM SQL Server. After you make the necessary changes, click
Test Connection on the WebLink menu to re-test and create the FILESTREAM database
schema.

Note: Your FILESTREAM database can exist on a different SQL Server instance.

4. Click Yes to validate the configuration.

A message displays indicating that the FILESTREAM database is not configured for use and
asking if you would like to configure it.

5. Click Yes to create the FILESTREAM database objects (tables, indexes, and so on).

When the objects are created, a message displays saying that the configuration is complete.

Files Administration Utility in DPS

Use the DPS Files Administration utility to search for and view files that were uploaded into DPS. These
include supporting documents that were uploaded for DPS transactions, as well as InDesign templates
that were imported or created using the DPS Merge Templates application.
To view the documents that have been uploaded using the Files Administration utility:

1. Open the DPS application.

2. On the DPS Utilities menu, click Files Administration.
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3. On the Files Administration dialog box, use the Date Range fields to select the start and end
dates to define the date range to search.

DPS defaults to use the past three days.
4. Click Refresh Files List to populate the Files grid.
Records that match the start and end date criteria display.
5. To further refine your results set, complete one or more of the following actions:

=  Enter specific text that you want to find. DPS searches the File Name and Description fields
to locate the matching text.

= Open the lookup and select a User ID.

= Use the drop-down list to select a DPS application. This drop-down list displays the
applications that allow supporting documents.

6. Click Refresh Files List to activate the search.
The Files grid lists all of the documents that match your criteria.

7. Click the File Name link to open the associated PDF.

‘Databases Out of Sync” Issue

The Databases Out of Sync dialog box displays when the files in the DPS and FILESTREAM databases
are not synchronized. This file mismatch can occur when there is a database backup or restore on one
database, but not the other. In this situation, the File Name link cannot open the selected file. Click OK to
return to the Files Administration utility. Then contact your system administrator for details.

Troubleshooting FILESTREAM

This section lists potential problems, causes, and solutions for issues with FILESTREAM.

Problem 1

You test the database connection for the first time in WebLink, and WebLink cannot create the
FILESTREAM database objects.

Possible Cause The FILESTREAM filegroup name is not in the required format:
[DeltekPSFILESTREAMDBName]_FS.

Solution Reformat the FILESTREAM filegroup name.

Problem 2

You receive a “FILESTREAM data cannot be placed on empty filegroup” error.
Possible Cause The FILESTREAM filegroup is not configured.

Solution Configure the FILESTREAM filegroup, and confirm that the FILESTREAM
filegroup name is in the required format:

[DeltekPSFILESTREAMDBName]_FS.
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Problem 3

When a user attempts to upload a document, DPS displays a message that it has not been configured to
upload supporting documents.

Possible Cause The Enable FILESTREAM option is not selected in WebLink and/or
FILESTREAM is not configured properly (WebLink is unable to connect to the
FILESTREAM database or the FW_Files table was not created.)

Solution Confirm that the Enable FILESTREAM option is selected in WebLink and that
FILESTREAM is configured properly.

Problem 4

When you test the FILESTREAM configuration in WebLink, a message displays saying that the
FILESTREAM database cannot be opened and that the login failed for the user account running the IS
Application Pool ldentity.

Possible Cause The FILESTREAM database has not been created or has not been created with
the required naming format, or the identity of the DeltekPSAppPool in IIS has not
been granted db_owner rights to the FILESTREAM database.

Solution Confirm that the FILESTREAM database exists and has been properly named
and that the 1IS Application Pool Identity has the required database rights.

Using FILESTREAM with Other SQL Server Features

Refer to this table for information about how FILESTREAM works with other SQL Server features.

All features See Using FILESTREAM with Other SQL Server Features.

SQL Server See FILESTREAM and FileTable with Always On Availability Groups (SQL

Availability Groups Server).

Transparent Data FILESTREAM can be used with TDE although the FILESTREAM data is not

Encryption (TDE) encrypted.

Log Shipping Log shipping supports FILESTREAM. Both the primary and secondary
servers must be running SQL Server 2012 or later and have FILESTREAM
enabled.

Database Mirroring Database mirroring does not support FILESTREAM. A FILESTREAM

filegroup cannot be created on the principal server. Database mirroring
cannot be configured for a database that contains FILESTREAM filegroups.

Failover Clustering For failover clustering, FILESTREAM filegroups must be put on a shared disk.
FILESTREAM must be enabled on each node in the cluster that will host the
FILESTREAM instance.
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SQL Server Express SQL Server Express supports FILESTREAM. The 4 GB database size limit
does not include the FILESTREAM data container.

How to Use FILESTREAM in a Firewall-Protected
Environment

To use FILESTREAM in a firewall-protected environment, both the client and server must be able to
resolve DNS names to the server that contains the FILESTREAM files. FILESTREAM requires that the
Windows file-sharing ports 139 and 445 be open.

The “client” in your DPS TDM deployment is the web/application server, so if your DPS deployment has a
firewall between the web/application server and the FILESTREAM database server, then the ports
referenced above must be open between the servers.

Queries to Join the DPS Transaction DB and FILES DB

The following query will obtain the file sizes in the FILES database by joining two [DeltekPS] and
[DeltekPS]Files databases. This will work if the databases are on the same SQL Server.

SELECT DATALENGTH(a.FileData) as FileSize, b.FileName, b.ContentType FROM
[DeltekPSDBName]FILES.dbo.FW _Files a inner join [DeltekPSDBName].dbo.FW_Files b ON
a.FileID=Db.FilelDd

The following query will obtain the file sizes in the FILES database by joining two [DeltekPS] &
[DeltekPS]Files databases. This will work if the databases are on Linked SQL Servers.

SELECT DATALENGTH(a.FileData) as FileSize, b.FileName, b.ContentType FROM
[FILESTREAMDBServer].[ DeltekPSDBName]FILES.dbo.FW_Files a inner join
[DeltekPSDBName].dbo.FW_Files b ON a.FileID=b.FileID

Note: You must create the link between the servers first. See SOL Server Books Online for
information on how to create Linked SQL Servers.
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Configure a Shared Location for Databases.enc

If your DPS deployment includes multiple web/application servers, or a dedicated process server, you
should create the shared directory as indicated below to eliminate the need to synchronize changes made
to databases.enc across your servers. Although not required, Deltek recommends this configuration for
the SetupWebApp and InstallDedicatedProcessServer switches.
To configure a shared path for databases.enc:
1. Ensure that the databases.enc file is synchronized across all servers.
2. ldentify a server that can host the file share.
This can be any server as long as it is located in the same data center as your DPS deployment.
Create a Windows file share on that server (for example, \\server\share).

4. Grant the service account(s) running the IIS Application Pool Identity and the Process Server
service a minimum of modify rights to the share you created.

5. Modify the DPS web.config file (..\DeltekPS\Web\web.config) on all web/application and process
servers:

= Under <appSettings>, locate the DatabasesEncDirectory entry and uncomment it out. (It will
be commented out by default.)

= For the value of this setting, enter the share path, not including the databases.enc file
name. It should look like this, where \\server\share\ is the actual UNC path to your file share:

<add key="DatabasesEncDirectory" value="\\server\share\" />
Copy the databases.enc file to the share.
Rename the databases.enc file on all web/application and process servers to databases.old.

8. Restart IIS and the Process Server service on all applicable servers and run tests to ensure that
DPS and WebLink can be accessed on all web/application servers and that the Process Server
service is processing jobs correctly.

9. Make sure to check the Application Event Logs on all servers for any errors or warnings.

Alternative to a Shared Databases.enc File

As an alternative to having a shared path for your databases.enc file, complete the following steps to
synchronize changes made to databases.enc across your servers.

You must do this every time that you make changes to databases.enc.

1. Launch the WebLink application on one web/application server and configure your connection
and application settings.

The settings are saved to a local encrypted databases.enc file on the server.

2. Copy the databases.enc file from your web/application server to all other web/application and
process servers.

Restart the Deltek DPS Process Server Windows service and IIS on each machine.

4. Repeat this process whenever any update is made in WebLink.

Technical Installation Guide 135


file://server/share
file://server/share/
file://server/share/

Deltek gwumor

Configure Secure Sockets Layer (SSL)

Configure Secure Sockets Layer (SSL)

Important Information on SSL Configurations

You must have properly configured SSL certificates installed and the necessary bindings created on all
web/application and reporting servers in your DPS configuration. You cannot run the setup script and the
various switches without them.

Read this section to better understand:
= How the DPS reporting framework handles SSL requests.
= How the use of non-standard ports impacts functionality.

= What configurations are and are not possible using non-standard ports.

How the Reporting Framework Handles SSL

Each request to run a report in DPS includes several calls to the report server web service URL. Some of
these calls are server-side (made from the DPS web/application server) and some of these calls are
client-side (made from the DPS application on the user’s workstation).

When DPS is configured for SSL, the SQL Reporting Services server must also be configured for SSL.
When you use a reverse proxy, DPS does not support the use of SSL Offloading so an SSL certificate
must be installed and configured on the report server.

The default behavior for server-side calls is that they are always made using only HTTP, which requires
that the report server have an HTTP binding configured. An alternative approach is to use HTTPS for
server-side calls. This approach works only if SSL is configured for use by both DPS and Reporting
Services. Select the Use HTTPS for Reporting Services server-side calls option on the Report Server
tab in WebLink to use HTTPS for server-side calls.

Client-side calls are always made using the protocol prefix used to access DPS, which requires SSL.
When you use SSL, the communication between the client and the server is always encrypted, whether
or not a reverse proxy is used. The SQL Reporting Services server must have an HTTPS binding in
addition to the HTTP binding, or the Use HTTPS for Reporting Services server-side calls option must
been selected to use HTTPS for server-side calls.

Non-Standard SSL Ports

While it is possible to use non-standard SSL ports with DPS, the default reporting framework behavior is
that all server-side calls to the report server URL are made using HTTP. For this reason, if you are using
a non-standard SSL port for your SQL Reporting Services URL (for example,
http://<ReportServer>:4443/reportserver) in WebLink, you need to use a reverse proxy, such as ARR,
and enable SSL Offloading. Alternatively, if you select the Use HTTPS for Reporting Services server-
side calls option, you do not need to configure an HTTP binding for SSRS or use a reverse proxy.

In addition, you need to configure an HTTP port on SSRS with the same port value (for example, HTTPS
web server port 4443 and SSRS HTTP port 4443). This will ensure that client requests to the ARR
reporting virtual directories work properly and that server-side calls from the web server to the report
server also work properly.

Similar changes are required if you use a hardware- or software-based reverse proxy solution other than
ARR. ARR is the only reverse proxy solution tested by Deltek.
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You can successfully use a non-standard SSL port for your DPS URL, but to use non-standard ports with
SSRS, you must do one of the following:

= Use areverse proxy.
= Select the Use HTTPS for Reporting Services server-side calls option.
= Reconfigure your system to use standard HTTP/HTTPS ports 80/443.

In a two- or three-tier DPS deployment where SSRS is on a different server than DPS, a configuration
without a reverse proxy and SSL Offloading enabled would require that the same non-standard port be
enabled on SSRS for both SSL and non-SSL bindings under the default reporting framework behavior.
This is not possible due to the resulting port conflict. To resolve this issue, select the Use HTTPS for
Reporting Services server-side calls option.

Likewise, using the default reporting framework behavior, you cannot configure a single server installation
with non-standard ports for both DPS and SSRS, with or without ARR, because the same port would be
required for both HTTP and HTTPS, resulting in a port conflict. However, you can have a single server
installation of DPS and SSRS using standard HTTP/ HTTPS ports 443/80, with or without ARR. To
resolve this issue, select the Use HTTPS for Reporting Services server-side calls option.

Secure the DPS Web Server

To configure DPS for use with SSL, you must either:

= Obtain an SSL certificate from an online certificate authority such as Verisign, Thawte, or
Comodo, or

= Have access to a domain or stand-alone certificate authority on your network.

Request a Server Certificate

To request the certificate:
1. Log on to the web server.
2. From Administrative Tools, open Internet Information Services Manager.
3. From the navigation pane at left, select your server navigation menu.
4. Double-click Server Certificates to display the Server Certificates window.
5. Inthe Actions pane, select one of the following options:

= Import: If you already have a certificate for your server, select this action to import that
certificate.

= Create Certificate Request: Select this action to launch a wizard that guides you in creating
a text file to submit to your Certificate Authority (CA) to obtain the actual SSL certificate for
your web server.

= Complete Certificate Request: If you used Create Certificate Request to request a
certificate, select this action to complete your request and install your certificate.

= Create Domain Certificate: If you have a Certificate Authority on your domain, select this
action to request your certificate.

= Create Self-Signed Certificate: Select this action to test SSL functionality or troubleshoot
SSL certificate issues.
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After you obtain and import your SSL Certificate, you must create an SSL binding for your
web server.

Expand Sites, and select your web site.

In the Actions pane, click Bindings.

On the Site Bindings dialog box, click Add.

On the Add Site Binding dialog box, in the Type drop-down list, select https.

© ® N o

The Port value automatically changes to 443.

10. From the IP address drop-down list, select your IP address or use the default setting All
Unassigned.

11. From the SSL Certificate drop-down list, select your certificate.
12. Click OK.

Test the SSL Certificate and Binding

To test your new SSL certificate and binding, access your web site using https:// as the URL prefix and
make sure that everything is working correctly.

Secure SQL Server Reporting Services

The Reporting Services Configuration Manager does not directly support requesting and importing the
SSL certificate, as 1IS does. To request and import the SSL certificate on your Reporting Services server,
you must use the Certificates MMC (Microsoft Management Console) snap-in, described below.

If you are using SSL for DPS (required), you must use SSL for Reporting Services. You cannot run SSL
for DPS without an SSL binding configured for Reporting Services.

= You cannot run DPS without SSL and still use SSL for Reporting Services.

= The Reporting Services web service URL in WebLink must reference the fully qualified domain
name of the report server. This is specified in the SSL certificate. If the report server previously
referenced a local netbios name, you must change it to the fully qualified domain name. The fully
qualified domain name must be in the format:

https://deltekps.companyname.com/reportserver

Note: If SQL Reporting Services and IIS are being used on the same server and you have already
configured an SSL certificate for IIS, you do not need to use the Certificate MMC imported in steps 1
through 9 below. Start with Step 10.

To secure SQL Server Reporting Services for DPS:

Click Start » Run.

In the Open field on the Run dialog box, enter mmc and click OK to launch the MMC console.
Click File » Add/Remove Snap-in.

On the Add or Remove Snap-ins dialog box, select Certificates and click Add.

Select Computer account, and click Next.

2 T oA

Select Local Computer.
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7. Click Finish, and then click OK. You should now see the certificate store.
Now you need to request a new certificate or import an existing certificate.
8. Right-click the Personal folder, and point to All Tasks.
Select one of the following actions:
= |f you have a domain Certificate Authority (CA), click Request New Certificate.

= |f you need to request a certificate from a stand-alone CA or an online CA, click Advanced
Operations » Create Custom Request.

10. After you have your SSL certificate, import it using the following steps:
a. Right-click the Personal folder.
b. Click All Tasks » Import to launch the Certificate Import Wizard.
c. Browse to the location of your SSL certificate and complete the import process.

At this point, the certificate is registered with the server. The next step is to register the certificate
with SQL Reporting Services.

11. Click Start » All Programs » Microsoft SQL Server » Configuration Tools to open the
Reporting Services Configuration Manager on the Report Server.

Next you must create the SSL bindings for the Web Service URL and the Report Manager URL.
12. Under Connect, click Web Service URL. The Web Service URL window displays.
13. On the Web Service URL window, click Advanced.

14. On the Advanced Multiple Web Site Configuration dialog box, under Multiple SSL Identities for
the Report Server Web Service, click Add.

15. On the Add a Report Server SSL Binding dialog box, select a specific IP Address (if appropriate).

16. Click the drop-down list for the Certificate option. The certificate you imported in the previous
steps should display.

17. Select the certificate.
18. Click OK to add this URL to the system.

Note: If all communication to the report server will be done via SSL, you should also remove
the HTTP binding from the configuration.

19. Repeat these steps for the Report Manager URL.
20. On the Web Server, launch WebLink, log in, and select the database.

21. On the ReportServer tab, verify that the URL contains a reference to the fully qualified domain
name of the report server.

This is specified in the SSL certificate. If the report server previously referenced a local machine
name, you must change it to the fully qualified domain name. The fully qualified domain name
must be in the form: https://dps.companyname.com/reportserver

Test the SSL Configuration

Test DPS using SSL URLSs to ensure that the product is functioning correctly. To do this, trace a DPS
SSL session using Telerik Fiddler or another HTTP tracing tool.
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Reload Reports into DPS

During the web server/tier installation process, DPS installs a standard set of reports for each language
enabled in the database. DPS uses the following internal steps to complete this process:

1. DPS installs the report folders and files into the DeltekPS\Reports folder (default location:
\Program Files\Deltek\DeltekPS\Reports).

2. DPS imports the DPS Report files into Microsoft SQL Server Reporting Services (SSRS), which
makes the reports available in Reporting Services.

Connection Errors

If there are problems with the connection between DPS and the report server, the reports will not install
correctly onto the report server.

Identify the Error

If the DPS installation displays a message stating that reports were not successfully imported during the
installation process, you must complete the appropriate procedure for your installation type.

Test the Report Server Settings in WebLink

Launch the DPS WebLink application.

For each database in the drop-down list, click the Report Server tab.

Click the Test Report Server button to verify that no errors occur during the connection.
Save your changes and exit WebLink.

a r~ 0N

Reload your reports into DPS.
Reload Reports into DPS
You have two options for reloading reports into DPS:

To reload reports using the LoadReports switch:

See LoadReports Switch.

To reload reports using the SmartClient application:

1. Launch the DPS SmartClient application.

2. Inthe DPS Navigation menu, click Utilities » Report Administration to display the Reporting
Administration form.

3. Select the Load Reports tab to load reports on the report server.

In the Location of reports on application server field, enter the file path location of the reports
(RDL files) on the report server.

From the Type option drop-down list, select Standard.

If you want to load a single report, enter the name of the report in the Report Name field. (You do
not need to supply the .RDL extension.)
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You can also use this field as a wild card search. For example, if you enter Project, DPS finds
and loads all files that contain the word Project, such as Project List, Project Summary, and
Project Audit.

Sub reports do not load for main reports; you must load them manually by name. If you leave the
Report Name field blank, all reports load.

Click Load Report Files. A loading reports warning message displays.
Click OK to continue the reload report process.
To install custom reports, return to step 5.

This time, select Custom from the Type option drop-down list. Then complete the remaining
steps of the procedure.

Attention: For additional information on reloading reports, click the Help button on the Load Reports
Tab.
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Create a Reverse Proxy for SQL Reporting Using
Application Request Routing (ARR)

Do I Need a Reverse Proxy?

DPS uses the Microsoft SQL Reporting Services WinForms/Web report viewer control to render reports.
This control requires a direct connection to the server running the SQL Reporting Services web service.
Due to the nature of the DPS and SQL Reporting Services logical tier architectures and the available
editions and licensing requirements of SQL Reporting Services, it is likely that the SQL Reporting
Services web service will not be installed on the web/application server in your deployment of DPS.

Typically, this is not a problem when DPS is deployed inside the intranet. However, when DPS is
deployed where it is accessible directly via the Internet, the infrastructure requirements needed to support
the configuration become complex because it is necessary to have:

= Multiple points of entry (one each for the web server and SQL Reporting web service)
= Multiple firewall configurations
= Potentially, multiple public DNS records with your Internet Service Provider (ISP)

To complicate matters, if you have a two-tier deployment of DPS, this deployment may require that the
server hosting your database is accessible to the Internet, posing additional security risks.

A reverse proxy using Microsoft's Application Request Routing (ARR) extension for 1IS allows the direct
forwarding of requests through the DPS web server to the reporting services web service, with responses
back to your Internet clients. This configuration resolves all of the issues described above. The primary
intent of a reverse proxy is to shield the SQL server from access via the Internet. Specifically, this applies
in two-tier deployments where the SQL database and report server are on the same physical machine.
Deltek does not generally recommend using a reverse proxy because it can have an adverse effect on
the performance of the web/application server.

Deltek supports the use of Application Request Routing 3.0. Follow the steps below to install ARR. These
installation instructions are specific to version 3.0 of ARR.

Attention: For additional information, see Application Request Routing.

Important Information on the Use of Non-standard Ports

Before installing and configuring ARR, see Configuring Secure Sockets Layer (SSL) for information on
how the reporting framework handles SSL requests and potential issues with the use of non-standard
ports.

Prerequisites

The following prerequisites must be met before installation:
= The DPS web/application server must be running one of the following:
=  Windows Server 2016 / IIS 10.0
=  Windows Server 2012 R2/ IIS 8.5
= DPS must be installed.
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= The lIS configuration must include the IIS role service Management Service.

Install Application Request Routing (ARR)

To download and install Application Request Routing on your DPS web/application server:
1. Go to the following URL to install ARR 3.0 via the Microsoft Web Platform installer:

http://www.iis.net/downloads/microsoft/application-request-routing

Click Install this Extension.
On the Microsoft Web Platform Installer page, click Install Now.

On the File Download dialog box, click Run to run the ARRv3_0.exe file.

o~ WD

When the Web Platform Installer launches, choose to install Application Request Routing 3.0.

The Web Platform Installer will ensure that all prerequisites required for the installation are also
downloaded and installed.

6. Accept the license agreements.

When the Web Platform Installer has finished downloading and installing all components, click
Finish and then click Exit on the Web Platform Installer main page.

Configure Application Request Routing (ARR)

To configure Application Request Routing:

1. Open Windows Explorer and create two folders under <drive>:\Program
Files\Deltek\DeltekPS\Web\, named:

= ReportServer: For example, enter: c:\\Program Files\Deltek\DeltekPS\Web\Reportserver.

= Reports (optional): This folder is needed only if you want external access to Report
Manager. DPS does not need this folder.

2. Create a new Application Pool called DeltekPSReportingProxy:
a. InllIS Manager, expand the server name.
b. Right-click Application Pools, and select Add Application Pool.
c. Enter the name, and click OK to create the Application Pool.
3. Modify the Application Pool settings:
Right-click the DeltekPSReportingProxy Application Pool, and select Advanced Settings.
Set Enable 32 bit applications to false.

a
b
c. Configure the Identity to be the same account as your DeltekPSAppPool.
d. Setldle Time-out to O (the default is 20).

e. Scroll down to see more Advanced Settings.

f. Set Regular Time Interval (minutes) to O (the default is 1740).

g. Set Specific Times to 00:15:00 (the default is 00:00:00).
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4. Create IIS Applications to act as the proxy for the Reports (SQL RS Report Manager) and
ReportServer (SQL RS web service):

a. InlIS Manager, expand Sites.
b. Right-click Default Web Site, and select Add Application.

c. (Optional) In the Alias field, enter Reports, configure it to use the DeltekPSReportingProxy,
and enter (or browse to) the physical path that you created in step 1.

d. Click OK to create the Reports application.
5. (Required) Set up the ReportServer Application:
a. Right-click Default Web Site, and select Add Application.

b. Inthe Alias field, enter ReportServer, configure it to use the DeltekPSReportingProxy, and
enter (or browse to) the physical path you created in step 1.

c. Click OK to create the ReportServer Application.

6. Add Rewrite Rules for each reporting application.
a. Under Default Web Site, click Reports Application.
b. Double-click URL Rewrite. \

Note: If you do not see the URL Rewrite module, it's possible that Internet Services
Manager was open when ARR was installed. Close and re-open Internet Services
Manager.

Click Actions » Add Rules.
Select Reverse Proxy, and click OK.

Click OK when you see the prompt: Are you sure you want to enable proxy functionality?

=~ 0o o 0

On the Add Reverse Proxy Rules dialog box, enter the name of your SQL Reporting Services
server in the Inbound Rules text box.

Since your DPS server is configured for SSL and your Report Server is also required to be
SSL enabled, the option Enable SSL Offloading (default) is not necessary, so clear this
option so that this feature is not enabled. This ensures that all communication remains
encrypted.

Click OK to create the reverse proxy rule.

h. Select the rule that was created and click the Edit link on the right, under Inbound Rules.

i. By default, the rewrite rule only includes the base URL for the server name entered. Edit the
URL under Rewrite URL to have the correct Reporting Services application. The correct URL
is:

http://<reportserver>/Reports/{R:1}

Note: Make sure that there is a slash between Reports and {R:1}.
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Do more.*

7.

Repeat steps 6a through 6g for the ReportServer virtual directory.
a. Under Default Web Site, click ReportServer Application.

b. Double-click URL Rewrite.

c. Click Actions » Add Rules.

d. Select Reverse Proxy and click OK.

e. When prompted about enabling proxy functionality, click OK.
f

On the Reverse Proxy Rules dialog box, enter the name of your SQL Reporting Services
server in the Inbound Rules text box.

g. Click OK to create the reverse proxy rule.

Select the rule that was created and click the Edit link on the right under Inbound Rules. By
default, the rewrite rule only includes the base URL for the server name entered.

Edit the URL under Rewrite URL to have the correct Reporting Services application. The correct

URL will be:
http://<reportserver>/ReportServer/{R:1}

Test the Proxy Server

To test the proxy server:

1.
2.

Open Internet Explorer.

Browse to the following URLSs.

If ARR has been configured properly, your request will be proxied to the SQL Reporting Services

server.
= https://<DPSWebServer>/Reports

where <DPSWebServer> is the Fully Qualified Domain Name of the web/application server.

= https://<DPSWebServer>/ReportServer

where <DPSWebServer> is the Fully Qualified Domain Name of the web/application server.

Configure DPS to Use the Reverse Proxy

To modify WebLink to use the reverse proxy:

1.
2.
3.

To open WebLink, on the web server, use http://localhost/DeltekPSClient/Weblink.application.

Enter the password to access WebLink.

Click the Report Server tab, and modify the Server URL to be the URL to access the new
ReportServer virtual directory that you created on the DPS Web Server.

Typically, the Server URL is in the form https://<ReportServer>/ReportServer. Change this to
https://<DPSWebServer>/ReportServer.

No additional changes are necessary for the WebLink configuration. Be sure to change all
databases that will use the reverse proxy.

To test the Report Server configuration, click Test » Report Server Configuration.

After the configuration tests successfully, save your changes.
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Troubleshooting

If you need help, contact the Deltek Global Services consulting group,

DeltekforPSConsulting@deltek.com. The consulting group will provide an estimate of the cost for the help
that you need.
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Configure HTTP Compression

Configuring HTTP Compression for DPS can greatly reduce the size of HTTP (hypertext transfer protocol)
requests and responses between the client and web server, which improves application response time.
HTTP Compression functionality is built into Internet Information Services (11S) but is not enabled by
default. This section explains how to install and configure HTTP Compression.

Three Configuration Methods for HTTP Compression

You can configure HTTP Compression using one of three methods:

= Use the appcmd IS command line administrative utility. You must run this utility via an elevated
command prompt such as Run as Administrator.

=  Modify the applicationhost.config file directly. Deltek does not recommend that you modify the
applicationhost.config file directly unless you are familiar with XML formatting. Be sure to make a
backup of applicationhost.config before you make any changes.

= Use the Configuration Editor via the Internet Information Services administrative utility.

This document focuses on the first of the three methods. However, if you want to use the other methods,
you can use the modified entries and settings from applicationhost.config, described at the end of this
section.

Install HTTP Compression IIS Role Services

To install HTTP Compression IIS Role Services:
1. Launch the Server Manager.
2. Click Roles.

3. Under Web Server (IIS), locate Role Services and check to see that the Static and Dynamic
Content Compression role services have been installed.

4. If not, select Add Role Services and install both role services.

Alternative Procedure

Alternatively, you can install these role services using the Windows Package Manager (pkgmgr) from an
administrative command prompt (for example, Run as Administrator). Run this command:

start /w pkgmgr Ziu:llS-WebServerRole;11S-Performance;l1S-HttpCompressionStatic;11S-
HttpCompressionDynamic
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Configure HTTP Compression

To configure HTTP Compression:
1. Select one of the following actions:

= |f you want to enable compression at the server level, ensure that both static and dynamic
compression are enabled via an elevated command prompt:

C:\Windows\System32\Inetsrv\Appcmd.exe set config -section:urlCompression -
doStaticCompression:true -doDynamicCompression:true

= If you want to enable compression for a particular web site, use the following command and
replace “ Site Name” with the name of the web site:

C:\Windows\System32\Inetsrv\Appcmd.exe set config "Site Name" -
section:urlCompression -doStaticCompression:true -doDynamicCompression:true
2. Set the static and dynamic compression levels via an elevated command prompt:

C:\Windows\System32\Inetsrv\Appcmd.exe set config -section:httpCompression -
[name="gzip"].staticCompressionLevel :9 -
[name="gzip"]-dynamicCompressionLevel:4

The default dynamic compression level is zero.

Note: Dynamic compression can significantly impact CPU resources. See the blog post IIS 7
Compression. Good? Bad? How much? for information and recommendations on setting
compression levels. The command above uses recommendations from this blog post.

3. Configure the content types that you want to compress.

The default configuration compresses most static and dynamic content types used by the
application.

However, you must configure specific content types to compress the ClickOnce content types.
Use these commands:

C:\Windows\system32\inetsrv\appcmd set config /section:httpCompression
/+dynamicTypes. [mimeType="application/octet-stream” ,enabled="true"]
/commit:apphost

C:\Windows\system32\inetsrv\appcmd set config /section:httpCompression
/+dynamicTypes. [mimeType="application/x-ms-application” ,enabled="true"]
/commit:apphost

C:\Windows\system32\inetsrv\appcmd set config /section:httpCompression
/+dynamicTypes. [mimeType="application/x-ms-manifest”,enabled="true"]
/commit:apphost

Note: ClickOnce content types are considered dynamic. If you add them under the
<statictypes> section, ClickOnce files are not compressed. See the following Microsoft
support article for additional guidance on setting content types: How to add content types for
HTTP compression in 1IS 7.0.
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Additional Settings that May Impact HTTP Compression

You should test to ensure that HTTP Compression is working as expected before modifying these
settings. Follow the instructions in the next section to determine if these settings are necessary in your
environment.

The following additional settings may impact the functionality of HTTP Compression:

C:\Windows\system32\inetsrv\appcmd.exe set config -
section:system.webServer/serverRuntime /frequentHitThreshold:1 /commit:apphost

C:\Windows\system32\inetsrv\appcmd.exe set config -
section:system.webServer/serverRuntime /frequentHitTimePeriod:00:01:00 /commit:apphost

The default values are 2 and 00:00:10, respectively.

Attention: For more information, see the article Server Runtime.

Test the HTTP Compression Configuration

Consider using Telerik Fiddler HTTP Debugging Proxy to determine that HTTP Compression is working
as expected.

HTTP Compression Sections/Settings in
applicationhost.config

The configuration of HTTP Compression described above modifies the three primary sections in
applicationhost.config shown below. The specific settings that you modify are displayed in red:

= <urlCompression doStaticCompression="true" doDynamicCompression=""true" />

=  <httpCompression directory="%SystemDrive%\inetpub\temp\l1lS Temporary Compressed
Files">

<scheme name="'gzip" dII="%Windir%\system32\inetsrv\gzip.dll”
staticCompressionLevel="9" dynamicCompressionLevel="4" />

<staticTypes>
<add mimeType=""text/*" enabled="true" />
<add mimeType="'message/*" enabled=""true" />
<add mimeType="application/x-javascript" enabled=""true" />
<add mimeType=""application/atom+xml" enabled="true" />
<add mimeType=""application/xaml+xml" enabled=""true" />
<add mimeType="*/*" enabled="false" />

</staticTypes>

<dynamicTypes>
<add mimeType=""text/*" enabled="true" />
<add mimeType="'message/*" enabled=""true" />
<add mimeType="application/x-javascript" enabled=""true" />

<add mimeType="application/octet-stream” enabled="true" />
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<add mimeType="application/x-ms-application” enabled="true" />
<add mimeType="application/x-ms-manifest” enabled="true" />
<add mimeType="*/*" enabled=""false" />
</dynamicTypes>
</httpCompression>

= <serverRuntime frequentHitThreshold="1" frequentHitTimePeriod="00:01:00" />
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Pre-Deploy DPS Smart Client to User
Workstations

DPS uses two technologies in the client tier:
= The primary technology is a web-based interface (web client).

= The secondary technology is a smart client that uses the ClickOnce deployment technology for
delivering Windows-based applications to the user. The smart client application checks for new
updates on the web/application server each time the application is launched and automatically
installs them into the local user’s profile (%WUSERPROFILE%\Local Settings\Apps\2.0\... ).

The smart client technology will be phased out prior to the release of DPS 3.0.

To reduce the size of the initial client-side download when a user launches the DPS smatrt client, you can
pre-deploy the smart client files to user workstations. This “Hybrid Deployment Model” (HDM) installs the

application by first looking in a specific folder on the workstation and, if no file is found there, downloading
the file from the application/web server.

When you use HDM, ClickOnce delivers about 15 files (enough to display the login page). After that,
HDM takes over to deliver core application assemblies, software updates, language-specific satellite
assemblies, and custom items.

ClickOnce Deployment Features

= Applications are installed per-user, not per-computer.

=  Administrator privileges are not required.

=  Applications do not have to be installed through Add/Remove Programs.

= Nothing is registered to the GAC (Global Assembly Cache).

= No ActiveX objects, plug-ins, or Java applets are used.

= The ClickOnce cache is located here: c:\Users\USERPROFILE_Name\AppData\Local\Apps\2.0

Files to be Deployed

You must repeat the process below each time that you upgrade your DPS application/web servers to a
new release.

The files that are pre-deployed to the user workstations are located on the application/web server in the
\Program Files\Deltek\DeltekPS\SmartClient folder (where DPS is installed):

=  DeploymentManifest.xml
= One or more zip files (as listed in the DeploymentManifest.xml)
You must copy all of the zip files, plus the DeploymentManifest.xml, to the workstation.

The date and time on the time stamp for each zip file must match the date and time shown in the
DeploymentManifest.xml.

Technical Installation Guide 151



Deltek gwumor

Pre-Deploy DPS Smart Client to User Workstations

Deploy Files to a Workstation

Use the procedure below to deploy files to a workstation. The workstation must be running Windows 7 or
higher.
To deploy files:

1. Locate the \ProgramData\ directory, and create the Deltek directory.

By default, the \ProgramData folder on Windows 7 and higher is hidden. You may need to select
the Show Hidden Files option in Windows Explorer.

2. Copy the DeploymentManifest.xml file and all zip files from the application/web server into the
Deltek directory.

3. Repeat this process each time that you upgrade your DPS application/web servers to a new
release.
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Configure Integrated Security for DPS

You can use Windows Integrated Authentication with DPS, which allows users to log in one time for both
Windows and DPS.

To do this, you configure Windows Integrated Security for each user’s DPS account, using the Windows
Domain network login as the username for that user. This allows the user to be automatically logged in to
DPS as long as they are logged in to the domain. If the user is not properly logged in to the domain, the
user is prompted for network credentials to log in to DPS. For example, non-domain workstation users, as
well as users connecting to the network via an Internet connection, receive a domain authentication
challenge before they are logged in to DPS.

The use of Integrated Security in 1IS requires a CAL (Client Access License) for each user who will
access the web server. This is a Microsoft, not Deltek, licensing requirement.

Alternative Approach: As an alternative to using Windows Integrated Security, you can use the
Microsoft Azure Active Directory single sign-on (SSO) feature. Like Windows Integrated Security, it
lets users log on to DPS using their Windows usernames and passwords instead of using separate
DPS usernames and passwords.

This approach is more commonly used with the cloud version of DPS and is described in the Cloud
Administrator's Help System.

Required Configuration Changes

To configure Windows Integrated Authentication, you must make several changes at the domain level
and in 1S, in addition to configuring your domain user accounts in DPS:

= You must configure a domain user account as the 1IS Application Pool identity for the
DeltekPSAppPool in IIS. The domain account does not require domain administrative rights.
Optionally, the DPS installation creates a local Windows account, DeltekPS, to serve this
function. However, a domain account is required to support trusted domains as well as the default
[IS Windows Integrated Security configuration of using Kernel Mode Authentication.

= The domain account used for the Application Pool Identity needs the following rights on the DPS
web/application server:

= The account must be a member of the following local groups:
= Administrators group
= |IS_IUSERS group

= The account requires the following local security policy rights:
= Allow log on locally
= Log on as a service
= Log on as a batch job

= You must change the DeltekPS IIS Application (virtual directory) from using Anonymous Access
to using Windows Integrated Security.
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= If you do not wish to use the default of Kernel Mode Authentication, you must create a Service
Principal Name (SPN) for the domain user account that is the Application Pool Identity. You must
have domain administrative rights to create the SPN.

Attention: See Configure a Service Principal Name for more information.

Configure the Application Pool Identity

To configure the Application Pool Identity to be a domain account:

1. Click Server Manager » Configuration » Local Users and Groups » Groups and add the
domain user to the local Administrators and 11IS_IUSRS group.

2. In Administrative tools, click Security Settings » Local Policies » User Rights Assignment to
grant the domain user the necessary rights.

3. Click Administrative Tools » Internet Information Services » Application Pools and change
the application pool identity.

Right-click DeltekPSAppPool, and click Advanced Settings.

In the Process Model » Identity field, click the ellipses (...).

On the Application Pool Identity dialog box, select Custom Account.
Click Set.

On the Set Credentials dialog box, in the Username field, enter the domain and user name in the
following format: Domain\Username. Click OK.

© N o 0 &

9. Launch DPS on the web/application server to ensure that the application launches correctly.

If not, review the application event logs to look for a problem.

Configure IIS to Use Windows Integrated Authentication

Do not make any modifications to the security settings for the DeltekPSClient IIS Application. The
application represents the ClickOnce deployment and must continue using Anonymous Access.
To configure 1IS to use Windows Integrated Authentication:

1. From within Internet Information Services, expand the web site where the DPS application is
installed.

Select the DeltekPS application.
Double-click the Authentication icon under IIS.
Select Anonymous Authentication, and click Disable on the Actions pane.

Select Windows Authentication, and click Enable on the Actions pane.

2 T

With Windows Authentication still selected, click Advanced Settings. Ensure that the Enable
Kernel-mode authentication option is selected, and click Cancel.

The default configuration is to have Enable Kernel-mode authentication selected. If you clear
Enable Kernel-mode authentication, you must create a Service Principal Name, which is
documented later in this section. The default setting is acceptable for application authentication;
however, if you wish to use Windows Integrated Authentication for your database connection, you
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must complete the Configure Windows Integrated Authentication for Internet Users (and Non-
Domain Workstations) procedure.

Launch the DPS application.
You should test both the Smart Client and Web Client.

You may see the Windows Authentication option on the login page. This option displays if you
have multiple databases configured in WebLink. If there is only one database, the user is
automatically logged into DPS, and this screen does not display.

Configure DPS for Windows Integrated Authentication

After the servers are configured to support Windows Integrated Authentication, you must configure DPS
application domain users with their domain logins.

WeblLink has options on the System Settings Tab that may alleviate performance issues when using
Windows Integrated Authentication. See the WebLink help for details. Test changes to these settings
thoroughly before you implement the changes in a production environment.

To configure a domain login for DPS:

1.
2.
3.

Launch the DPS Web application, and log in as a user with the appropriate security rights.
Click Configuration » Security » Users, and create a new user.

Enter the domain username for the user you want to create (for example, the login ID used to log
in to the Windows domain).

Complete the additional information required for the user.
Select the Windows Authentication option.

From the Domain drop-down list, select the domain for this user. If the domain is not listed, you
can manually enter the netbios name of the domain.

Save your changes.

When the user launches DPS, the login screen displays with the User ID and password blank
and the Windows Authentication check box cleared unless the WebLink option Automatically
check Windows Authentication check box in WebLink is selected.

= After a user logs in with Windows Authentication selected, this setting is remembered for
subsequent logins.

= If there is only one database defined in WebLink and the application is configured for
Windows Integrated Authentication, the user is automatically logged in to the application on
all subsequent logins after the initial login.
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Configure Windows Integrated Authentication for Internet
Users (and Non-Domain Workstations)

A different authentication process applies to domain users who are configured for Windows Integrated
Authentication but are accessing the application from a non-domain workstation or via the Internet.
To configure Integrated Authentication for Internet users:

1. Launch the DPS application.

The Internet Explorer security prompt displays because the user is not authenticated to the
domain and IIS is configured for Windows Integrated Authentication, meaning that only
authenticated users can access without a challenge.

2. Select the Remember my credentials option if you want to save your credentials for both the
browser and the WinForms application.

In the future, you will not be prompted for credentials.
Enter the domain credentials, and click OK.

4. Enter values in the Username, Password, and Domain fields on the Windows Login Credentials
dialog box.

This step is necessary because the client side WinForms application is not able to use the
previous credentials requested by, and processed by, Internet Explorer.

Configure Windows Integrated Authentication for the DPS
Database Connection

The first step in using Windows Integrated Authentication for the DPS database connection is to grant the
domain user account running the 1IS Application Pool Identity the appropriate rights to the DPS database
(and the report server and session state databases, as needed).

To establish rights for SQL Server:

1. Identify the domain user account that is being used as the Application Pool Identity in IIS. See
step 3 in the Configure the Application Pool Identity section.

In SQL Server Enterprise Manager, create a SQL login for this domain user account.

3. Click User Mapping and grant db_owner rights to the DPS database (and the report server and
session state databases).

4. Modify WebLink to use Windows Integrated Authentication for the various database connections.
Complete steps 5 through 10 to enable these settings.

Launch WebLink and enter the WebLink password when prompted.
Click OK.

From the Current Database drop-down list on the WebLink screen, select the database to which
you want to connect.

8. Select the Windows Authentication option to use the domain Application Pool Identity user
account to connect to the database.
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9. If necessary, you can also enable Windows Integrated Authentication for the report server
database connection. In this situation, the account requiring access may differ from the one used
for the IIS Application Pool Identity.

The account that will be used to make this connection is shown on this page as the Windows
Username under the report server URL. If this is a different account than the 1IS Application Pool
Identity, you must grant db_owner rights to the report server databases and then select the
Windows Integrated option for the report server database authentication.

Optionally, if you are using SQL Server session state, you can also enable Windows Integrated
Authentication for that connection. This will use the IIS Application Pool Identity to make the
database connection.

WeblLink has options on the System Settings Tab that may alleviate performance issues when
using Windows Integrated Authentication. See the WebLink help for details. Test changes to
these settings thoroughly before you implement the changes in a production environment.

10. On each of the tabs in WebLink, select the test button to test the connection.

Configure a Service Principal Name

To disable Kernel Mode Authentication, you must create a Service Principal Name (SPN) for the domain
user account that is the Application Pool Identity. The creation of the SPN requires domain administrative
rights.

[IS Kernel Mode Authentication

When you use Windows Integrated Authentication, the default configuration of IIS is to use Kernel Mode
Authentication. If you must disable Kernel Mode Authentication, follow the steps in this section to
establish a Service Principal Name (SPN) for the Application Pool Identity. In a default configuration of
IIS, Kernel Mode Authentication is enabled.
To see if Kernel Mode Authentication is enabled:

1. Using an Administrator account, log on to the DPS web/application server domain.

2. To open Internet Information Services, click Start » All Programs » Administrative Tools »
Internet Information Services (IIS) Manager.

3. Expand the server name, expand Sites, and select Default Web Site (or the site where DPS is
installed).

4. Select the DPS virtual directory, and double-click Authentication in the Features view.

Select Windows Authentication and verify that the status is Enabled. (Anonymous Access
should be Disabled.) If it is not, select Enable from the Actions menu.

6. With Windows Authentication still selected, click Advanced settings on the Action
menu. The Advanced Settings dialog box displays.

7. If the Kernel Mode Authentication check box is selected, Kernel Mode Authentication is
enabled.

Technical Installation Guide 157



Deltek gwumor

Configure Integrated Security for DPS

Kernel Mode Authentication Implementation

The default configuration works for the DPS Windows Integrated Authentication application and
database connections.

To disable Kernel Mode Authentication, clear the Enable Kernel Mode Authentication selection
under the Advanced Settings of the Windows Authentication feature for the DeltekPS virtual
directory. Disabling Kernel Mode Authentication requires that a Service Principal Name be
established for the Application Pool Identity.

Service Principal Names

Under the default configuration with Kernel Mode Authentication enabled, it is not necessary to create a
Service Principal Name for the Application Pool Identity. The default SPNs created are sufficient.

If you do create an SPN for the Application Pool Identity, you will cause a duplicate SPN issue that
prevents Windows Integrated Security from authenticating anyone to the web site.

When Kernel Mode Authentication is disabled, complete the following steps to create a Service Principal
Name for the Application Pool Identity of the DeltekPSAppPool.

To create the Service Principal Name:
1. Log on to the server with domain administrative rights.
2. Run the following commands:
= setspn —A http/<name of server> ApplicationPoolldentity (Domain\Username)
= setspn —A http/<fully qualified name of server> ApplicationPoolldentity (Domain\Username)
Or, if appropriate, use the DNS name of the server:

= setspn —A http/<DNS name of server> ApplicationPoolldentity (Domain\Username)

Note: See the following related Microsoft Knowledge Base article if you need additional
details: You receive an "HTTP Error 401.1 - Unauthorized: Access is denied due to invalid
credentials" error message when you try to access a Web site that is part of an 1IS 6.0

application pool.

Configure Authentication Persistence

When you use Windows Integrated Authentication in IS, every request made by the client is
authenticated, by default, using one of two Windows Integrated Authentication providers: Negotiate or
NTLM. This repeated authentication causes extra round trips between the client and server for each
request and can impact performance, especially on latent connections.

However, if you use Authentication Persistence, the server authenticates only the initial request from the
client and does not perform authentication on subsequent requests on the same connection, thus
improving performance.
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Source of Extra Round Trips

The default Windows Integrated Authentication provider is Negotiate, which causes the client and server
to “negotiate” an authentication method that both can support.

= On atypical Active Directory network, the default authentication method is Kerberos.

= On non-domain, or more specifically, Internet-based connections, the default authentication
method is NTLM.

If you view the connections for a single user in IIS logs, you see something like this:
NTLM:
2016-01-05 16:24:51 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 2 5 484
2016-01-05 16:24:51 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 1 2148074254 15
2016-01-05 16:24:51 10.5.12.16 POST /DeltekP S/MethodCall.aspx - 80 DOMAIN\ser 10.5.4.5 - - 200 0 0 501
2016-01-05 16:24:51 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 2 5 15
2016-01-05 16:24:51 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 1 2148074254 0
2016-01-05 16:24:51 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 DOMAIN\user 10.5.4.5 - - 200 0 0 15
2016-01-05 16:24:51 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 250
2016-01-05 16:24:51 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 1 2148074254 0
2016-01-05 16:24:51 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 DOMAIN\ser 10.5.4.5 - - 200 0 0 15
2016-01-05 16:24:54 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 2 5 15
2016-01-05 16:24:54 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 1 2148074254 0
2016-01-05 16:24:54 10.5.12.16 POST /DeltekP S/MethodCall.aspx - 80 DOMAIN\ser 10.5.4.5 - - 200 0 0 140
Kerberos:
2016-01-05 17:37:46 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 250
2016-01-05 17:37:47 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 DOMAIN\user 10.5.4.5 - - 200 0 0 93
2016-01-05 17:37:47 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 250
2016-01-05 17:37:47 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 DOMAIN\user 10.5.4.5 - - 200 0 0 15
2016-01-05 17:37:47 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 250
2016-01-05 17:37:47 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 DOMAIN\user 10.5.4.5 - - 200 0 0 15
2016-01-05 17:37:50 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 - 10.5.4.5 - - 401 250
2016-01-05 17:37:50 10.5.12.16 POST /DeltekPS/MethodCall.aspx - 80 DOMAIN\user 10.5.4.5 - - 200 0 0 144

For NTLM, note that there are two 401 (unauthorized) HTTP status codes (401.2 and 401.1) for each

HTTP 200 (success) status code. Each of these 401/401/200 codes represents a single request from the
client.

With Kerberos, there is only one 401 HTTP status code for each 200 status code.

Each 401 represents an extra round trip between the client and server, which can decrease overall
performance, especially on latent connections, such as from remote offices over a slower WAN link or via
the Internet.
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Know more.
Do more.*

Delte

Configuration Options for Authentication Persistence

If performance is a concern, you can enable Authentication Persistence via the Advanced Server
Connection Settings on the System Settings tab of the WebLink utility.

Select one of the following configuration options.

Share a single HTTP connection for
all HTTP requests and establish
authentication persistence when
using Windows Integrated
Authentication (supports Kerberos

only)

Share a single HTTP connection for
all HTTP requests when using
Windows Authentication (supports
Kerberos and NTLM) *requires
additional configuration — see help
documentation for more details*

None Selected (default)

Select this option if you are sure that all connections are
authenticating via Kerberos (for example, if you have an
Active Directory domain to which all users authenticate and
you do not have DPS open to the Internet).

Be sure that Negotiate is at the top of the list in the
Providers link under the Windows Authentication
configuration for the DPS application in 1IS. You can further
validate if Kerberos is in use by reviewing the IIS logs and
comparing them to the examples above.

Select this option to support both Kerberos and NTLM
authentication if DPS is open to the Internet.

You must also change the IIS configuration to add the
authPersistNonNTLM setting, described in this Microsoft
KB article: You may experience slow performance when you
use Integrated Windows authentication together with the
Kerberos authentication protocol in IS 7.0

The default behavior of 1IS does not change.

If the client is not going through a proxy to access the web server, select the related Disable automatic
proxy detection on HTTP requests (can improve performance over high latency connections)
check box to disable automatic proxy detection. This approach only has an impact on highly latent

connections (100ms or higher).

Use IIS Logs to Confirm Authentication Persistence

You can review IIS logs using Excel to see if authentication persistence is configured properly.

Fiddler is a great tool for debugging HTTP issues. However, to determine if authentication persistence is
enabled and working, use IIS logs. Examining IIS logs lets you see what is occurring from the perspective

of the server rather than the client.

To review IIS logs to confirm authentication persistence:

1. Copy the log to your desktop or to another working location.

2. Open the log in Notepad.
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3. Remove all of the header information or the log will not parse properly:
a. At the top of the log, note the first four rows:
#Software: Microsoft Internet Information Services 8.0
#Version: 1.0
#Date: 2016-01-05 16:24:50
#Fields:
b. After #Fields, find the word date followed by all of the other column headers.

c. In Notepad, place your cursor just before the d in date, press ENTER, and then delete the
first four rows.

d. Search through the log for additional instances of this header information, because IIS
restarts will cause the header information to repeat in the log. Delete any additional instances
that you find.

4. Open the log with Excel:
a. Browse to the location where you edited the log file.

b. On the Open File dialog box, select All Files from the File Type drop-down list. By default,
you will only see Excel files.

c. When the Text Import Wizard starts, select the Delimited option and click Next.

d. Select Space as the delimiter and click Finish.
5. When the file displays in Excel, locate the c-ip column and filter on unique client IP addresses.
6. Examine the requests.

If persistence is configured properly, you will see a few 401s at the beginning of the user’s
session, but the majority of requests will display as 200s.

It is normal to see other 401s. As long as they are not repetitive, persistence is configured
properly.
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Configure Database Session State for DPS

Session state information is typically stored in memory on the web server in the 1IS Application Pool
process serving the application (w3wp.exe). Database session state is normally not a consideration
unless you will be load balancing multiple front-end DPS web/application servers and you would like to
isolate your user’s session information from a failure or error on one web server where their session
information may be lost.

Use the WebLink utility to configure DPS to store session state information in a database. Be aware that
Deltek has written our own session state model and does not rely on the ASP.NET session state.

Create the Session State Database (Optional)

If you want to store session state information in the DPS database, WebLink automatically configures the
database table where session state information is stored. However, if you want to store the database
table in a database other than your DPS database, you must create a separate database and login for
this purpose.

Configure DPS for Database Session State

Before you make this change, make sure that you are making it during a maintenance window when no
one is logged into DPS. Changing the session state invalidates all active user sessions.

To configure DPS for database session state, complete the following steps on the web/application
server:

1. On the DPS web/application server, launch and log in to the DPS WebLink utility
http://localhost/DeltekPSClient/\Weblink.application.

2. Click the System Settings tab.

In the drop-down field, change Store Session State in Memory to Store Session State in SQL
Server.

You will receive a message that switching session state modes will force a restart of ASP.NET
and all users will lose their sessions.

Click Yes.

In the SQL Server field, enter the name of the database server where the session state database
exists.

6. Inthe Database Name field, enter the name of the session state database.

7. If you plan to use Windows Integrated Authentication for the database connection, select the
Windows Authentication option.

This disables the SQL Username and SQL Password fields.

Attention: See Configure Integrated Security for DPS for details on Windows Integrated
Authentication.

8. Inthe SQL username field, enter the SQL Login ID with rights to that database.

9. Inthe SQL password field, enter the password for the SQL Login ID that you entered in the
previous step.
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10. Click Test Database Connection to validate the connection information that you entered.
11. Click Apply to save your changes.

A message displays that prompts you to configure this database to store session state
information.

12. Click Yes to create a table in the database called FW_SessionState.
A message displays to tell you that WebLink has successfully configured the server (database) to
store the DPS session state.
To verify that the session state is being stored correctly:
1. Access your database server via a query utility.
2. Loginto DPS.

3. Run the following query in Query Analyzer to verify that a row has been added to the table. There
will be one row for every user logged in.

Use <Session State Database>
Go
Select * from FW_SessionState
Go

Note: If DPS is not closed properly, user sessions can be orphaned. A process server job
named “Delete Old Sessions” runs every night to remove orphaned user sessions.
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Securing Your DPS Deployment

When you install DPS, the installation script creates a number of user accounts on the DPS physical tiers
(database, web/application, report, and process server). These user accounts include local Microsoft
Windows user accounts and SQL Server Login IDs (for both Windows and Mixed Mode authentication).
You also have the option of using domain accounts for all of these service accounts.

To secure your DPS deployment, you must change these accounts so that they are unique to your firm
and do not include any Deltek default user accounts or passwords.

Most of these changes require administrative rights to your servers, so be sure to log in with the proper
account to make these changes. Do not log in using the DeltekPS local account because you will
subsequently delete or disable this account on all DPS servers.

Another option for changing the user account is to run the DPS installation script with the
SetServiceAccounts switch.

If You Have Multiple Servers

If you have multiple web/application, report, or process servers, make sure that you repeat the same
steps on each physical server, using the same user account information that you used on the first server
for that tier.

If You Have Deployed Several Logical Tiers with the Same
Windows Account

You may have deployed several logical tiers, all using the same Windows account and all located on the
same physical server. For example, in a single-server installation, the DeltekPS local Windows account is
used as all of the following:

= Application Pool Identity

= Reporting Services access account
= Process Server service account

= A Windows SQL Login account

If the account is serving multiple roles, you may not need to delete or disable the accounts as many times
as indicated in these instructions.
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Web/Application Tier

By default, the web/application tier installation creates a local Windows user account named DeltekPS.
(You can opt to use a domain account instead.)

This account is also added to the Local Administrators group and the 1IS_IUSRS group and is configured
as the Application Pool Identity of the DeltekPSAppPool.
To secure the web/application tier and customize the Application Pool Identity:

1. Begin by changing the Application Pool Identity. Select one of the following actions:

= If you are using a Windows domain, create a domain user account, or use an existing one.
Then add this user to the Local Administrators group and IIS_IUSRS group on the
web/application server.

= If you are not using a Windows domain, create a new local Windows user account and add
that user to the same Windows groups.

2. Log on to the domain on the DPS web/application server using an Administrator account.

Click Start » All Programs » Administrative Tools » Internet Information Services (lIS)
Manager to open Internet Information Services.

Expand the Server name, and click Application Pools.

Select the DeltekPSAppPool, and select Advanced Settings from the Action pane on the right
side.

6. Place your mouse pointer in the Identity field, and click the ellipses (...) button to set the identity.
7. Select the Custom account option, and click Set.

8. Inthe User name field on the Set Credentials dialog box, enter the Application Pool Identity in the
form <Domain>\<Username>.

9. Inthe Password and Confirm password fields, enter the user’'s password.
10. Click OK three times to set the identity.

After this process is completed, if you are using Windows Integrated Authentication for the SQL
Server connection, add the Domain user to the Local User (not Administrators) group on the SQL
Server and grant this new Domain user dbo (database owner) rights to your DPS database(s).

Attention: See Database Tier for more information.

11. Change the Process Server service account.

By default, the Process Server service is installed on every web/application server, as well as on
any server installed as a Dedicated Process Server.

Attention: See Process Server Tier for more information.

12. Click Computer Management » Local Users and Groups » Users and delete or disable the
local DeltekPS Windows user account on the web/application server.
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Database Tier

By default, the Database tier installation creates a local Windows user account on the SQL Server named
DeltekPS, as well as a SQL Server Login ID, also named DeltekPS. (You can opt to use domain
accounts instead.)

SQL Server has two modes of authentication:
=  Windows Integrated
= Mixed Mode

If you are unsure which mode of authentication you are using:

1. Launch the DPS WebLink utility on the web/application server via
http://localhost/deltekpsclient/weblink.application.

2. If you have not set a password for WebLink, click Change Password, and enter a unique
password.

The Change Password button is visible only when accessing WebLink via localhost on the
web/application server.

Log in to WebLink, and select your database from the Current Database drop-down list.
4. Review the information on the General tab to identify your method of SQL authentication.

= If the Windows Authentication check box is selected, then you are using Windows
Integrated Authentication.

= If the Windows Authentication check box is cleared and a SQL username and password
are entered, then you are using SQL Server or Mixed Mode authentication.

Windows Integrated Authentication

If you are using Windows Integrated Authentication for the SQL Server connection, the local Windows
user account is created on the database tier. You need to update the database tier with the new user
account that you created for the DPS Application Pool Identity in the Web/Application Tier section.

Note: See Configure Integrated Security for DPS for detailed information on configuring Windows
Integrated Security for web/application and database connections.

To update the database tier with the new user account:
1. Select one of the following options:

= |f you are using a domain user account for the IS Application Pool Identity, add this Domain
user to the Local Users (not Administrators) group on the SQL Server.

= |f you are using a local user account as the IIS Application Pool Identity, use the Computer
Management utility from Administrative Tools to create a local user on the database server
with the same username and password as you used on the web/application server.

Administrative rights to your database server are not necessary for the domain or local user
account described above.
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2. Create a new Windows login in SQL Server for the domain or local user account that is being
used for the 1IS Application Pool Identity.

Create the new SQL Login using SQL Server Management Studio from the Security - Logins
folder.

Grant this new Windows login dbo (database owner) rights to your DPS database(s).
On the web/application server, launch the WebLink utility.
Log in to WebLink, and select your database from the Current Database drop-down list.

If it is not already selected, select the Windows Authentication check box.

N o ok~ w

To ensure that the database connection information was updated correctly, click Test »
Database Connection to validate the connection.

8. Use the Computer Management utility under Administrative Tools to delete or disable the local
DeltekPS Windows user account on the database server.

9. Use SQL Server Management Studio to delete or disable the DeltekPS Windows Login ID from
within SQL Server.

Deleting the Windows User Account does not remove it from SQL Server.

Mixed Mode Authentication

If you are using Mixed Mode Authentication for the SQL Server database connection, you must create a
unique SQL Server login.
To create the SQL Server login:

1. If you have not already done so, secure the sa account with a unique password using SQL
Server Management Studio from the Security - Logins folder.

Create a unique SQL Server login ID and password using SQL Server Management Studio.

3. Grant the new login dbo (database owner) rights to your DPS database(s) and, if appropriate, the
reporting services databases (ReportServer and ReportServerTempDB).

4. If you want to use a different account for report server database access, create a second SQL
login in SQL Server Management Studio and manually update the Report Server tab in WebLink
with the new connection information.

Be sure to test the connection before saving your changes.
5. Log in to WebLink, and select your database from the Current Database drop-down list.
On the General tab, enter the new SQL Server login username and password.

To ensure that the database connection information was updated correctly, click Test »
Database Connection to validate the connection.

8. Update the Report Server tab with the new connection information for the report server
databases.

9. Use SQL Server Management Studio to delete or disable the DeltekPS SQL login ID that the
installation created on the Database server.

Report Tier

By default, the Report tier installation creates a local Windows user account named DeltekPS on the
report server (SQL Reporting Services server). This Windows user account is also granted System
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Administrator and Content Manager Rights in SQL Reporting Services. (You can opt to use a domain
accounts instead.)

Note: When you created the database tier account, access rights to the report server databases were
automatically given to the new user account.

To secure the report tier and customize the report tier account:
1. Select one of the following actions:

= |f you have a Windows Domain, create or have a domain user account created, and use the
Computer Management utility under Administrative Tools to add this user to the Local
Administrators group on the report server. Click Computer Management » Local Users and
Groups » Administrators, and add the new Windows account.

= If you are not using a Windows Domain, you must create a new local Windows user account
and add that user to the Local Administrators group.

The next step is to use Report Manager to grant this new account the necessary rights in
Reporting Services.

2. Use http://<report_server>/reports to open Report Manager, replacing <report_server> with the
name of your report server.

To access Report Manager, you must have rights to the report server. You may also need to
launch Internet Explorer using the Run as Administrator option.

3. Click the Site Settings link in the upper right corner and add the new account to the
Administrators role.

Delete the DeltekPS account from this role.

Click the Properties tab or the Folder Settings button (depending on your version of SQL
Server).

6. Add your new account to the Content Manager role.
Delete the DeltekPS account from that role.

8. Use the Computer Management utility from Administrative Tools to delete or disable the local
DeltekPS Windows user account on the report server.

Process Server Tier

By default, the Process Server tier installation creates a local Windows user account named DeltekPS on
the process server. (You can opt to use a domain accounts instead.) By default, the process server
service is installed on every web/application server, as well as on any server installed as a dedicated
process server. Therefore, you should perform the following steps on every web/application server as well
as on every dedicated process server.

In this procedure, you change the Process Server Service Account (a Windows account on the process
server tier).
To secure the Process Server tier and customize the Process Server service:

1. Select one of the following actions:

= If you have a Windows Domain, create or have a domain user account created. Use the
Computer Management utility under Administrative Tools to add this user to the Local
Administrators group on the Report server. Click Computer Management » Local Users
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and Groups » Administrators, and add the new Windows account.

= If you are not using a Windows Domain, you need to create a new local Windows user
account and add that user to the Local Administrators group.

2. To change the service to run your new account, click Start » Control Panel » Administrative
Tools » Services, and locate the Deltek PS process server service.

Update the Log On As column to reflect the new user information that you created above.

4. Use the Computer Management utility from Administrative Tools to delete or disable the local
DeltekPS Windows user account on the process server.
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Configure Reporting Services Logging

You can debug Reporting Services issues using two different kinds of Reporting Services logging:

= Trace logging, which provides detailed logging of errors or warnings seen in the Reporting
Services logs.

= HTTP logging, which helps identify HTTP- and authentication- related issues in Report Manager
or the Report Server web service.

Consider enabling and configuring this logging.

Attention: For more information, see the article Reporting Services Log Files and Sources.

Enable Reporting Services Trace Logging

To configure trace logging:
1. Stop the Reporting Services service.
2. Modify the ReportServenbin\ReportServerService.exe.config file.

See the details in the Changes to the ReportServernbin\ReportServerService.exe.config File
section.

3. Restart the Reporting Services service.

Attention: For more information, see the article: Report Server Service Trace Log.

Rules for Tracing

You can enable tracing for the components listed below. These are the trace level rules, as defined in the
ReportServerService.exe.config file:

= |f atrace level is defined for the specific component in RSTrace/Components, then that setting
takes precedence.

= If atrace level is defined for all components (for example, all:3) then that level is used.

= If neither level is defined, the default trace level (labeled DefaultTraceSwitch) defined in
system.diagnostics/switches is used.

Components that Can Be Traced

= Library =  DbPolling = DbCleanup

= ConfigManager = Notification = Cache

=  WebServer = Provider = Chunks

= NtService = Schedule = ExtensionFactory
= Session = Subscription = RunningJobs

= BufferedResponse = Security =  Processing

= RunningRequests = ServiceController = ReportRendering

Technical Installation Guide 170


https://docs.microsoft.com/en-us/sql/reporting-services/report-server/reporting-services-log-files-and-sources?view=sql-server-2017
https://docs.microsoft.com/en-us/sql/reporting-services/report-server/report-server-service-trace-log?view=sql-server-2017

Deltek gwumor

Configure Reporting Services Logging

" HmiViewer * PreviewServer = SemanticModelGenerat
= DataExtension = ResourceUtilities or

=  EmailExtension = ReportPreview - Semantic(?ueryEngine
= ImageRenderer = Ul = AppDomainManager

= ExcelRenderer = Crypto * HttpRuntime

Changes to the ReportServer\bin\ReportServerService.exe.config File

Make the highlighted modifications to the ReportServenbin\ReportServerService.exe.config file:
<configuration>
<configSections>

<section name="RStrace"
type="Microsoft._ReportingServices.Diagnostics.RSTraceSectionHandler ,Microsoft_Reportin
gServices.Diagnostics" />

</configSections>
<system.diagnostics>
<switches>
<add name="DefaultTraceSwitch" value="3" />
</switches>
</system.diagnostics>
<RStrace>
<add name="FileName" value="ReportServerService_" />
<add name="FileSizeLimitVvb" value="32" />
<add name="'KeepFilesForDays" value="14" />
<add name="Prefix'" value=""tid, time" />
<add name="TracelListeners" value="debugwindow, file" />
<add name="TraceFileMode" value="unique" />
<add name="HttpTraceFileName" value="ReportServerService HTTP_" />

<add name="HttpTraceSwitches" value="date,time,
clientip,username,serverip,serverport,host,method,uristem,uriquery,protocolstatus,byte
sreceived, timetaken, protocolversion,useragent,cookiereceived,cookiesent,referrer” />

<add name=""Components"
value="all:3,http:3,Library:4,Emai lExtension:4,Subscription:4,Schedule:4,Notification:
4 ,DbPolling:4,NtService:4" />

</RStrace>
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Errors in the Reporting Services Log File

Errors appear in the reporting services log file as shown below:

session!ReportServer_0-1!e10!09/11/2011-13:14:51:: i INFO: LoadSnapshot: Item with session:
pvonO0I55nrycom3uczjnho45, reportPath: , userName: KL\deltekadmin not found in the database

library!ReportServer_0-1!€10'09/11/2011-13:14:51:: e ERROR: Throwing
Microsoft.ReportingServices.Diagnostics.Utilities.ExecutionNotFoundException: Execution
'pvon0I55nrycom3uczjnho45' cannot be found, ;

Info: Microsoft.ReportingServices.Diagnostics. Utilities.ExecutionNotFoundException: Execution
'pvon0I55nrycom3uczjnho45' cannot be found

Each log entry begins with the sections (or components) that can be traced, followed by an exclamation
point. For example, if you want verbose logging for the errors shown above, enable library and session
verbose logging as follows:

<add name=""Components" value="all:3,Library:4,Session:4" />

Enable Reporting Services HTTP Logging

The Reporting Services service runs its own http.sys listener to accept standard HTTP/HTTPS requests
on standard HTTP ports (80/443). Unlike Internet Information Services, HTTP logging is not enabled by
default, but can be enabled following the steps in the article Report Server HTTP Log.

You can also use Telerik Fiddler to trace the HTTP requests from client to report server for help
troubleshooting HTTP and authentication issues.
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Configure an Alternate Database for DPS
Reporting

When you use DPS reporting, your SQL Server database engine must handle two different workloads:
transactional and reporting. These workloads demand tremendous resources from your SQL Server. One
remedy is to offload the reporting workload to a different SQL Server, where you have a copy of your DPS
database.

These reports use the alternate database:
= Dashboard reports
= Reports in the Reporting menu applications (excepting the Purchasing reports)

They use the alternate database whether they are previewed, directly printed, emailed, run via the
process server, or processed in another way.

All other reports, including posting logs, billing (interactive and batch) reports, and timesheet and expense
reports continue to run their queries against the DPS transaction database.

Note: Visualization reports do not use SQL Reporting Services and are not affected by this feature.

Alternate Database for Reporting

To set up an alternate database, configure a copy of your DPS database for access. Then configure the
connection string information in WebLink on the Report Server tab in the Alternate Database for
Reporting section. The primary benefit of using the Alternate Database for Reporting configuration in
WeblLink is that it can be used with any version or edition of SQL Server.

Note: With SQL Express, the Alternate Database for Reporting must be located on the same SQL
Express instance as the transaction database. This is a limitation of SQL Express because Reporting
Services for SQL Express can only use local databases.

Consider the following:

= Find an appropriate method to create a copy of the database on the second SQL Server (for
example, transactional replication, log shipping, database backup/restore, or third party tools that
support SQL Server snapshot backup).

Note: Deltek has not completed testing and does not provide support for the underlying
database copy/synchronization methodology that you choose.

= Ensure that the database copy used for reporting is kept in sync with the transaction database.
Not keeping the databases in sync will result in stale data for reporting purposes.

= Ensure that the SQL login used for authentication has read-only access to the database.
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This Microsoft documentation will help you choose an appropriate database replication/synchronization
methodology:

= Transactional replication:

SOL Server Replication

Note: DPS uses the SET CONTEXT_INFO stored procedure, which is known to cause
issues during the replication of objects that require schema changes on the replicated
database (See the article Make Schema Changes on Publication Databases.) Fortunately, in
DPS, this issue appears limited to the replication of custom user defined fields. To work
around this issue, you can set up an internal process to identify and manually replicate these
objects before they are put into production use.

= Log shipping:
About Log Shipping (SOL Server)

= Backup/restore:

Back Up and Restore of SOL Server Databases

= Third party tools that support snapshot backups:
Snapshot Backups

Note: SQL Server Database Mirroring is not supported for the Alternate Database for Reporting
functionality because the mirrored database is not accessible for read-only queries.

Also, Database Mirroring does not support SQL Server FILESTREAM, which is required for DPS
Transaction Document Management (TDM).

Configure the Alternate Database for Reporting in WebLink

To configure an alternate database for reporting:
1. Create a copy of your DPS transaction database on a second SQL Server.
For testing purposes, perform a backup/restore.

2. Identify and implement a methodology to ensure that data is synchronized between the
databases within a timeframe differential suitable to your business needs.

3. Create a login that has read-only rights to the alternate database.

This can be accomplished by granting db_datareader rights, rather than db_owner rights, to the
SQL Server login that is used for the alternate database.

4. Launch the DPS WebLink utility and select the DPS transaction database entry that you will
configure as an alternate reporting database.

Click the Report Server tab.
Select the Use Alternate Database for Reporting option and click OK.
DPS displays a reminder message.

7. Click OK to continue.
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8. Enter the connection string information for the alternate database:

Server Name Enter the name of the SQL Server hosting the alternate
database.

Database name Enter the name of the alternate database.

Windows Authentication Select this check box if you are using Windows Integrated

Authentication for the database connection. The identity of
the DeltekPSAppPool will need read-only rights to the
alternate database.

Database Username/Password If you are not using Windows Integrated Authentication,
enter the SQL server login with read-only rights to the
alternate database.

9. From the WebLink menu, click Test » Alternate Database for Reporting to validate the
connection.

Identify the Connection String Used in a Report

After configuring the Alternate Database for Reporting option, validate that reports are running against the
correct database.

To acquire the connection string by previewing the report:
1. Click the construction haticon = on the Reporting toolbar. If you don’t see the icon, maximize
the report.
From the View Report Information drop-down list, select Report Data Source.
3. Click the View button.
You will be prompted to Open or Save the XML file.

4. Click Open, and the file will open using the application configured to open XML files. On most
computers, that will be your default browser.

5. Review the ConnectString element for the following attributes:

= Data Source: This is either the database server specified in the Alternate Database for
Reporting configuration or, if you use Availability Groups, the Availability Group Listener.

= |nitial Catalog: This is either the database name specified for the Alternate Database for
Reporting configuration or, if you use Availability Groups, the DPS database name.

= Applicationintent=ReadOnly: This only displays when you use Availability Groups and if the
report was run against the Read Only reporting database.

= MultiSubnetFailover: This only displays when you use Availability Groups.
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Configure Basic Availability Groups Using
Microsoft SQL Server Standard Edition

DPS supports the use of Microsoft SQL Server AlwaysOn Basic Availability Groups if you have SQL
Server 2016 or a later version.

= A SQL Server Basic Availability Group provides a high availability solution for databases hosted
on SQL Server Standard Edition.

= Basic Availability Groups support failover for a single database.

=  Multiple Basic Availability Groups are supported in the same server configuration, which provides
failover support for multiple databases on the same server.

Differences in SQL Server Standard and Enterprise Features

You can use Availability Groups with SQL Server Standard Edition or Enterprise Edition, but features will
vary:

SQL Server Edition See installation steps here:

SQL Server Standard Edition = Basic Availability Groups This section
= Multi-subnet Failover
SQL Server Enterprise Edition =  Availability Groups Configure Availability Groups

Using Microsoft SOL Server
Enterprise Edition

= Readable Secondary
Replicas

= Read Only Routing

=  Multi-subnet Failover

Attention: This section focuses specifically on the SQL Server Basic Availability Group features
supported by DPS. For more information on the limitations of Basic Availability Groups, see these
articles:

= Basic Availability Groups (Always On Availability Groups)

= Editions and supported features of SOL Server 2016

Prerequisites

See the MSDN documentation for prerequisites, restrictions, and recommendations for AlwaysOn
Availability Groups:

Preregs, Restrictions, Recommendations - Always On Availability Groups

Specific prerequisites for Basic Availability Groups with DPS are:
= Standard Edition of SQL Server 2016

= A maximum of two SQL Server Standard Edition nodes
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= Standard Edition of Windows Server 2012 or later. (The specific operating system feature that is
required to support Availability Groups is Windows Server Failover Clustering.)

Note: If you are using Transaction Document Management (which uses SQL Server
FILESTREAM) and Windows Server 2012 Failover Clustering, you may need to install the
following Microsoft hotfix:

Can't access VNN FILESTREAM share when you use the FILESTREAM and FileTable
features on a Windows Server 2012-based failover cluster

= A Windows file share on a server other than the SQL Servers to which the SQL service accounts
have write access. This is required to configure Availability Groups.

= Windows Server Failover Cluster feature, installed and configured

Multi-subnet Failover

The Multi-subnet Clustering feature provides failover support when the primary and secondary replicas of
the Availability Groups are on different network subnets.

If your WSFC (and SQL Server Availability Group Listener) are configured so that your WSFC nodes are
on different network subnets, multi-subnet failover support is automatically enabled.

The MultisubnetFailover=True option is automatically added to the connection string.

Attention: For more information, see the following articles:

= Listeners, Client Connectivity, Application Failover

= Create or Configure an Availability Group Listener (SQL Server)

Install and Configure Windows Server Failover Cluster
(WSFC)

The WSFC will cluster applications and services. Your specific configuration depends on your intended
use of SQL Server Availability Groups. For example, you may want to use a SQL Server Failover Cluster
Instance (FCI) in addition to using Availability Groups. One of the primary differences in the cluster
configuration of an FCI versus an Availability Group is the need to provide shared storage.

Attention: See the Microsoft documentation for in-depth details about configuring Windows Server
Failover Clustering for your intended use.

When you configure Windows Server Failover Cluster:

= A cluster virtual network is created. You will need an IP address and DNS name for the cluster
and server names for the nodes that will be members of the cluster.

= No shared storage is needed, so you can deselect the option to add available storage.

= A static IP or DHCP can be used for the cluster network. A static IP should be used for production
environments.
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Know more
Do more.*

= A DNS name is created automatically, or you can create a DNS entry before configuring the

cluster.

= You will need domain rights because the process creates a computer account in the domain for

the cluster virtual network.

=  Two virtual networks are created, one for the Windows Server Failover Cluster and one for the
Availability Group listener. Use a unique name for the cluster, one which is not SQL-specific but

will be easily identifiable as the Windows cluster.

=  When DPS connects to the SQL Server, it will not connect to the WSFC name but will connect to
the Availability Group Listener (created later). The WSFC is enabled for the failover functionality

of Availability Groups.

Use the following procedures to install and configure Windows Server Failover Clustering.

Note: Depending on your operating system, the steps in these procedures may vary slightly. The
procedures in this section are based on Windows Server 2012 Standard Edition. See this article:
Windows Server Failover Clustering with SQL Server.

Install the Failover Clustering Feature

To install the failover clustering feature:
1. Open the Server Manager utility.
Access the Local Server and scroll down to Roles and Features.
From the Tasks drop-down list, select Add Roles and Features.
In the Add Roles and Features wizard, click Next until you get to the Select Features page.
Select the Failover Clustering option.
If prompted, click OK to install any dependent features.

Complete the wizard to perform the installation.

© N o 0k~ w0 DN

If prompted, reboot the server.

Configure Failover Clustering using Failover Cluster Manager

To configure the Failover Clustering feature:

1. From Administrative Tools, open the Failover Cluster Manager.

2. Under Management, click Create Cluster. The Create Cluster Wizard will guide you through the

process.

3. Onthe Select Servers page of the wizard, browse to or enter the names of the servers that will be

part of the cluster.

4. On the Validation Warning page, select Yes to run the Cluster Validation tests, and then click

Next.

This process creates a report that identifies any problems that need to be addressed before you

create the cluster.

5. When the validation is completed, provide a name for the cluster in the Cluster Name field.

6. Click Next to create the cluster.
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7. If you are configuring a WSFC that does not require shared storage, clear the Add all eligible
storage to the cluster option.

Install SQL Server on Each Cluster Node

After configuring the WSFC, you must perform the SQL Server installation on each node in the cluster.

After installing SQL Server on all nodes in the cluster, restore your DPS transaction and FILESTREAM
databases and configure the SQL Reporting Services databases (ReportServer and
ReportServerTempDB) on the Primary node in the cluster.

Installation Requirements and Notes

= If you are only configuring Availability Groups (not a Failover Cluster Instance), you must perform
a New SQL Server stand-alone installation, not a New SQL Server failover cluster installation, on
each node.

= Shared storage is a requirement of Availability Groups only if they are installed in a SQL Cluster.
The prerequisite check will fail if you choose a SQL Server Cluster installation and do not provide
shared storage.

= Only the SQL database engine can use Basic Availability Groups. Even though the Availability
Groups use a WSFC, this does not constitute a true cluster and will not provide fault tolerance for
other SQL Server services (Analysis Services or Reporting Services).

= To be fault tolerant, Analysis Services must be part of an actual Failover Cluster Instance (FCI)
where SQL is installed using a new SQL Server failover cluster installation.

= You can use an FCI with an Availability Group to enhance the availability of an availability replica.
However, to prevent potential race conditions in the WSFC cluster, automatic failover of the
Availability Group is not supported to or from an availability replica that is hosted on an FCI.

= Reporting Services use a scale-out deployment, which is not a cluster.

= You can use the same or different service accounts on each node, but all accounts must have
rights to the file share described in the Prerequisites section above.

= FILESTREAM functionality can be used with Availability Groups and will require that
FILESTREAM be enabled on both failover nodes.

Attention: For more information, see FILESTREAM and FileTable with Always On
Availability Groups (SQL Server).

You may also need this Microsoft hotfix:

Can't access VNN FILESTREAM share when you use the FILESTREAM and FileTable
features on a Windows Server 2012-based failover cluster

= Although this is not a requirement, you should consider performing the exact same SQL Server
installation on each node, including the same installation, configuration, and instance name.

=  For proper failover support, the failover nodes should have comparable hardware resources.

See the MSDN documentation for prerequisites, restrictions, and recommendations for AlwaysOn
Availability Groups:

Preregs, Restrictions, Recommendations - Always On Availability Groups
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Configure Database Login

For the DPS and Reporting Services databases that are part of an Availability Group to be immediately
available in the event of an Availability Group failover, you must complete these steps on both failover
nodes. The following rights must be granted to the login used to access the DPS and Reporting Services
databases that are part of the Availability Group:

Dbo = Database Owner rights to all databases | All databases in the Availability Group
in the Availability Group

View Any Definition Availability Groups

View Server State Availability Groups

When you back up and restore a database to another server, the login on the first server has a different
SID (Security Identifier) than the same login on the second server. This issue is typically resolved using
the sp_change_users_login stored procedure. However, since the database on the secondary replica will
be in read-only mode, you cannot fix the login.

You can resolve this issue by using the sp_help_revlogin stored procedure, described in this article:

How to transfer logins and passwords between instances of SOL Server

Once the procedure is created in the master database, execute it to get:
= The list of SQL Logins with their associated SIDs.
= The CREATE statement needed to create the login on the Secondary replicas.

Here is an example:

CREATE LOGIN [DeltekPS] WITH PASSWORD =
0x0200EOE05D60876CCE39BD9209515FB63C5589D6C939F3AB56A6CE9DBFBF49A9410F66F098408
27135F800725E25A77714FDFA31FB6C18BCB46561217947C3749F0380A18AF5 HASHED, SID =
0x0124F12258D9BD49BE649C2D7A6DA838, DEFAULT_DATABASE = [master], CHECK_POLICY =
OFF, CHECK_EXPIRATION = OFF

Prior to configuring the Availability Groups, run the CREATE statement(s) created from executing
the sp_help_revlogin on your server on all secondary replicas.
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Create Availability Groups

You must enable Availability Groups and create an Availability Group on the primary node.

To enable Availability Groups:
Open the SQL Server Configuration Manager.
2. Right-click the SQL Server service and click Properties.

3. On the AlwaysOn High Availability tab, select the option to enable the Availability Groups for each
node.

4. Restart the SQL Server service.

Repeat steps 1-4 on all nodes that will be part of the Availability Group.

To create an Availability Group:

1. For each database that requires failover support, put the database in FULL recovery mode and
make a FULL database backup.

A Basic Availability Group can only handle failover for a single database, so you will need to
create an Availability Group for each database that requires failover support.

In a typical DPS deployment you will have at least three databases: DPS, ReportServer, and
ReportServerTempDB. Other possible databases include the Transaction Document
Management (FILESTREAM) database.

Attention: For more information on performing backups and restores of databases in FULL
recovery mode, see the article:

Back Up and Restore of SOL Server Databases

2. In SQL Server Management Studio, start the Availability Group Wizard.

Expand AlwaysOn High Availability, right-click Availability Groups, and click New Availability
Group Wizard on the shortcut menu.

4. Select a name for the Availability Group.

Because each database will be in its own Availability Group, you will need a separate Availability
Group for each database. The name should describe the database that the Availability Group
includes (for example, DeltekPSAG).

5. Select the Database Level Health Detection option.

This undocumented option controls whether the entire Availability Group fails over if one
database becomes suspect. Because Basic Availability Groups contain only one database, this
setting is not directly applicable, but Deltek recommends selecting it anyway. This feature is only
available in SQL Server 2016.

6. Select the database to be included in the Availability Group, and click Next.

The wizard will tell you whether or not the database meets requirements (for example, the
database is in FULL recovery mode and you have made a FULL database backup).

7. On the Replicas tab, specify the Availability Group configuration (nodes, failover mode, and
synchronization mode).
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Attention: See this article for more information on failover and failover modes:

Failover and Failover Modes (Always On Availability Groups).

8. For Basic Availability Groups, use the Add Replica button on this tab to add the second node.

9. Select settings, referring to this table, and click Next.
Server Instance A maximum of two servers is allowed.
Initial Role Select the role of the server (Primary or Secondary).

Automatic Failover = Check this option for failover to occur automatically. Otherwise, failover
will be a manual process.

Synchronous This option controls how transactions are committed, which has an
Commit/ impact on the performance of the synchronization and how much data
Asynchronous may be lost in the event of a failure. Select one of these options:
Commit

= Synchronous Commit: Each transaction must be committed to
both Node 1 and Node 2 before the transaction is considered
complete. This option reduces the possibility of data loss, but at
the expense of performance.

= Asynchronous Commit: Each transaction is committed to Node
1. The transaction is also sent to Node 2 but there is no verification
if it is or is not committed. This option performs better, but with the
chance of data loss.

Readable Select No because this setting does not apply to Basic Availability
Secondary Groups, which do not allow connections to secondary replicas.
10. Check the information on the Endpoints tab.
The Endpoint for each instance is created automatically.
11. Check the information on the Backup Preferences tab.

Backup Preferences determine whether or not backups can be made from replicas other than the
primary replica. This tab is grayed out because this feature is not available in Basic Availability
Groups.

12. Click the Listener tab, where you create the Availability Group Listener.

Only one listener is required, regardless of the number of Basic Availability Groups configured,
unless your replicas are on different subnets.

13. Create a listener for the first Availability Group created, but not for subsequent Availability
Groups.
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14. From the Network Mode drop-down list, select the type of listener: Static IP or DHCP.
The port will be the same as the one used by the SQL Server port (the default is 1433).

Note: If you are using multiple subnets, click the Add button to add the IP address for the
listener on all subnets. This option is available only if you are using Static IP addresses. See
this article for more information:

Add IP Address Dialog Box (SQL Server Management Studio)

15. Click Next.

16. On the Data Synchronization Preference tab, enter the shared path or use the Browse button to
select the location that all nodes/SQL service accounts can access.

This action determines how the databases synchronize to the replica.
17. Repeat these steps (except step 12) for all applicable databases in your DPS deployment.

For example, if your SQL Server will host the DPS transactional database, a FILESTREAM
(TDM) database, and the report server and ReportServerTempDB databases, you will have four
Availability Groups, one for each database.

Configure DPS and Reporting Services to Use Availability
Group Listener

Next, configure DPS and Reporting Services to use the Availability Group Listener that you configured
above:

= Use the WebLink utility to configure your DPS database, Report Server database, and
FILESTREAM database to use the Availability Group Listener.

= Use the Report Server Configuration Tool to configure Reporting Services to use the Availability
Group Listener.

Note: If you do not configure the applications to use the Availability Group Listener, your
users will experience connection errors in the event of a server or database level failure.

Configure DPS to Use the Availability Group Listener

To configure DPS to use the Availability Group Listener:

1. Launch the WebLink utility and select or add the DPS transaction database that is part of the
Availability Group.

2. On the General tab, enter (or change) the Availability Group Listener name in the SQL Server
field.

In the Database Name field, enter the name of the DPS transaction database.

4. Enter the SQL Server Login ID and password for the login that has been granted the necessary
SQL Server rights to the Availability Group database.

Attention: See the Configure Database Login section for more information.
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If you see the Use Availability Groups check box, but it is not enabled, see if the Use Alternate
Database for Reporting option is selected on the Report Server tab. You cannot use both the
Use Availability Groups and Use Alternate Database for Reporting features because they
provide the same functionality but are designed for different versions of SQL Server.

Note: Although you are modifying the server connection information for the DPS database,
the DPS FILESTREAM database (if applicable), and the Reporting Services database to use
the Availability Group listener, this action only ensures that these databases can still connect
to the new primary node in the event of a failover.

5. Select the Use Availability Groups check box.

At this point a query is issued to identify the edition of SQL Server in use and the name of the
Availability Group for the database. If this check returns Standard, the label of the check box will
change to Use Basic Availability Groups. Selecting this option does not impact the failover
functionality; it is just a visual identifier that Availability Groups are in use.

6. If you are using FILESTREAM and the FILESTREAM database is part of an Availability Group on
the same server (which it should be if the database is on the same SQL Server as DPS), confirm
that the FILESTREAM SQL Server is using the Availability Group Listener name.

If it is not, change the listener name to the Availability Group Listener name.

7. On the Report Server tab, confirm that the Server Name specified in the Report Server Database
Access section is using the Availability Group Listener name.

If it is not, change the listener name to the Availability Group Listener name.

Configure Reporting Services to Use the Availability Group Listener

If Reporting Services has not yet been configured, follow the steps in the Microsoft SQL Server Reporting
Services section to configure Reporting Services. Remember to create and add Availability Groups for
both the ReportServer and ReportServerTempDB databases. When you enter the database server name
to use for the report server databases, use the Availability Group Listener.

If Reporting Services is already configured to use the primary node server name, follow these
steps to configure Reporting Services to use the Availability Group Listener:

1. Open the Reporting Services Configuration Manager.

2. Select the Database menu.

3. Click the Change Database button.

4. Select the Choose an existing report server database option and click Next.
5

On the Connect to the Database Server screen, change the Server Name to be the Availability
Group Listener and click Next.

6. Select the existing ReportServer database from the drop-down list and click Next to complete the
configuration.
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Flexible Failover Policy

The Failover Policy controls the Failover feature of Availability Groups. For more information on this
feature, see this article:

Flexible Failover Policy for Automatic Failover of an Availability Group (SOL Server)

Failover Condition Level and Health Check Timeout

Transact-SQL Value Automatic Failover Initiated On...

1 One Server down. The SQL Server service stops because of a failover or
restart.
2 Two Server unresponsive. Any condition of lower value is satisfied, the SQL

Server service is connected to the cluster and the health check timeout
threshold is exceeded, or the current primary replica is in a failed state.

3 Three  Critical server error. Any condition of lower value is satisfied or an
internal critical server error occurs. This is the default level.

4 Four Moderate server error. Any condition of lower value is satisfied or a
moderate server error occurs.

5 Five Any qualified failure conditions. Any condition of lower value is satisfied
or a qualifying failure condition occurs.
The failover condition is determined by WSFC executing sp_server_diagnostics at regular intervals.
The following query identifies the existing Failover Policy:
select name,failure_condition_level,health_check timeout from sys.availability groups

Query Result:

failure_condition_level health_check_timeout

<AG_NAME> 3 30000

The following statements configure the Failover Policy for this configuration:
ALTER AVAILABILITY GROUP <AG_NAME> SET (FAILURE_CONDITION_LEVEL = 1); //default is 3

ALTER AVAILABILITY GROUP <AG_NAME> SET (HEALTH_CHECK_TIMEOUT = 60000); //default is
30000

Monitoring Availability Groups

The following tools are available for monitoring the status of an Availability Group:
=  Availability Group Dashboard
= System and Dynamic Management Views (DMVs)
= System Monitor (PerfMon)

=  Windows PowerShell

Technical Installation Guide 185


https://docs.microsoft.com/en-us/previous-versions/sql/sql-server-2012/hh710061(v=sql.110)

Deltek gwumor

Configure Basic Availability Groups Using Microsoft SQL Server Standard Edition

Availability Group Dashboard

To display the Availability Group Dashboard:
1. Launch SQL Server Management Studio and connect to the primary replica.
2. Right-click the Availability Group folder and click Show Dashboard on the shortcut menu.

System and Dynamic Management Views (DMVs)

The following MSDN article provides a variety of System Views and DMVs that can be used to monitor
the health and status of WSFC and Availability Groups:

Monitor Availability Groups (Transact-SQL)

System Monitor (PerfMon)

A variety of System Monitor counters can be used to monitor the performance of Availability Groups. See
this article for more information on the available counters and how to use them:

Monitoring of Availability Groups (SOL Server)

Windows PowerShell

These links are to a four-part MSDN series on using PowerShell to monitor Availability Groups:

= Part 1: Basic Cmdlet Overview

= Part 2 — Advanced Usage of AlwaysOn Health Cmdlets

= Part 3 — A Simple Monitoring Application for AlwaysOn
= Part 4 — Scheduling and Notification with SOL Agent

Troubleshooting

[ssue

If the Use Availability Groups check box does not display for your DPS database when selected in
WeblLink, execute the following query to see if it returns anything:

SELECT e.name, s.database_name
FROM sys.availability_groups_cluster AS e

INNER JOIN sys.availability_databases_cluster AS s
ON e.group_id = s.group_id

The query should return a result set showing the name of the Availability Group and each database
included in the Availability Group.

[ssue

When you use Availability Groups, a system health check query is run to determine the health of the
Availability Group. If the result of this query returns 0 or 1, the system will fall back to running all reports
against the primary replica and Read Only Routing will be effectively disabled. The health check query is:

select synchronization_health from sys.dm _hadr_availability_group_states
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Synchronization Health Values

0 Not healthy. None of the availability replicas have a healthy synchronization_health (2 =
HEALTHY).

1 Partially healthy. The synchronization health of some, but not all, availability replicas is
healthy.

2 Healthy. The synchronization health of every availability replica is healthy.

The following error displays if the SQL login used for the DPS database does not have View Definition or
View Server State permissions.

FrameworkException:

The user does not have permission to perform this action.

Call Stack:

{\b Query: }

select synchronization_health from sys.dm_hadr_availability_group_states

Attention: For more information, see the Configure Database Login section.

Solution:

Grant View Definition and View Server State permissions to the SQL Login.
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Configure Availability Groups Using Microsoft
SQL Server Enterprise Edition

DPS supports the use of Microsoft SQL Server AlwaysOn Availability Groups. The Enterprise Edition of
SQL Server Availability Groups provides an all-inclusive high availability and disaster recovery solution for
SQL Server databases.

Differences in SQL Server Standard and Enterprise Features

You can use Availability Groups with SQL Server Standard Edition or Enterprise Edition, but features will
vary:

SQL Server Edition See installation steps here:

SQL Server Standard Edition = Basic Availability Groups Configure Basic Availability
Groups Using Microsoft SQL
Server Standard Edition

=  Multi-subnet Failover

SQL Server Enterprise Edition =  Availability Groups This section

= Readable Secondary
Replicas

= Read Only Routing
=  Multi-subnet Failover

More Information

This section focuses specifically on the SQL Server Availability Group features supported by DPS. For
information about other SQL Server Availability Group features, see these articles:

=  Qverview of Always On Availability Groups (SOL Server)

= Editions and supported features of SOL Server 2016

These guides provide valuable information about solution design:

=  AlwaysOn Architecture Guides

SQL Server 2016 introduced a number of significant enhancements to the Enterprise Edition of
Availability Groups (in addition to the Basic Availability Group feature added to Standard Edition). See the
following article:

= Enhanced Always On Availability Groups in SOL Server 2016

Prerequisites

See the MSDN documentation for prerequisites, restrictions, and recommendations for AlwaysOn
Availability Groups:

=  Preregs, Restrictions, Recommendations - Always On Availability Groups

Specific prerequisites for DPS are:
= Enterprise Edition of SQL Server 2012 or higher
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= Atleast two SQL Server server nodes

= Standard Edition of Windows Server 2012 or later. The specific operating system feature that is
required to support Availability Groups is Windows Server Failover Clustering.

Note: If you are using Transaction Document Management (which uses SQL Server
FILESTREAM) and Windows Server 2012 Failover Clustering, you may need to install the
following Microsoft hotfix:

Can't access VNN FILESTREAM share when you use the FILESTREAM and FileTable
features on a Windows Server 2012-based failover cluster

= A Windows file share on a server other than the SQL Servers to which the SQL service accounts
have write access. This is required to configure Availability Groups.

Installation Overview

These are the primary installation steps, described in more detail in the sections that follow:
1. Use Server Manager to install the following features on all nodes:
=  Failover Clustering
= Failover Clustering Tools (part of Remote Administration Tools)
= .NET Framework 4.5.2

2. Create afile share on a different server that the SQL Server service account(s) will have full
control rights to.

Create the Windows Server Failover Cluster (WSFC)

The WSFC clusters applications and services. Your specific configuration depends on your intended use
of SQL Server Availability Groups. For example, you may want to use a SQL Server Failover Cluster
Instance (FCI) in addition to using Availability Groups. One of the primary differences in the cluster
configuration of an FCI versus an Availability Group is the need to provide shared storage.

Attention: See Microsoft documentation for in-depth details about configuring Windows Server
Failover Clustering.

When you configure Windows Server Failover Cluster:

= A cluster virtual network is created. You will need an IP address and DNS name for the cluster
and server names for the nodes that will be members of the cluster.

= No shared storage is needed, so you can clear the check box to add available storage.

= A static IP or DHCP can be used for the cluster network. Use a static IP for production
environments.

= A DNS name is created automatically, or you can create a DNS entry before configuring the
cluster.

= You will need domain rights because the process creates a computer account in the domain for
the cluster virtual network.
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=  Two virtual networks are created, one for the Windows Server Failover Cluster and one for the
Availability Group listener. Use a unique name for the cluster, one which is not SQL-specific but
which will be easily identifiable as the Windows cluster.

=  When DPS connects to the SQL Server, it will not connect to the WSFC name. It will connect to
the Availability Group Listener (created later). The WSFC is enabled for the failover functionality
of Availability Groups.

Multi-subnet Clustering

The Multi-subnet Clustering feature provides failover support when the Primary and Secondary replicas of
the Availability Groups are on different network subnets.

If your WSFC (and SQL Server Availability Group Listener) are configured so that your WSFC nodes are
on different network subnets, Multi-subnet Failover support is automatically turned on.

The MultisubnetFailover=True option is automatically added to the connection string.

Attention: See the following articles for more information:

= Availability Group Listeners, Client Connectivity, and Application Failover (SOL Server)

= Create or Configure an Availability Group Listener (SQL Server)

Install and Configure WSFC

Use the following procedures to install and configure Windows Server Failover Clustering.

Depending on your operating system, the steps in these procedures may vary slightly. The procedures in
this section are based on Windows Server 2012 Standard Edition.

Install the Failover Clustering Feature

To install the failover clustering feature:
1. Open the Server Manager utility.
Access the Local Server, and scroll down to Roles and Features.
From the Tasks drop-down list, select Add Roles and Features.
In the Add Roles and Features wizard, click Next until you get to the Select Features page.
Select the Failover Clustering option.
If prompted, click OK to install any dependent features.

Complete the wizard to perform the installation.

© N o ok~ w D

If prompted, reboot the server.
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Configure Failover Clustering using Failover Cluster Manager

To configure the failover clustering feature:
From Administrative Tools, open the Failover Cluster Manager.
2. Under Management, click Create Cluster.
The Create Cluster Wizard will guide you through the process.

3. On the Select Servers page of the wizard, browse to or enter the names of the servers that will be
part of the cluster.

4. On the Validation Warning page, select Yes to run the Cluster Validation tests, and click Next.

This process creates a report that identifies any problems that need to be addressed before
creating the cluster.

5. When the validation is completed, provide a name for the cluster in the Cluster Name field.
Click Next to create the cluster.

If you are configuring a WSFC that does not require shared storage, clear the Add all eligible
storage to the cluster option.

Install SQL Server on Each Node

After configuring the WSFC, you must perform the SQL Server installation on each node in the cluster.

Installation Requirements and Notes
=  SQL Server 2012 or later Enterprise Edition is required for Availability Groups.

= |f you are only configuring Availability Groups (not a Failover Cluster Instance), you must perform
a new SQL Server stand-alone installation, not a new SQL Server failover cluster installation, on
each node.

= Shared storage is a requirement of Availability Groups only if they are installed in a SQL cluster.
The prerequisite check will fail if you choose a SQL Server cluster installation and do not provide
shared storage.

= Only the SQL database engine can use Basic Availability Groups. Even though the Availability
Groups use a WSFC, this relationship does not constitute a true cluster and will not provide fault
tolerance for other SQL Server services (Analysis Services or Reporting Services).

= To be fault tolerant, Analysis Services must be part of an actual Failover Cluster Instance (FCI)
where SQL is installed using a new SQL Server failover cluster installation.

= An FCI may be used together with an Availability Group to enhance the availability of an
availability replica. However, to prevent potential race conditions in the WSFC cluster, automatic
failover of the Availability Group is not supported to or from an availability replica that is hosted on
an FCI.

= Reporting Services use a Scale-out Deployment, which is not a cluster.

= You can use the same or different service accounts on each node, but all accounts must have
rights to the file share described in the Prerequisites section above.
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= FILESTREAM functionality can be used with Availability Groups and will require that
FILESTREAM be enabled on all failover nodes.

Attention: For more information, see:

= FILESTREAM and FileTable with Always On Availability Groups (SOL Server) |
Microsoft Docs

You may also need the following Microsoft hotfix:

= Can't access VNN FILESTREAM share when you use the FILESTREAM and
FileTable features on a Windows Server 2012-based failover cluster

= Although this is not a specific requirement, you should consider performing the exact same SQL
Server installation on each node, including the same installation and data paths and instance
name.

= For proper failover support, the failover nodes should have comparable hardware resources.

= See the MSDN documentation for prerequisites, restrictions, and recommendations for AlwaysOn
Availability Groups:

Preregs, Restrictions, Recommendations - Always On Availability Groups

After installing SQL Server on all nodes in the cluster, restore your DPS transaction and FILESTREAM
databases and configure the SQL Reporting Services databases (ReportServer and
ReportServerTempDB) on the primary node in the cluster.

Configure Database Login

For the DPS and Reporting Services databases that are part of an Availability Group to be immediately
available in the event of an Availability Group failover, you must complete these steps on all failover
nodes. The following rights need to be granted to the login used to access the databases (DPS and
Reporting Services databases) that are part of the Availability Group:

Dbo = Database Owner rights to all databases | All databases in the Availability Group
in the Availability Group

View Any Definition Availability Groups

View Server State Availability Groups

When you back up and restore a database to another server, the login on Server A has a different SID
(Security Identifier) than the same login on Server B. This issue is typically resolved using the
sp_change_users_login stored procedure. However, because the database on the secondary replica will
be in read-only mode, you cannot fix the login.

You can resolve this issue by using the sp_help_revlogin stored procedure, found in the following article:

How to transfer logins and passwords between instances of SOL Server

Once the procedure is created in the master database, execute it to get the list of SQL logins with their
associated SIDs and the CREATE statement to create the login on the secondary replicas.
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Here is an example.

CREATE LOGIN [DeltekPS] WITH PASSWORD =
0x0200EOEO05D60876CCE39BD9209515FB63C5589D6C939F3AB56A6CE9DBFBF49A9410F66F09840827135F8
00725E25A77714FDFA31FB6C18BCB46561217947C3749F0380A18AF5 HASHED, SID =
0x0124F12258D9BD49BE649C2D7A6DA838, DEFAULT_DATABASE = [master], CHECK_POLICY = OFF,
CHECK_EXPIRATION = OFF

Prior to configuring the Availability Groups, run the CREATE statement(s) created from executing the
sp_help_revlogin on your server on all secondary replicas.

Create Availability Groups

You must enable Availability Groups and create an Availability Group on the primary node.

To enable Availability Groups:
1. Open the SQL Server Configuration Manager.
2. Right-click the SQL Server service, and click Properties.

3. On the AlwaysOn High Availability tab, select the check box to enable the Availability Groups for
each node.

Restart the SQL Server service.

Repeat steps 1-4 on all nodes that will be part of the Availability Group.

To create an Availability Group:

1. Select the databases to be included in the Availability Group (all of these databases will fail over
together if there is a failover).

At a minimum, include the DPS and Reporting Services databases (ReportServer and
ReportServerTempDB).

The database must be in FULL recovery mode and a FULL database backup must have been
taken of the database prior to starting the Availability Group wizard.

Attention: For more information on performing backups and restores of databases in FULL
recovery model, see the following MSDN documentation:

Back Up and Restore of SOL Server Databases

2. In SQL Server Management Studio, start the Availability Group Wizard.

3. Expand AlwaysOn High Availability, right-click Availability Groups, and click New Availability
Group Wizard on the shortcut menu.

4. Select a name for the Availability Group.

This is not the virtual name of the Availability Group listener, but it can be the same. The name
should describe the databases the Availability Group includes (for example, DeltekPSAG)
because multiple Availability Groups can exist on the same servers.

5. Select the Database Level Health Detection option.

This undocumented option controls whether the entire Availability Group fails over if one
database becomes suspect.
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6. Select the databases that you want to include in the Availability Group.

The wizard will tell you whether or not they meet the requirements (for example, FULL recovery
and FULL backup taken).

7. Specify the Availability Group configuration (nodes, failover mode, and synchronization mode).

Attention: See this article for more information on failover and failover modes:

Failover and Failover Modes (Always On Availability Groups)

See the following settings to complete the fields on this form:

Server Instance A maximum of four servers is allowed (eight with SQL Server
2016)

Initial Role Select the role of the server (Primary or Secondary).

Automatic Failover Check this option for failover to occur automatically. Otherwise,

failover will be a manual process.

Synchronous Commit/  This option controls how transactions are committed, which has

Asynchronous Commit | an impact on the performance of the synchronization and how
much data may be lost in the event of a failure. Select one of
these options:

= Synchronous Commit: Each transaction must be
committed to both Node 1 and Node 2 before the transaction
is considered complete. This option reduces the possibility of
data loss, but at the expense of performance.

= Asynchronous Commit: Each transaction is committed to
Node 1. The transaction is also sent to Node 2 but there is
no verification if it is or is not committed. This option
performs better, but with the chance of data loss.

Readable Secondary Select one of these options:
= No: Connections are not allowed to secondary replicas.

= Yes: Connections are allowed in read-only mode.

= Read-intent only: Connections using the
Applicationintent=ReadOnly keyword are used for Read

Only Routing.
8. Click the Endpoints tab.

The Endpoint for each instance is created automatically.

9. Click Backup Preferences to select whether or not backups can be taken from replicas other
than the primary replica (another feature of Availability Groups).

10. Click the Listener tab. You use this tab to create the Availability Group Listener.
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11. From the Network Mode drop-down list, select the type of listener: Static IP or DHCP.
The port will be the same as the one used by the SQL Server port (the default is 1433).

Note: If you are using multiple subnets, use the Add button to add the IP address for the
listener on all subnets. This option is available only if you are using Static IP addresses. See
the following article for more information:

Add IP Address Dialog Box (SQL Server Management Studio)

12. Click Next.

13. On the Data Synchronization Preference tab, enter the shared path or use the Browse button to
select the location that all nodes/SQL Service accounts can access. This determines how the
databases synchronize to the replicas.

Read Only Routing Configuration

DPS architecture changes have been made to support the Read Only Routing feature. This feature lets
certain report queries to run against a read-only copy of the DPS transaction database on a secondary
replica of the Availability Group. The benefit of this feature is that it allows much of the DPS reporting
workload to be offloaded from the database on the primary replica to the secondary replica, which frees
resources for the transaction workload.

= Only the following reports use Read Only Routing:
= Dashboard reports
= Reports that you run from the Reporting menu (except Purchasing reports)

Reports that use the replica database will do so regardless of how they are generated: when they
are previewed, directly printed, emailed, run via the process server, or generated in another way.

= Read Only Routing requires that the connection string uses the Applicationintent=ReadOnly
keyword. The DPS Reporting architecture has been modified to allow for this change in the
connection string when the database configuration specified in WebLink is configured to use
Availability Groups.

= With this keyword and the proper configuration (queries below), the Availability Group will
automatically route connections with this keyword to the read-only secondary replicas configured
for Read-intent only.

= Even though you have configured the Availability Group for read-intent only secondary replicas,
manual queries are required to configure the Read Only Routing part of the configuration.

Attention: For more information about Read Only Routing, read the following article:

Configure Read-Only Routing for an Availability Group (SOL Server)
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Read Only Routing Queries

Two queries are required to modify the Availability Group configuration to support Read Only Routing:
=  Configure the Read Only Routing URL
= Configure Read Only Routing Lists

Configure the Read Only Routing URL

Read Only Routing URLSs are different from Availability Group endpoints, which were automatically
configured earlier. In the Availability Group configuration above, there are two nodes, each configured to
allow read-intent only connections when the node is in secondary mode. (A node in secondary mode is
promoted to primary when a failover occurs.)

= The following query identifies existing read-only routing URLS:
select read_only_routing_url from sys.availability_replicas
Query Result (if present; otherwise the query will return NULL):
read_only_routing_url
tcp://CAMDEVSQL12AG1:1433
tcp://CAMDEVSQL12AG2:1433

= This blog post identifies a script that can be run against each replica to calculate the read-only
routing URL:

Calculating read _only routing _url for AlwaysOn

Here is sample output from the script:

Read-only-routing url script v.2012.1.24.1

This SQL Server instance version is [11.0.2100.60]

This SQL Server instance is a standard (not clustered) SQL Server instance.
This SQL Server instance is enabled for AlwaysOn.

This SQL Server instance is NOT a Sql Azure instance.

This SQL Server instance DAC (dedicated admin) port is 1434

This SQL Server instance is listening to all IP addresses (default mode).

This SQL Server instance is listening on fixed tcp port(s) (it is not
configured for dynamic ports), this is a recommended configuration when using
read-only routing.

This SQL Server instance resides in domain "dev.ads.deltek.com”

This SQL Server instance FQDN (Fully Qualified Domain Name) is
"CAMDEVSQL12AG1.dev.ads.deltek.com®

This SQL Server instance port is 1433

The read_only_routing_url for this SQL Server instance is
"tcp://CAMDEVSQL12AG1.dev.ads.deltek.com:1433"
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= The following statements configure the read-only routing URL for each node:
ALTER AVAILABILITY GROUP [SQL12AG1]

MODIFY REPLICA ON N®CAMDEVSQL12AG1® WITH
(SECONDARY_ROLE(READ_ONLY ROUTING_URL=N"tcp://CAMDEVSQL12AG1.dev.ads.deltek.com
:1433"))

ALTER AVAILABILITY GROUP [SQL12AG1]

MODIFY REPLICA ON N®CAMDEVSQL12AG2" WITH
(SECONDARY_ROLE(READ_ONLY ROUTING_URL=N"tcp://CAMDEVSQL12AG2.dev. ads.deltek.com
:1433"))

Where:
= [SQL12AG1] is the name of the Availability Group (not the listener).
= CAMDEVSQL12AG1 is node 1 and CAMDEVSQL12AG2 is node 2.

= tcp://CAMDEVSQL12AG1.dev.ads.deltek.com:1433 is the read-only routing URL for node 1
and tcp://CAMDEVSQL12AG1 .dev.ads.deltek.com: 1433 is the read-only routing URL for
node 2.

Configure Read Only Routing Lists

Read Only Routing Lists provide a priority order for the routing of read-intent only connections among
nodes in an Availability Group configured for Read Only Routing.

= The following query identifies existing Read Only Routing Lists and shows that when
CAMDEVSQL12AG1 is the primary, the priority order will be the replica (CAMDEVSQL12AG2)
and then itself if the replica is not available (and vice versa if CAMDEVSQL12AG2 is the primary):

select g-name, rl.replica_server_name, l.routing priority,
r2_replica_server_name, r2.read_only_routing_url

from sys.availability _read_only routing_lists as I

join sys.availability replicas as rl1 on Ll.replica_id = rl.replica_id

join sys.availability replicas as r2 on l.read_only replica_id = r2.replica_id
join sys.availability groups as g on rl._.group_id = g.group_id

Query Result:

replica_server_name replica_server_name
priority
2
1
1
2

SQL12AG1 | CAMDEVSQL12AG1 CAMDEVSQL12AG1 tcp://CAMDEVSQL12AG1:1433
SQL12AG1 | CAMDEVSQL12AG2 CAMDEVSQL12AG1 tcp://CAMDEVSQL12AG1:1433
SQL12AG1 | CAMDEVSQL12AG1 CAMDEVSQL12AG2 tcp://CAMDEVSQL12AG2:1433

SQL12AG1 | CAMDEVSQL12AG2 CAMDEVSQL12AG2 tcp://CAMDEVSQL12AG2:1433
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The following statements configure the Read Only Routing Lists for this configuration:
ALTER AVAILABILITY GROUP [SQL12AG1]

MODIFY REPLICA ON N"CAMDEVSQL12AG1® WITH (PRIMARY_ROLE (READ ONLY ROUTING_ LIST
= (N"CAMDEVSQL12AG2" ,N"CAMDEVSQL12AG1")))

ALTER AVAILABILITY GROUP [SQL12AG1]

MODIFY REPLICA ON N"CAMDEVSQL12AG2" WITH (PRIMARY_ROLE (READ ONLY ROUTING_ LIST
= (N"CAMDEVSQL12AG1" ,N"CAMDEVSQL12AG2")))

Where:
= [SQL12AG1] is the name of the Availability Group (not the listener).
= CAMDEVSQL12AG1 is node 1 and CAMDEVSQL12AG2 is node 2.

Configure DPS and Reporting Services to Use Availability
Group Listener

Next, configure DPS and Reporting Services to use the Availability Group Listener that you configured

above:

Use the WebLink utility to configure your DPS transaction database, report server database, and
FILESTREAM database to use the Availability Group Listener.

Use the Report Server Configuration Tool to configure Reporting Services to use the Availability
Group Listener.

Configure DPS to Use the Availability Group Listener

To configure DPS to use the Availability Group Listener:

1.

Launch the WebLink utility, and select or add the DPS transaction database that is part of the
Availability Group.

On the General tab, enter (or change) the Availability Group Listener name in the SQL Server
field.

In the Database Name field, enter the name of the DPS transaction database.

Enter the SQL Server login ID and password for the login that has been granted the necessary
SQL Server rights to the Availability Group database. See the Configure Database Login section
for more information.

If you see the Use Availability Groups check box, but it is not enabled, check to see if the Use
Alternate Database for Reporting check box is selected on the Report Server tab. You cannot
use both the Availability Groups and Alternate Database for Reporting features because they
provide the same functionality but are designed for different versions of SQL Server.
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Note: Although you are modifying the server connection information for the DPS database,
the DPS FILESTREAM database (if applicable), and the Reporting Services database to use
the Availability Group Listener, this action only ensures that these databases can still connect
to the new primary node in the event of a failover.

The only features that use the DPS database on the secondary (Read Only) replica are the
database queries for the specific reports described earlier in this document. This includes
reports on the Reporting Applications menu (excepting Purchasing reports) and Dashboard
reports.

4. Select the Use Availability Groups check box.

At this point a query is issued to identify the edition of SQL Server and the name of the
Availability Group for the database. If the check returns Standard, the label of the check box
changes to Use Basic Availability Groups. Selecting this option does not impact the failover
functionality; it is just a visual identifier that Availability Groups are in use.

5. If you are using FILESTREAM and the FILESTREAM database is part of the Availability Group
(which it should be if the database is on the same SQL Server as DPS), confirm that the
FILESTREAM SQL Server is using the Availability Group Listener name.

If it is not, change the listener name to the Availability Group Listener name.

6. On the Report Server tab, confirm that the Server Name specified in the Report Server Database
Access section is using the Availability Group Listener name.

If it is not, change the listener name to the Availability Group Listener name.

Configure Reporting Services to Use the Availability Group Listener

If Reporting Services has not yet been configured, follow the steps in Microsoft SOL Reporting Services
to configure Reporting Services. Remember to add the report server databases to the Availability Group.
When you enter the Database Server name to use for the report server databases, use the Availability
Group Listener.

If Reporting Services is already configured to use the primary node server name:
1. Open the Reporting Services Configuration Manager.
2. Select the Database menu.
3. Click the Change Database button.
4. Select the Choose an existing report server database option and click Next.
5

On the Connect to the Database Server screen, change the Server Name to be the Availability
Group Listener, and click Next.

6. Select the existing ReportServer database from the drop-down list and click Next to complete the
re-configuration.

Flexible Failover Policy

The Failover Policy controls the Failover feature of Availability Groups. For more Information on this
feature, see this article:

Flexible Failover Policy for Automatic Failover of an Availability Group (SOL Server)

Technical Installation Guide 199


https://docs.microsoft.com/en-us/previous-versions/sql/sql-server-2012/hh710061(v=sql.110)

Deltek ponmere

Configure Availability Groups Using Microsoft SQL Server Enterprise Edition

Failover Condition Level and Health Check Timeout

Transact- . . "

SQL Value Automatic Failover Initiated On...
1 One Server down: The SQL Server service stops because of a failover or restart.
2 Two Server unresponsive: Any condition of a lower value is satisfied, the SQL

Server service is connected to the cluster and the health check timeout
threshold is exceeded, or the current primary replica is in a failed state.

This is the default level.

3 Three Critical server error: Any condition of a lower value is satisfied or an internal
critical server error occurs.

4 Four Moderate server error: Any condition of a lower value is satisfied or a
moderate server error occurs.

5 Five Any qualified failure conditions: Any condition of a lower value is satisfied
or a qualifying failure condition occurs.
The failover condition is determined by WSFC executing sp_server_diagnostics at regular intervals.
The following query identifies the existing Failover Policy:
select name,failure_condition_level,health_check timeout from sys.availability groups

Query Result:

failure_condition_level health_check_timeout

SQL12AG1 3 30000

The following statements configure the Failover Policy for this configuration:
ALTER AVAILABILITY GROUP AG1 SET (FAILURE_CONDITION_LEVEL = 1); //default is 3
ALTER AVAILABILITY GROUP AG1 SET (HEALTH_CHECK_ TIMEOUT = 60000); //default is 30000

Monitoring Availability Groups

The following tools are available for monitoring the status of an Availability Group:
=  Availability Group Dashboard
= System and Dynamic Management Views (DMVs)
= System Monitor (PerfMon)

=  Windows PowerShell

Availability Group Dashboard

To display the Availability Group Dashboard:
1. Launch SQL Server Management Studio and connect to the primary replica.

2. Right-click the Availability Group folder and click Show Dashboard on the shortcut menu.
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System and Dynamic Management Views (DMVs)

This article provides a variety of System Views and DMVSs that you can use to monitor the health and
status of the WSFC and Availability Groups:

Monitor Availability Groups (Transact-SOL)

System Monitor (PerfMon)

A variety of System Monitor counters can be used to monitor the performance of Availability Groups. This
article provides more information on the available counters and how to use them:

Monitoring of Availability Groups (SQL Server)

Windows PowerShell

These links are to a four-part MSDN series on using PowerShell to monitor Availability Groups:

= Part 1: Basic Cmdlet Overview

= Part 2 — Advanced Usage of AlwaysOn Health Cmdlets

= Part 3 — A Simple Monitoring Application for AlwaysOn
= Part 4 — Scheduling and Notification with SOL Agent

Troubleshooting

[ssue

If the Use Availability Groups check box does not display for your DPS database when selected in
WeblLink, execute the following query to see if it returns anything:

SELECT e.name, s.database_name
FROM sys.availability_groups_cluster AS e

INNER JOIN sys.availability_databases_cluster AS s
ON e.group_id = s.group_id

The query should return a result set showing the name of the Availability Group and each database
included in the Availability Group.

[ssue

When you use Availability Groups, a system health check query is run to determine the health of the
Availability Group. If the result of this query returns 0 or 1, the system falls back to running all reports
against the Primary replica and effectively disables Read Only Routing. The health check query is:

select synchronization_health from sys.dm _hadr_availability_group_states

Synchronization Health Values

0 Not healthy: None of the availability replicas have a healthy synchronization_health (2 =
HEALTHY).
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1 Partially healthy: The synchronization health of some, but not all, availability replicas is
healthy.
2 Healthy: The synchronization health of every availability replica is healthy.
[ssue

The following error displays if the SQL login used for the DPS database does not have View Definition or
View Server State permissions.

FrameworkException:

The user does not have permission to perform this action.

Call Stack:

{\b Query: }

select synchronization_health from sys.dm_hadr_availability_group_states

Attention: For more information, see the Configure Database Login_section.

Solution:

Grant View Definition and View Server State permissions to the SQL Login.

Identify the Connection String Used by the Application or Process
Server

To validate that the MultiSubnetFailover=True keyword is being added to the connection string for your
Availability Group configuration, add the following setting to the web.config file under the
<ApplicationSettings> tag:

<add key="LogConnectString" value="Y"/>
When this option is setto Y:

= The application connection string (created at login) is logged in the ConnectionString.txt file
named in the application Logs directory.

= The process server connection string is logged in the ProcessServerConnectString.txt file in the
same location.

Review these logs to ensure that the MultiSubnetFailover=True keyword is added to the
connection string. After you have validated that the correct connection string is being issued, change the
value of the LogConnectionString setting to N.

Technical Installation Guide 202



Deltek gwumor

Configure Availability Groups Using Microsoft SQL Server Enterprise Edition

Identify the Connection String Used in a Report

After you configure the Alternate Database for Reporting or Availability Group option, you must
validate that reports are running against the correct database. Preview the report to check the connection
string.

To review the connection string by previewing the report:

1. Display any report.

2. Click the construction hat icon ~ on the Reporting toolbar.

If you don't see the icon, maximize the report.

From the View Report Information drop-down list, select Report Data Source.
4. Click the View button. You will be prompted to Open or Save the XML file.

Click Open to open the file using the application configured to open XML files (usually the default
browser).

6. Review the ConnectString element for the following attributes:

= Data Source: This is either the database server specified in the Alternate Database for
Reporting configuration or, if you use Availability Groups, the Availability Group Listener.

= Initial Catalog: This is either the database name specified in the Alternate Database for
Reporting configuration or, if you use Availability Groups, the DPS database name.

= Applicationintent=ReadOnly: This only displays when you use Availability Groups and if the
report was run against the Read Only Reporting database.

= MultiSubnetFailover: This only displays when you use Availability Groups.
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